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インストール・ガイド • 安全情報

• 測定器の入手

• 環境要件と電気的要件

• 基本的なセットアップ

• アクセサリ

• 動作検証

• 規制情報

ユーザーズ・ガイド • 測定器の概要

• フロント・パネル操作

• セキュリティ

• 基本的なトラブルシューティング

プログラミング・ガイド • リモート・オペレーション

• ステータス・レジスタ

• ファイルの作成およびダウンロード

SCPIリファレンス • SCPIの基本

• コマンド記述

• プログラミング・コマンドの互換性

サービス・ガイド • トラブルシューティング

• アセンブリ交換

• 交換可能な部品

• 修理後の手順

• 安全／規制情報

キーのヘルプa

aHelpハードキーを押してから、ヘルプが必要なキーを押します。

• キーの機能の説明

• 関連するSCPIコマンド
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1 信号発生器の概要

• 「信号発生器の特長」 2ページ

• 「フロント・パネルの概要」 3ページ

• 「フロントパネル・ディスプレイ」 7ページ

• 「リア・パネルの概要」 9ページ
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信号発生器の概要
信号発生器の特長
信号発生器の特長

• N5181A、アナログ・モデル：250 kHz～1, 3, または6 GHz

• N5182A、ベクトル・モデル：250 kHz～3または6 GHz

• 電子式アッテネータ

• 周波数、パワーまたは周波数とパワーのステップ／リスト掃引

• ベクトル・モデルはリスト掃引の波形を内蔵可能

• ユーザ・フラットネス補正

• 自動レベル・コントロール (ALC)；パワー校正

• 10 MHz基準発振器（外部出力装備）

• 柔軟性の高い基準入力、1 ～50 MHz（オプション1ER）

• GPIB、USB 2.0、100Base-T LANインタフェース

• アナログ変調：AM、FM、ΦM（オプションUNT）

• 外部AM、FM、ΦM（オプションUNT）

• パルス変調（オプションUNU）

• SCPI/IVI-COMドライバ

• 8648/ESGコード対応

• LXIクラスC準拠

• 外部アナログI/Q入力（ベクトル・モデル）

• アナログ差動I/Q出力（ベクトル・モデル、オプション1EL）

• 最高125 Mサンプル/sの速度での任意I/Q波形の再生（ベクトル・モデル、オプション654）

• Signal Studioソフトウェアを使用すれば、ベクトル・モデルは802.11無線LAN、W-CDMA、cdma2000、1xEV-DO、

GSM、EDGEなどを作成可能

ハードウェア、ファームウェア、ソフトウェア、マニュアルの特長およびオプションの詳細については、信号発生器に付

属のデータシートをご覧ください。データシートはAgilent TechnologiesのWebサイトからも入手できます。 

1. Open: http://www.agilent.com/find/mxg

2. 目的のモデル番号を選択します。

3. オプション／価格表の価格表を選択します。
2 Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド



信号発生器の概要
フロント・パネルの概要
フロント・パネルの概要

1. ホストUSB

このユニバーサル・シリアル・バス (USB) を使用して、データ転送用のメモリ・スティックを接続します。信号発生器を

シャット・ダウン／再起動しなくても、USBデバイスを接続したり、取り外したりできます。測定器の裏面にはデバイス

USBコネクタ（11ページを参照）もあるので、このコネクタを使ってリモート・コントロールすることも可能です。

2. ディスプレイ

液晶表示 (LCD) 画面には、現在の機能に関する情報が表示されます。スタータス・インジケータ、周波数、振幅設定、エ

ラー・メッセージなどの情報が表示されます。ディスプレイの右側には、ソフトウェアのラベルが表示されます。7ペー

ジの「フロントパネル・ディスプレイ」も参照してください。

3. ソフトキー

ソフトキーは、キーの左側に表示されている機能を実行します。

4. テンキー

テンキーは、0～9のハードキー、小数点ハードキー、マイナス記号ハードキー、バックスペース・ハードキーから構成さ

れます。24ページの「数およびテキストの入力／編集」を参照してください。

5. 矢印とSelect

Selectと矢印ハードキーを使って、信号発生器のディスプレイ上に表示されている項目を選択して編集することができま

す。24ページの「数およびテキストの入力／編集」を参照してください。

コネクタ A型

USBプロトコル 2.0

22. 電源スイッチとLED 

21. MoreとLED 

20. Return 

18. ノブ 

19. Incr Set 
15. Page Down 

16. I Input

17. Q Input

12. RF 
Output 

13. RF On/OffとLED 

14. Mod On/OffとLED 

7. メニュー 
および
10. Help 

11. Preset
とUser 
Preset 

9. Local 
Cancel/(Esc) 

5. 矢印とSelect 

6. Page Up 

8. Trigger 

4. テンキー 3. ソフトキー 2. ディスプレイ 1. ホストUSB 

MXGÉxÉNÉgÉãêMçÜî¦ê¹äÌ
N5181A 250 kHzÅ`6 GHz
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信号発生器の概要
フロント・パネルの概要
6. Page Up

テーブル・エディタで、前のページを表示するにはこのハードキーを使用します。25ページの「例：テーブル・エディタ

の使用法」を参照してください。テキストが表示エリアの1ページに収まりきらない場合は、このキーとPage Downキー

（5ページ）を併用してテキストをスクロールします。

7. メニュー

これらのハードキーは、測定器の機能を設定したり、情報にアクセルするためのソフトキー・メニューをオープンします。

8. Trigger

トリガ・モードがTrigger Keyに設定されている場合にこのハードキーを押すと、リスト掃引やステップ掃引などの機能に

対してトリガ・イベントが即座に開始されます。

9. Local Cancel/(Esc)

このハードキーを押すと、リモートオペレーションがオフになり、信号発生器はフロント・パネル制御に戻ります。また、

アクティブ機能の入力やIQ校正などの長い処理はキャンセルされます。

10. Help

ハードキーやソフトキーの説明を表示するには、このキーを使用します。23ページの「キーの説明の表示」を参照してく

ださい。

11. PresetとUser Preset

これらのハードキーは、信号発生器を既知の状態（工場設定またはユーザ定義）に設定します。23ページの「信号発生器

のプリセット」を参照してください。

42ページを参照

38ページを参照

35ページを参照

26ページを参照

53ページを参照

57ページを参照

ベクトル・モデル
のみ有効。

26ページを参照

27ページを参照

15ページを参照

23ページを参照

67ページを参照

将来用に確保。
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信号発生器の概要
フロント・パネルの概要
12. RF Output

13. RF On/OffとLED

このハードキーは、RF OUTPUTコネクタのRF信号の動作状態を切り替えます。RF出力をオンにすると、RF On/OffLED
が点灯します。

14. Mod On/OffとLED

このハードキーは、アクティブ変調方式による出力搬送波信号の変調のオン／オフを切り替えます。このハードキーを使

用して、フォーマットを設定したり、アクティブにすることはできません（34ページの「搬送波信号の変調」を参照して

ください）。

出力変調をオンにすると、MOD ON/OFF LEDが点灯します。

15. Page Down

テーブル・エディタで、次のページを表示するにはこのハードキーを使用します。25ページの「例：テーブル・エディタ

の使用法」を参照してください。テキストが表示エリアの1ページに収まりきらない場合は、このキーとPage Upキー（4
ページ）を併用してテキストをスクロールします。

16. I Input（ベクトル・モデルのみ）

121ページの「I/Q変調」も参照してください。

17. Q Input（ベクトル・モデルのみ）

121ページの「I/Q変調」も参照してください。

コネクタ 標準：

オプション1EM：

インピーダンス：

N型メス

リア・パネルのN型メス

50Ω

損傷レベル 50 Vdc、2 Wの最大RFパワー

コネクタ タイプ：BNC（メス） インピーダンス：50Ω

信号 外部から供給されたI/Q変調のアナログ同相成分。

信号レベルは ＝0.5 Vrms（校正済み出力レベル）。

損傷レベル 1Vrms

コネクタ タイプ：BNC（メス） インピーダンス：50Ω

信号 外部から供給されたI/Q変調のアナログ直交位相成分。

信号レベルは ＝0.5 Vrms（校正済み出力レベル）。

損傷レベル 1Vrms
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 5



信号発生器の概要
フロント・パネルの概要
18. ノブ

ノブを回すことにより、数値を増減したり、リストの次の桁、文字または項目を強調表示することができます。17ページ

の「フロントパネルのノブの分解能」も参照してください。

19. Incr Set 

このハードキーを使用して、現在のアクティブ機能の増分値を設定することができます。増分値は、ノブの現在の比率設

定に応じて、ノブを回すたびに変化するアクティブ機能の値の量にも影響を及ぼします（17ページの「フロントパネルの

ノブの分解能」を参照）。

20. Return 

このハードキーを押すことによって、キーを押す前の状態に後戻りすることができます。複数の階層を持つメニューでは、

Returnキーを押すと前のメニュー・ページに戻ります。

21. MoreとLED

メニューにソフトキー・ラベルをすべて表示できない場合は、More LEDが点灯し、ラベルの下にMoreメッセージが表示

されます。次のラベル・グループを表示するには、Moreハードキーを押します。

22. 電源スイッチとLED

このスイッチによって、待機モードまたは電源投入モードを選択します。待機位置にすると、黄色のLEDが点灯し、信号

発生器の機能はすべてオフになります。信号発生器は電源に接続されたままなので、一部の内部回路によって多少は電力

が消費されます。オン位置にすると、緑色のLEDが点灯し、信号発生器の機能はすべてオンになります。
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信号発生器の概要
フロントパネル・ディスプレイ
フロントパネル・ディスプレイ

1. アクティブ機能エリア

このエリアには、現在アクティブ状態にある機能が表示されます。例えば、周波数がアクティブ機能の場合、現在の周波

数設定が表示されます。現在のアクティブ機能に対応する増分値がある場合は、その値も表示されます。

2. 周波数エリア

このエリアには、現在の周波数設定が表示されます。

3. インジケータ

インジケータは、信号発生器の一部の機能の状態とエラー状態を示します。1つのインジケータの位置が複数のインジケー

タによって用いられる場合もあります。この場合、同じインジケータ位置を使用する機能が同時にアクティブになること

はありません。

インジケータ どういった場合に表示されるか . . .

ΦM 位相変調がオンの場合。周波数変調をオンにした場合、FMインジケータに代わってΦMが表示されます。

ARB ARB発生器がオンの場合。

ALC OFF ALC回路がオフの場合。ALCがオンで、出力レベルを維持できない場合は、UNLEVELインジケータが同じ位置に表示されます。

AM 振幅変調がオンの場合。

ARMED 掃引が開始され、信号発生器が掃引トリガ・イベントを待っている場合。

ATTNHOLD アッテネータ・ホールド機能がオンの場合。この機能がオンになっていると、アッテネータの現在の設定が維持されます。

DETHTR ALCディテクタのヒータの温度が気温を下回っている場合。ALC仕様を満たすには、ヒータの温度が気温と同じでなければなりません。

AWGN リアルタイムI/Qベースバンド相加性白色ガウス雑音がオンの場合。

5. エラー・メッセージ・エリア 6. テキスト・エリア 7. ソフトキー・ラベル・エリア 

4. 振幅エリア 3. インジケータ 2. 周波数エリア 1. アクティブ機能エリア 

スクロール・バー
テキストが一画面
に収まりきらない
場合は、スクロー
ル・バーがここに
表 示 さ れ ま す。
Page Upキーと

Page Downキー

を使用して、テキ
ストをスクロール
してください。
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信号発生器の概要
フロントパネル・ディスプレイ
4. 振幅エリア

このエリアには、現在の出力パワー・レベル設定が表示されます。

5. エラー・メッセージ・エリア

このエリアには、省略されたエラー・メッセージが表示されます。複数のメッセージが発生した場合は、最新のメッセー

ジだけが表示されます。42ページの「エラー・メッセージの読込み」を参照してください。

6. テキスト・エリア

このエリアには、信号発生器のステータス情報（変調ステータスなど）やその他の情報（掃引リストやファイル・カタロ

グなど）が表示されます。このエリアを使って、情報の管理（情報の入力、ファイルの表示／削除など）などの機能を実

行することもできます。

7. ソフトキー・ラベル・エリア

このエリアには、ディスプレイの右隣にあるソフトキーの機能を定義するラベルが表示されます。ソフトキー・ラベルは、

選択された機能に応じて変化します。

DIGBUS デジタル・バスが使用されている場合。

ERR エラー・メッセージがエラー待ち行列に置かれている場合。このインジケータは、エラー・メッセージをすべて表示するか、エラー待ち
行列をクリアするまでオフになりません（42ページの「エラー・メッセージの読込み」を参照）。

EXTREF 外部周波数基準が適用されます。

FM 周波数変調がオンの場合。位相変調をオンにした場合、ΦMインジケータに代わってFMが表示されます。

I/Q I/Qベクトル変調がオンの場合。

L 信号発生器がリスナ・モードにあり、GPIB、USBまたはVXI-11/ソケット (LAN) インタフェース経由で情報やコマンドを受信している場合。

MULT 周波数逓倍器が設定されている場合（51ページの「周波数逓倍器の設定」を参照）。

OFFS 周波数オフセットが設定されている場合（49ページの「出力オフセットの設定」を参照）。

PULSE パルス変調がオンの場合。

R 信号発生器がGPIB、USBまたはVXI-11/ソケット (LAN) インタフェース経由でリモート制御されている場合。

REF 出力基準が設定されている場合（50ページの「出力基準の設定」を参照）。

S 信号発生器がGPIB、USBまたはVXI-11/ソケット (LAN) インタフェース経由でサービス・リクエスト (SRQ) を出した場合。

SWEEP 信号発生器が現在、リスト・モードまたはステップ・モードで掃引を行っている場合。

SWMAN 信号発生器が手動掃引モードにある場合。

T 信号発生器がトーカ・モードにあり、GPIB、USBまたはVXI-11/ソケット (LAN) インタフェース経由で情報を送信している場合。

UNLEVEL 信号発生器が適切な出力レベルを維持できない場合。このインジケータが表示されても、測定器に異常があるとは限りません。正常に動
作している場合でも発生する可能性があります。ALC回路がオフの場合は、同じ位置にALC OFFという別のインジケータが表示されます

（上のALC OFFを参照）。

UNLOCK いずれかのフェーズ・ロック・ループがフェーズ・ロックを維持できない場合。どのループがロックできないかは、エラー・メッセージ
を見ればわかります（42ページの「エラー・メッセージの読込み」を参照）。

WINIT 信号発生器がシングル掃引が開始されるのを待っている場合。

インジケータ どういった場合に表示されるか . . .
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信号発生器の概要
リア・パネルの概要
リア・パネルの概要

1. AC電源コンセント

AC電源コード・コンセントには、信号発生器に付属の3極AC電源コードを接続します。電源設定要件および電源コードの

詳細については、『インストール・ガイド』を参照してください。

2. SWEEP OUT

3. AM

コネクタ BNC（メス）

2 kΩの負荷をドライブ可能

インピーダンス<1Ω

信号 電圧レンジ：掃引幅に関係なく、0～＋10 V
掃引モードで：掃引の開始＝0 V、掃引の終了＝＋10 V
CWモードで：出力なし

これは多目的コネクタです。信号ルーティングの選択については、33ページと57ページを参照してください。

コネクタ BNC（メス） インピーダンスは通常50Ω

信号 指定の変調度を実現する外部からの±1Vp信号。

損傷レベル 5Vrmsおよび10 Vp

2. SWEEP OUT 

3. AM 
4. FM 

5. PULSE 

6. TRIG IN 

7. TRIG OUT 

8. REF IN 

10. GPIB 
11. LAN 

12. デバイスUSB 

9. 10 MHz OUT 

デジタル変調コネクタ（ベクトル・モデルのみ）（12ページ） 1. AC電源コンセント 

オプション
1EMのみ

5ページを参照
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信号発生器の概要
リア・パネルの概要
4. FM

5. PULSE

6. TRIG IN

7. TRIG OUT

8. REF IN

工場設定モードでは、信号発生器はこのコネクタの有効基準信号を検出して、内部基準動作から外部基準動作に自動的に

切り替わります。23ページの「信号発生器のプリセット」を参照してください。オプション1ER（柔軟な基準入力）を使

用する場合は、使用したい外部基準周波数を信号発生器に明示的に知らせる必要があります。フロント・パネルから、ま

たはリモート・インタフェース経由で情報を入力します。

コネクタ BNC（メス） インピーダンスは通常50Ω

信号 指定の偏差を実現する外部からの±1Vp信号。

損傷レベル 5Vrmsおよび10 Vp

コネクタ BNC（メス） インピーダンスは通常50Ω

信号 外部供給：±1 V＝オン、0 V＝オフ 

損傷レベル 5Vrmsおよび10 Vp

コネクタ BNC（メス） 高インピーダンス

信号 手動掃引モードのポイントツーポイントや外部掃引モードのLF掃引などのトリガ動作用の外部から

のTTLまたはCMOS信号。

立ち上がりエッジまたは立ち下がりエッジでトリガすることができます。

損傷レベル ≦−0.5 Vおよび≧＋5.5 V

コネクタ BNC（メス） インピーダンスは通常50Ω

信号 待ちシーケンスの開始時、または手動掃引モードでポイント・トリガを待っているときにハイになるTTL
信号。 
待ちシーケンスが終了するか、ポイント・トリガが受信されると、ローになります。 
論理極性は反転できます。

これは多目的コネクタです。信号ルーティングの選択については、33ページと57ページを参照してください。

コネクタ BNC（メス） インピーダンスは通常50Ω

信号 ±1 ppm以内の外部タイムベース基準からの−3.5～＋20 dBm信号。
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信号発生器の概要
リア・パネルの概要
9. 10 MHz OUT

10. GPIB

このコネクタは、外部コントローラなどの互換デバイスとの通信を可能にします。また、信号発生器のリモート制御に使

用可能な3つのコネクタのうちの1つです。（11. LANおよび12. デバイスUSBを参照してください）。

11. LAN

信号発生器はこのコネクタを経由したローカル・エリア・ネットワーク (LAN) ベースの通信に対応しているので、LANに

接続しているコンピュータによってリモートからプログラムできます。LANインタフェースはLXIクラスCに準拠していま

すが、auto−MDIXには対応していません。信号発生器は1本のケーブルで100 mまでを限界とします (100Base-T)。LANの

詳細については、『プログラミング・ガイド』を参照してください。

12. デバイスUSB

このユニバーサル・シリアル・バス (USB) コネクタを使用してPCを接続して、信号発生器をリモート制御します。

コネクタ BNC（メス） インピーダンスは通常50Ω

信号 ＞4 dBmの公称信号レベル。

コネクタ Mini-B

USBプロトコル バージョン2.0
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信号発生器の概要
リア・パネルの概要
デジタル変調コネクタ（ベクトル・モデルのみ）

I OUT、QOUT、  OUT、  OUT

EXT CLOCK

EVENT 1

コネクタ タイプ：BNC（メス） インピーダンス：50Ω
DC結合

信号

I OUT 内蔵ベースバンド・ジェネレータからのI/Q変調のアナログ同相成分。

Q OUT 内蔵ベースバンド・ジェネレータからのI/Q変調のアナログ直交位相成分。

 OUT I OUTコネクタとの併用により、平衡a ベースバンド信号を入力。

a 平衡信号は、2 本の導線に存在する、グランドに対して対称で、極性が逆（位相が 180 °逆）の信号です。

 OUT Q OUTコネクタとの併用により、平衡aベースバンド信号を入力。

損傷レベル > 1 Vrms DC原点オフセット 通常は<10 mV

出力信号レベル（50Ω負荷終端）

• 0.5Vpk（代表値）、I/Qベクトルの1単位長に相当

• 0.69 Vpk (2.84 dB)（代表値）、π/4 DQPSKの最大クレスト・ファクタ、α ＝ 0.5

• 0.71 Vpk (3.08 dB)（代表値）、π/4 DQPSKの最大クレスト・ファクタ、α ＝ 0.35

• 通常は1 Vp-p（最大）

コネクタ BNC（メス） インピーダンスは通常50Ω

信号 立ち上がりエッジが開始データ・ビットと一致する外部からのTTLまたはCMOSビット・クロック信号。 
立ち下がりエッジを使って外部信号の同期がとられます。

この信号は、デジタル変調アプリケーションに用いられます。

損傷レベル >＋8および< −4V 最高クロック速度　50 MHz

コネクタ BNC（メス） インピーダンス：通常は50Ω

信号 データ・パターン、フレーム、タイムスロットの開始をトリガするのに用いることができるパルス。 
±1タイムスロットまで調整可能。分解能＝1ビット

マーカ

各任意波形ポイントは、対応するマーカ・オン／オフ条件を持ちます。 
マーカ1レベル＝＋3.3 V CMOSハイ（正の極性を選択した場合）、－3.3 V CMOSロー（負の極性を選

択した場合）。 
任意波形のマーカ 1がオンになると必ず、このコネクタで出力が発生します（82ページの「波形マー

カの使用」を参照）。

損傷レベル >＋8および<−4V

I Q

I

Q
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信号発生器の概要
リア・パネルの概要
PAT TRIG IN

DIGITAL BUS I/O

Agilent Technologiesの信号作成ソフトウェアによって使用されるバス。このコネクタは一般用ではありません。信号作成

ソフトウェア・オプションがインストールされている場合にのみ信号が存在します（詳細については、

http://www.agilent.com/find/signalcreationをご覧ください）。

AUX I/O

コネクタ BNC（メス） インピーダンス：通常は50Ω

信号 TTL/CMOSロー－TTL/CMOSハイまたはTTL/CMOSハイ－TTL/CMOSロー・エッジでのトリガ。 
このコネクタへの入力により、内蔵のデジタル変調パターン・ジェネレータは、シングル・パターン

出力を開始したり、連続的に出力されているパターンを停止して再同期させたりします。 
トリガとデータ・ビット・クロックを同期させるために、トリガ・エッジがラッチされ、内部データ・

ビット・クロックの立ち下がりエッジの間にサンプリングされます。 
これは全ARB波形発生器トリガの外部トリガです。

最小トリガ入力パルス幅（ハイまたはロー）＝100 ns

最小トリガ遅延（トリガ・エッジからフレームの第1ビット）＝1.5～2.5ビット・クロック周期

損傷レベル >＋8および< −4V

リア・パネルの50ピン・コネクタ（メス）を確認25 1

2650

ピン 1 ＝イベント 1
ピン 2 ＝イベント 2
ピン 3 ＝イベント 3
ピン 4 ＝イベント 4
ピン 5 ＝サンプリング・レート・

クロック出力
ピン 6 ＝パターン・トリガ入力 2

ピン 7 ～ 25 ＝予約 *

ピン 26 ～ 50 ＝グランド

* 将来の機能

イベント1、2、3、4（ピン1－4）
データ・パターン、フレーム、タイムスロットの開始をトリガするのに用いることができるパルス。 
±1タイムスロットまで調整可能。分解能＝1ビット

マーカ
各任意波形ポイントは、対応するマーカ・オン／オフ条件を持ちます。 
マーカ・レベル＝＋3.3 V CMOSハイ（正の極性を選択した場合）、－3.3 V CMOSロー（負の極性を選択した場合）。

任意波形の対応するマーカがオンになると必ず、これらのピンで出力が発生します（82ページの「波形マーカの使用」を参照）。

サンプリング・レート・クロック出力（ピン5）
この信号は、内蔵ベースバンド・ジェネレータで用いられます。このピンを経由して、シリアル・データを同期させるためのCMOSビッ

ト・クロック信号が送られます。 
Damage levels: > +5.5 and < −0.5V　

パターン・トリガ入力2（ピン6）
TTL/CMOSロー－TTL/CMOSハイまたはTTL/CMOSハイ－TTL/CMOSロー・エッジでのトリガ。 
このコネクタへの入力により、内蔵のデジタル変調パターン・ジェネレータは、シングル•パターン出力を開始したり、連続的に出力され

ているパターンを停止して再同期させたりします。 

トリガとデータ・ビット・クロックを同期させるために、トリガ・エッジがラッチされ、内部データ・ビット・クロックの立ち下がり
エッジの間にサンプリングされます。 

これは全ARB波形発生器トリガの外部トリガです。最小パルス幅＝100ns Damage levels: > +5.5 and < −0.5V
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信号発生器の概要
リア・パネルの概要
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2 プリファレンスの設定とオプションの有効化

Utilityメニューからは、ユーザ操作／リモート操作用のプリファレンスや測定器オプションを有効化するためのメニュー

にアクセスできます。

16ページ

「フロントパネルのノブの分解能」 17ページ

17ページ

「オプションの有効化」 21ページ

「GPIBインタフェースの設定」 19ページ

「LANインタフェースの設定」 20ページ

「LANサービスの有効化：ブラウザ、ソケット、VXI-11」 20ページ

ユーザ・プリファレンス

リモート操作用プリファレンス

「時間／日付の設定」 18ページ

「ファームウェアのアップグレード」 18ページ
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 15



プリファレンスの設定とオプションの有効化
ユーザ・プリファレンス
ユーザ・プリファレンス

Utilityメニューから、以下のユーザ・プリファレンスを設定できます。

• 下の「ディスプレイの設定」

• 「電源投入とプリセット」 17ページ

• 「フロントパネルのノブの分解能」 17ページ

ディスプレイの設定

注記 明度とコントラストを最小値に設定すると、暗すぎてソフトキーが見えない場合があります。この場合には、上

の図を参照してBrightnessソフトキーとContrastソフトキーの位置を確認し、表示がよく見えるように値を調整

してください。

レンジ：15～100

レンジ：35～55

レンジ：1～12時間（1時間単位）

Light Only：ディスプレイのライトはオフ、テキストは低輝度表示のまま。 

Light & Text：ディスプレイのライトとテキストをオフ。

ディスプレイが長期間変化しない場合は、このモードを使用してテキストが
ディスプレイに焼きつかないようにします。

オンにすると、リモート制御バスによって
実行されたコマンドに応じて、信号発生器
のディスプレイが更新されます。

色なし、高い明度

Utility > Display >

139ページの「Secure Displayの使用（オプション006のみ）」も

参照してください。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください

137ページ

明るい背景に
黒いテキスト。

暗い背景に
明るいテキスト。
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プリファレンスの設定とオプションの有効化
ユーザ・プリファレンス
電源投入とプリセット

フロントパネルのノブの分解能

プリセット後の目的のGPIB言語を選択します。

『プログラミング・ガイド』および『SCPIリファレンス』

も参照してください。

Utility > Power On/Preset >

永続設定の復元
（電源の入れ直し、プリセット、リコールの影響を
受けない）工場設定の復元。

8648がプリセット言語またはGPIBリモート言語として選択した

場合のみ使用可能（19ページを参照）。

注記

ユーザ・プリセットを定義するには、測定器を必要に応じて設定し、User Preset > Save User Presetを押します。

現在の機能の増分値をアクティブ入力に設定します。

Utility > 
Instrument Adjustments >

増分値とステップ／ノブ比によって、ノブを回すたびに変化するアクティブ機能の

値の量が決まります。

例えば、アクティブ機能の増分値が10 dB、ステップ／ノブ比が50 / の場合、ノブを

回すたびにアクティブ機能の値が0.2 dB (10 dBの1/50) 変化します。 

ノブ1回転の変化量を変更するには、増分値、ステップ・ノブ比またはその両方を変

更します。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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プリファレンスの設定とオプションの有効化
ファームウェアのアップグレード
時間／日付の設定

信号発生器のファームウェアは、時間と日付をト

ラッキングして、時間／日付基準ポイントに設定

されている最新の時間と日付を使用します。

時間／日付を進める

時間や日付を進める場合は、インストールされている時間ベースのライセンスを使い果してしまい、信号の時間／日付基
準ポイントをリセットすることになるので注意してください。信号発生器の現在の基準ポイントより後の時間または日付

を新たに設定した場合は、その日付が新たな基準ポイントとなります。後で日付を戻した場合、次のセクションで説明す

るような危険を冒すことになります。

時間／日付を戻す

時間を戻した場合、信号発生器は時間が基準ポイントから後退したことに気付きます。時間を25時間以上戻した場合、時

間を戻す時点でインストールされているライセンスがなくても、信号発生器は時間ベースのライセンスを使用できなくな

ります。この場合は、基準ポイント以前の25時間以内または基準ポイント以降のいずれかの時点に日付を戻すことによっ

て、信号発生器は時間ベースのライセンスを再び使用できるようになります。

25時間以上時間を戻さなければならないことがわかった場合（例えば、誤って時間を進め過ぎてしまった場合）は、時間

ベースのライセンスを使用したければ、Agilent Technologiesにアシスタンスを依頼してください（151ページを参照）。

ファームウェアのアップグレード

新しいファームウェア・リリースについては、http://www.agilent.com/find/upgradeassistantをご覧ください。

時間や日付を変更すると、時間ベース

のライセンスがインストールされてい

ない場合でも、信号発生器の時間ベー

スのライセンスの使用能力に影響が及

ぶ可能性があります。

Utility > 
Instrument Adjustments >注意

元の時間／日付基準ポイント

時間

新たな時間／日付基準ポイント

信号発生器が時間ベースのライセンス
を使用できなくなるポイント。

時間

現在の時間／日付基準ポイント

> 25時間
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プリファレンスの設定とオプションの有効化
リモート操作用プリファレンス
リモート操作用プリファレンス

信号発生器のリモート操作の詳細については、『プログラミング・ガイド』を参照してください。

GPIBインタフェースの設定

20ページ

下を参照

20ページ

注記

USBも使用可能です。設定が一切不要なので、メニューには示されていません。

リモートでの測定器の使用法の詳細については、『プログラミング・ガイド』を
参照してください。

目的のGPIB言語を選択します。

Utility > I/O Config >

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください。
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プリファレンスの設定とオプションの有効化
リモート操作用プリファレンス
LANインタフェースの設定

LANサービスの有効化：ブラウザ、ソケット、VXI-11

注記
信号発生器のLANへの接続には、100Base-T LAN
ケーブルを使用してください。 

信号発生器をPCに直接接続する場合は、クロス

オーバー・ケーブルを使用してください。

リモートでの測定器の使用法の詳細については、
『プログラミング・ガイド』を参照してください。

Utility > I/O Config >

20ページを

参照

『プログラミング・ガイド』
にリスト

測定器のファイル・システムへのリモート
（ブラウザ）アクセスを可能にします。

ブラウザを使って信号発生器を制御します。

Utility > I/O Config >

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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プリファレンスの設定とオプションの有効化
オプションの有効化
オプションの有効化

オプションを有効にするには次の2つの方法があります。 

• ライセンス・マネージャ・ソフトウェア・ユーティリティを使用する。

1. www.agilent.com/find/LicenseManagerからユーティリティをダウンロードする。 

2. ユーティリティを実行し、プロンプトに従う。

• SCPIコマンドを使用する（『プログラミング・ガイド』を参照）。

オプション／ライセンスの表示

Utility > 
Instrument Info >

サービス・ソフトウェア・ライセンスが

一部の Signal Studio アプリケーションからの

測定器オプションがここに表示されます。
チェック・マークはオプションが使用可能
であることを示しています。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください

波形ライセンスがここに表示されます。

ここに表示されます。
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プリファレンスの設定とオプションの有効化
オプションの有効化
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3 基本操作

この章では、基本的なフロント・パネルの操作を紹介します。リモート操作については、『プログラミング・ガイド』を参

照してください。

• 下の「信号発生器のプリセット」

• 下の「キーの説明の表示」

• 「数およびテキストの入力／編集」 24ページ

• 「周波数およびパワー（振幅）の設定」 26ページ

• 「掃引出力の設定」 27ページ

• 「搬送波信号の変調」 34ページ

• 「データの表示、保存、リコール」 35ページ

• 「エラー・メッセージの読込み」 42ページ

信号発生器のプリセット

キーの説明の表示

信号発生器を既知の状態に戻すには、PresetかUser Presetを押します。

Presetは工場プリセットで、User Presetはカスタム・プリセット*です（17ページも参照）。 

永続設定（プリセット、ユーザ・プリセット、電源の入れ直しの影響を受けない設定）をリセットするには、
次のように押します：Utility > Power On/Preset >Remote System Defaults。

*保存されている各ステート・ファイルに異なる名前を付けることによって複数のプリセット・ユーザを作成できます（40ページの図

3-6を参照）。

Helpハードキーを押すことによって、ハードキーまたはソフトキーの説明を表示できます。

ヘルプ・テキストを表示する手順：

1. Helpを押します。

2. 目的のキーを押します。
ヘルプが表示されます。キーの通常の機能は実行されません。
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基本操作
数およびテキストの入力／編集
数およびテキストの入力／編集

数の入力とカーソルの移動

アルファベットの入力

データ入力用のソフトキーは各種メ

ニューにあります。各メニューのソフト

キーの機能を確認するには、ヘルプ・キー

を使用して（23ページを参照）、説明を

表示してください。アルファベット・テー

ブルのヘルプを表示するには、テーブル

の隣のソフトキーを使用します。

アルファベットの使用が可能なデータを

選択すると、右側に示されているメ

ニューのうちの1つが表示されます。

矢印キーまたはノブを使って目的の文字

を強調表示し、Selectハードキー（また

はアルファベット・テーブルの隣のソフ

トキー）を押します。誤りを訂正するに

は、Bk SpまたはClear Textを使用します。

入力を終了するには、Enterソフトキーを押します。

16進文字の場合は、このメニューの一部が表示されます。文字メニューには、AからFまでの文字だけが表示されます（他

の値についてはテンキーを使用してください）。

上下の矢印キーは、選択（強調表示）した数値を増減したり、カーソルを垂直方向に移動します。

バックスペースはカーソルを左に

移動しながら、文字を削除します。

左右の矢印キーは、カーソルを水平方向に移動します。

Page up/down キーは、データ・テーブルを表示エリア内で上下に移動します。

 

数字キーと小数点を使って数値データを入力します。

負符号を入力します

各キーの詳細については、23ページを参照してください。

エントリの一部を選択するには、アルファベットを入力する場合と同様に、
Selectハードキーを使用します。一部のメニューでは、Selectキーはターミネー

タの役割も果たし、Enterソフトキーに相当します。

（このキーはトグル・キーです）。 注記：ノブを回すことにより、数値を増

減したり、強調表示されている桁または

文字を変更したり、リストまたは行内の

項目を順次確認することができます。

フロントパネルのノブの分解能（19ペー

ジ）も参照してください。

負の値を指定するには、数値の前または後に

アルファベット・テー
ブル内ではなく、アク
ティブ値内にカーソ
ルを移動するには、ア
ルファベット・テーブ
ルをオフにします。

保存されている機器ステート・ファイ
ルのコメントを追加／編集します（38
ページを参照）。

注記：ファイル名は25文字までです。
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基本操作
数およびテキストの入力／編集
例：テーブル・エディタの使用法

テーブル・エディタは設定作業を容易にします。以下の手順では、テーブル・エディタの基本的な機能を、リスト・モー

ド値テーブル・エディタを用いて説明します。

1. 信号発生器をプリセットします：Presetを押します。

2. テーブル・エディタをオープンします：Sweep > More > Configure List Sweepを押します。

下の図のようなエディタが表示されます。

3. 目的の項目を強調表示します：矢印キーまたはノブを使用してカーソルを移動します。 

4. （オプション）選択した項目をアクティブ機能エリアに表示します：Selectを押します。

5. 値を編集します：

• 値がアクティブ機能エリアに表示されている場合は、ノブ、矢印キーまたはテンキーを使って値を変更します。

• 値がアクティブ機能エリアに表示されていない場合は、テンキーを使って目的の値を入力します（入力した値が

アクティブ機能エリアに表示されます）。

6. 入力を終了します：

• 目的の単位（使用可能な場合）を押します。

• 単位が表示されていない場合は、Enter（使用可能な場合）またはSelectを選択します。

変更した項目がテーブル内に表示されます。

カーソル

テーブル・エディタ用ソフトキーテーブル・エディタ名 テーブル項目

編集を行う場合に、アクティブ項目を表示します。 選択項目が強調表示されます。選択した項目をアクティブ（編集可能）項目に
するには、Selectを押すか、目的の値を入力します。

テーブル項目はデータ・
フィールドとも呼ばれ
ます。

テーブル項目値のロード、検索、変更、
保存に使用します。各キーの詳細につい
ては、キーのヘルプを使用してください。 
Helpハードキーを押してから、目的の

キーを押します。

アクティブ機能エリア

現在のページ番号／全ページ数

別のメニューが使
用可能であること
を示しています。別
のメニューを表示
するには、Moreを
押します。

（ベクトル・モデルの
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基本操作
周波数およびパワー（振幅）の設定
周波数およびパワー（振幅）の設定

図3-1　FrequencyソフトキーとAmplitudeソフトキー

例： Configuring a 700 MHz, −20 dBm Continuous Wave Output

1. 信号発生器をプリセットします。

最大仕様周波数と最小パワー・レベルが表示されます（7ページのフロント・パネルの表示エリアを参照）。

2. 周波数を700 MHzに設定します：Freq > 700 > MHzを押します。 

ディスプレイのFREQUENCYエリアとアクティブ入力エリアに、700 MHzと表示されます。

3. 振幅を–20 dBmに設定します：Amptd > –20 > dBmを押します。

ディスプレイのAMPLITUDEエリアの表示が–20 dBmに変わり、振幅値がアクティブ入力になります。別のファンクショ

ン・キーを押すまでは、振幅がアクティブ機能であり続けます。

4. RF出力をオンにします：RF On/Offを押します。

RF出力LEDが点灯し、700 MHz、–20 dBmのCW信号がRF OUTPUTコネクタに出力されます。

 

47ページ

を参照

オプション
1ERのみ

次のメニューを表示するには、Moreを押します。

44ページ

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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基本操作
掃引出力の設定
掃引出力の設定

2通りの方法で、周波数ポイントと振幅ポイントによって掃引させることができます。

ステップ掃引（28ページ）では、1つの選択した周波数／振幅から別の周波数／振幅に向って直線的または対数的に掃引

され、掃引中に直線的／対数的間隔のポイント（ステップ）で休止状態になります。掃引は、順方向／逆方向に、または

手動で行うことができます。 

リスト掃引（29ページ）では、周波数と振幅を、不等間隔で、非直線的昇順、降順またはランダムな順序で入力できます。

リスト掃引では、現在のステップ掃引値をコピーしたり、任意波形を掃引に含めたり（ベクトル・モデル）、リスト掃引

データをファイル・カタログに保存することも可能です（37ページ）。

図3-2　掃引用ソフトキー

各ポイントでのトリガを待つこと
なく掃引します。ポイント・トリ
ガは最初の掃引の前に待ち時間だ
け休止します。

TTL/CMOS信号をTrigger Inコネ

クタに印加。

ソースに選択したものには、トリ
ガ・イベントを定期的に発行。

タイマ・トリガとシングル掃引を併
用すると、最初の掃引の前に遅延が
生じます。

リモート・コマンドでトリガ。

ストップ周波数／振
幅からスタート周波
数／振幅に向ってダ
ウン掃引。

スタート周波数／振
幅からストップ周波
数／振幅に向って
アップ掃引。

28ページを

参照

29ページ

を参照

選択した掃引タイプによって、表示されるパラメータが決まります。

Sweep Type ＝ List
の場合に使用可能

33ページ

を参照

周波数掃引中は、CW周波数は表示されません。振幅掃引中は、振幅は表示されません。

周波数／振幅掃引中は、周波数も振幅も表示されません。

進捗度バー：超高速掃引はランダムまたは
逆方向に掃引しているように見えること
があります。

33ページを参照

各キーの詳細については、キーのヘルプを使用してください（23ページを参照）。
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基本操作
掃引出力の設定
ステップ掃引

ステップ掃引では、1つの選択した周波数／振幅から別の周波数／振幅に向って直線的または対数的に掃引され、掃引中

に直線的／対数的間隔のポイント（ステップ）で休止状態になります。掃引は、順方向／逆方向に、または手動で行うこ

とができます。 

例：連続リニア・ステップ掃引の設定

1. 測定器をプリセットし、Sweep/Listメニューをオープンします：Preset > SWEEPを押します。

デフォルトでは掃引繰り返しとして連続が、ステップ間隔としてリニアがそれぞれ選択されるため、これらのパラメー

タを設定する必要はありません。

2. ステップ掃引メニューを開きます：Configure Step Sweepを押します。

3. 以下のパラメータを設定します。

4. 周波数と振幅の両方を掃引します：Return > Return > Sweep > Freq Off On > Amptd Off Onを押します。

連続掃引がスタート周波数／振幅からストップ周波数／振幅に向って開始されます。SWEEPインジケータが表示され、

CW周波数と振幅は共に空白表示され（掃引中であることを示す）、進捗度バーには掃引の進捗状況が示されます。

5. RF出力をオンにします。 RF On/Offを押します。

RF LEDが点灯し、RF Outputコネクタでの連続掃引が可能になります。

出力： 500～600 MHzおよび−20＝0 dBmまで、500 msの待ち時間、6つの等間隔のポイントで連続的に掃引される信号。

スタート周波数500 MHz： Freq Start > 500 > MHzを押す

ストップ周波数600 MHz： Freq Stop > 600 > MHzを押す

掃引の開始時の振幅、−20 dBm： Amptd Start > −20 > dBmを押す

掃引の終了時の振幅、0 dBm： Amptd Stop > 0 > dBmを押す

6つの掃引ポイント： # Points > 6 > Enterを押す

各ポイントでの待ち時間、500 ms： More > Step Dwell > 500 > msecを押す

待ち時間＝信号が安定し、掃引が次のポイントに移るまでの
測定が可能な時間。

（ポイントツーポイント時間は待ち時間の設定値と処理時間、
スイッチング時間、セトリング時間の合計です）。 

Lin＝掃引全体を通して等間隔のステップ。出力は直線的に変化します。

Log＝ステップ間隔は掃引全体を通して対数的に増加。出力は指数関数的
に変化します。

ステップ掃引の待ち時間とリスト掃引の待ち時間は別個に
設定します。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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基本操作
掃引出力の設定
リスト掃引

リスト掃引では、周波数と振幅を、不等間隔で、非直線的昇順、降順またはランダムな順序で入力できます。リスト掃引

では、現在のステップ掃引値をコピーしたり、波形を掃引に含めたり（ベクトル・モデル）、リスト掃引データをファイ

ル・カタログに保存することも可能です（37ページ）。待ち時間は各ポイントで編集できます。

図3-3　リスト掃引設定用のソフトキーおよびディスプレイ

30ページを参照

選択した掃引によって、信号発生器が使用する待ち時間が決まります。ステップ掃引の待ち時
間はすべてのポイントで同じですが、リスト掃引の待ち時間はポイントごとに異なる場合があ
ります。

待ち時間＝信号が安定し、掃引が次のポイントに移るまでの測定が可能な時間。

ポイントツーポイント時間＝待ち時間の設定値と処理時間、スイッチング時間、セトリング時
間の合計です。 

各行は対応する掃引ポ
イントを定義します。例
えば、行1はポイント1を
定義します。

28ページを参照

ベクトル・モデル、 
および 
Sweep Type＝Listの場合のみ使用可能。

選択された掃引タイプ・
パラメータを表示します
（30ページを参照）。

ベクトル・モデルのみ

33ページを参照

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください

波形エントリが選択されて
いる場合のみ使用可能
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基本操作
掃引出力の設定
例：ステップ掃引データを使用したリスト掃引の設定

1. 必要なステップ掃引をセットアップしますが、掃引はオンにしません。この例では、28ページで設定したステップ掃

引を使用します。

2. SWEEPメニューで、掃引タイプをリストに変更します： 
SWEEP > Sweep Type List Stepを押して、Listを強調表示します。 

ディスプレイには掃引リスト・パラメータが表示されます（下の図を参照）。

3. ステップ掃引メニューを開きます：More > Configure List Sweepを押します。

4. メニューの以前に設定した値をクリアして、ステップ掃引で定義したポイントをリストにロードします：

More > Preset List > Preset with Step Sweep > Confirm Presetを押します。 

図のように、ステップ掃引からロードした値でディスプレイが更新されます。

5. 周波数と振幅を掃引します：SWEEP（ハードキー）> Sweep > Freq Off On > Amptd Off Onを押します。

掃引を設定すると、掃引機能がオンになります。連続掃引が開始されます。ディスプレイ上にSWEEPインジケータが

表示され、進捗度バーには掃引の進捗状況が示されます。

6. オンになっていない場合、RF出力をオンにします：RF On/Offを押します。

RF出力LEDが点灯し、RF OUTPUTコネクタでの連続掃引が可能になります。

ベクトル・モデル：

リストをプリセットすると、

以前に選択した波形がすべて

クリアされます。 

リスト掃引波形の選択方法に

ついては、31ページの「例：

リスト掃引ポイントの編集」

を参照してください。

波形はベクトル・モデルで
のみ使用可能です。
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基本操作
掃引出力の設定
例：リスト掃引ポイントの編集

テーブル・エディタの使い方がよくわからない場合は、25ページを参照してください。

1. 必要なリスト掃引を作成します。この例では、前の例で作成したリスト掃引を使用します。

2. 掃引がオンの場合は、オフにします。掃引がオンの場合、リスト掃引パラメータを編集するとエラーが発生します。 

3. 掃引タイプをリストに設定します：SWEEP > Sweep Type List Stepを押して、Listを強調表示します。

4. リスト・モード値テーブル・エディタで、ポイント1の待ち時間（行1で定義）を100 msに変更します：

a. More > Configure List Sweepを押します。

b. ポイント1の待ち時間を強調表示します。

c. 100 > msecを押します。

テーブルの次の項目（ポイント2の周波数値）が強調表示されます。

5. 選択した周波数値を445 MHzに変更します：445 > MHzを押します。

6. ポイント4とポイント5の間に新しいポイントを追加します：行4の任意のエントリを強調表示して、Insert Rowを押し

ます。

これにより、行4のコピーが行4の下に挿入され、新しいポイント5が作成され、後続の行の番号が付け直されます。

7. 周波数値をポイント5から1行ずつ下にずらします：行5の周波数エントリを強調表示し、More > Insert Itemを押します。

これにより、行5と6の元の周波数値が1行ずつ下にずれ、周波数値だけを持つエントリが行8に作成されます（パワー・

エントリと待ち時間エントリは下にずれません）。

8. 行5の今もアクティブな周波数値を590 MHzに変更します：590 > MHzを押します。行 5のパワーは今もアクティブ・パ

ラメータです。

9. ポイント5の新しいパワー値（−2.5 dBm）を挿入して、ポイント5と6の元のパワー値を1行下にずらします：Insert Item
> −2.5 > dBmを押します。 

10. ポイント8のエントリを完成するために、既存の値のコピーを下にずらして、ポイント7の待ち時間の複製を挿入しま

す：行7の待ち時間を強調表示して、Insert Itemを押します。

11. アナログ測定器の場合は、ステップ14に進んでください。ベクトル測定器の場合は、ステップ12を続けて実行してく

ださい。

12. ポイント2の波形を選択します：

a. ポイント2の波形エントリを強調表示して、More > Select Waveformを押します。

使用可能な波形が表示されます（次の例を参照してください）。

b. 目的の波形（この例では、SINE_TEST）を強調表示し、SelectハードキーまたはSelect Waveformソフトキーを押し

ます。

波形を選択するか、

または

変調なしを選択します。
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基本操作
掃引出力の設定
13. 必要に応じて、波形を選択したい残りのポイントに対してステップ12を繰り返します。下の図は、表示例を示したも

のです。

14. 掃引をオンにします： 
Return > Return > Return > Sweep > Freq Off On > Amptd Off On > Waveform Off Onを押します。

15. RF出力をオンにします（オンになっていない場合）： 
RF On/Offを押します。 

ディスプレイ上にSWEEPインジケータが表示され、信号発生器が掃引中であることが示されます。また、進捗度バー

には掃引の進捗状況が示されます。 

例：シングル掃引の使用法

1. ステップ掃引（28ページ）かリスト掃引（30ページ）を設定します。

2. List/Sweepメニューで、掃引繰り返しをシングルに設定します： 
Sweep Repeat Single Contを押して、Singleを強調表示します。

トリガするまで掃引は発生しません。

ディスプレイ上にWINITインジケータが表示され、掃引の開始待ち中であることが示されます。

3. RF出力をオンにします（オンになっていない場合）：RF On/Offを押します。

4. 掃引を開始します：Single Sweepを押します。

RF Outputコネクタでは、設定した掃引が1回だけ繰り返されます。 

信号発生器の掃引時には、WINITインジケータに代わってSWEEPがディスプレイ上に表示され、進捗度バーには掃引の

進捗状況が示されます。 

シングル掃引の終了時に、進捗度バーは消え、SWEEPインジケータに代わってWINITインジケータが表示されます。

空のエントリはCW (no modulation) を
選択したのと同じです。
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基本操作
掃引出力の設定
例：掃引の手動制御

1. ステップ掃引（28ページ）かリスト掃引（30ページ）を設定します。

2. Sweep/Listメニューで、掃引するパラメータを選択します：Sweep > parameterを押します。

3. 手動モードを選択します：Return > More > Manual Mode Off Onを押します。

4. RF出力をオンにします（オンになっていない場合）： RF On/Offを押します。

5. 出力するポイントを選択します：Manual Point > number > Enterを押します。

6. ノブまたは矢印キーを使って、ポイントからポイントへ移動します。

信号のルーティング

Sweep > More > More > Route Connectors >

選択した掃引ポイントのパラメータによって、
RF Outputコネクタに出力可能な信号が定義され

ます。

手動ポイントを入力した場合、
進捗度バーが選択したポイント
に移動して停止します。

SWMANインジケータは、掃引

が手動掃引モードにあるこ
とを示します。

各出力コネクタにルーティングしたい
信号を選択します。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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基本操作
搬送波信号の変調
搬送波信号の変調

搬送波信号を変調するには、以下の2つが必要です。

• アクティブ変調フォーマット

および

• RF出力の変調がオン

例

1. 信号発生器をプリセットします。

2. AM変調をオンにします：AM > AM Off Onを押します（オプションUNTが必要）。

変調フォーマットは、信号パラメータを設定する前でも後でもオンにできます。

変調フォーマットを作成しても、搬送波信号は変調されません。

信号が作成されると、フォーマット名を示すインジケータが表示され、変調フォーマットがアクティブであることが

示されます。

3. RF出力の変調をオンにします：LEDが点灯するまでMod On/Offキーを押します。

アクティブ変調フォーマットがない場合に変調をオンにしても、変調フォーマットをオンにするまでは搬送波信号は

変調されません。

注記 変調をオフにするには、LEDがオフになるまでMod On/Off キーを押します。

Mod On/Offキーがオフの場合は、アクティブな変調フォーマットがあっても、搬送波信号は変調されません。

4. RF出力コネクタに変調搬送波を出力するには、LEDが点灯するまでRF On/Offキーを押します。

以下も参照して

ください。 
「アナログ変調の使用法（オプションUNTのみ）」53ページ

「パルス変調の使用法（オプションUNU）」57ページ

「I/Q変調」121ページ

 

アクティブ AM 変調インジケータ

AM変調フォーマットはオン。

LEDが点灯している場合は、アク
ティブ変調フォーマットにより搬
送波の変調が可能であることを示
します。
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基本操作
データの表示、保存、リコール
データの表示、保存、リコール

データをファイルとして信号発生器のファイル・カタログに保存して、表示することができます。ファイル・カタログ（図

3-4を参照）から、保存されているファイルを削除したり、コピーしたり、名前を変更することができます。

• 「保存されているファイルの表示」 36ページ

• 「データのセーブ／リコール」 37ページ

以下も参照してください。

「機器ステート・ファイルの場合」 38ページ

「内部／外部メディアの選択」 41ページ

「波形セグメントのストア、ロード、再生」 70ページ

図3-4　ファイル用ソフトキー

測定器の操作パラメータ（38ページを参照）。

リスト・モード値テーブル・エディタからデータを掃
引します。

ユーザ・フラットネス校正補正。

136ページを参照

注記： 使用できるファイル・タイプは、インストールされたオプションにより異なります。

波形ファイルと対応するマーカ／ヘッダ
情報。

注記：
外部USBメディアを接続せずにExternal Mediaメニューをオープン

した場合は、"Eternal Media Not Detected（外部メディアが検出さ

れません" というメッセージが表示されます。

41ページを参照

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 35



基本操作
データの表示、保存、リコール
保存されているファイルの表示

信号発生器に保存されているファイル

1. File > Catalog Type > 目的のカタログを押します。

カタログ内のファイルがアルファベット順に表示されます。ファイル情報には以下が含まれます。

• ファイル名

• タイプ

• ファイル・サイズ

• 変更日時

外部メディアに保存されているファイル

1. 外部メディアを接続します。

測定器にはExternal Mediaディレクトリが表示されます。

2. USERディレクトリを強調表示し、Selectを押します。

外部メディアのファイル・ディレクトリがアルファベット順に表示されます（下の図を参照）。

Page UpキーとPage Downキーを

使って、USERディレクトリの内容

を確認します。
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基本操作
データの表示、保存、リコール
データのセーブ／リコール

データのセーブ／リコール方法は、データによって異なります。

• 機器ステート・ファイルには測定器の設定が保存されています。このタイプのファイルの場合は、Saveハードキーと

Recallハードキーを使用します（38ページの図3-5を参照）。

• 他のタイプのファイルの場合は、ファイル作成用メニューにあるLoad/Storeソフトキー（下を参照）を使用します。 

注記 ファイル名は25文字までです。

このメニューを使ってファイル名を
入力します（24ページを参照）。各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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基本操作
データの表示、保存、リコール
機器ステート・ファイルの場合

図3-5　SaveソフトキーとRecallソフトキー

例：機器ステートの保存

1. 信号発生器をプリセットし、以下を設定します。

2. （オプション、ベクトル・モデルのみ）波形ファイルをこれらの設定と対応付けます。 

a. Mode > Dual ARB > Select Waveformを押します。

b. 目的のファイルを強調表示し、Select Waveformを押します。ファイルがリストされていない場合は、まずファイ

ルを内部／外部メディアからBBGメディアに移動する必要があります（71ページを参照）。 

3. 目的のメモリ・シーケンス（この例の場合は1）を選択します：Save > Select Seq > 1 > Enterを押します。

4. 目的のレジスタ（この例の場合は01）を選択します：Select Reg > 1 > Save Regを押します。 

波形が現在選択されている場合は、機器ステートを保存すると波形ファイル名も保存されます。 

5. 説明的なコメントをシーケンス1のレジスタ01に追加します： 

Add Comment to Seq[1] Reg[01]を押してコメントを入力したら、Enterを押します。Recallを押すと、Saved Statesリスト

にコメントが表示されます。機器ステートに対応する波形がない場合は、波形名を入力することにより、どの機器ス

テートがどの波形に当てはまるか簡単に確認できます。 

ステート・ファイルには、以下の情報は保存されません。

システムのセキュリティ・レベル リスト・モード周波数 ホスト名 リモート言語 FM偏移

システムのセキュリティ・レベル表示 リスト・モード・パワー IPアドレス FTPサーバ PM偏移

システムのセキュリティ・レベル状態 リスト・モード待ち時間 サブネット・マスク 手動DHCP MAC

Webサーバ (HTTP) リスト・モード・シーケンス デフォルト・ゲートウェイ VXI-11 SCPI ユーザ・パワー補正

ソケットSCPI (TELNET) ステート表示のオン／オフ ARBファイル リスト・ファイル I/Q校正データ

• Frequency: 800 MHz • Amplitude: 0 dBm • RF: on

測定器の設定（ステート）は測定器のステート・メモリに
保存されます。ステート・メモリは10シーケンス (1～9)
に分割され、各シーケンスは100個のレジスタ (00～99) で
構成されます。

SaveおよびRecallメニューの削除用ソフトキーを使っ

て、特定のレジスタの内容やステート・ファイル・カタロ
グの全シーケンスの内容を削除することができます。 

削除の確認が求められます。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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基本操作
データの表示、保存、リコール
例：機器ステートのリコール

1. 信号発生器をプリセットします。

2. Recallを押します。

Select Seqソフトキーによって最後に使用したシーケンスが示されます。ディスプレイには、そのシーケンスのレジス

タに保存されているステートがすべてリストされます。RECALL Regがアクティブ・エントリです。 

3. 目的の機器ステートを選択します。 

目的のステートが現在選択されているシーケンス内にリストされている場合は、目的の番号 > Enterを押します。

リストされていない場合は、Select Seq > 目的の番号 > Enter > RECALL Reg > 目的の番号 > Enterを押します。

例：機器ステートと対応する波形ファイルのリコール

1. 目的の機器ステートをリコールします（前の例を参照）。

2. 機器ステートと一緒にリコールする波形ファイルの名前を表示します：Mode > Dual ARBを押します。

名前は、選択した波形で表示されます。機器ステートをリコールしても、波形名がリコールされるだけです。すでに

削除されている波形ファイルが再現されたり、内部／外部メディアにあるファイルがBBGメディアにロードされるこ

とはありません。

3. 目的のファイルが存在していること、BBGメディア内にあることを確認してください（71ページ）。波形ファイルが

BBGメディア内にない場合、次のステップを実行するとエラーが発生します。 

4. 波形ファイルをオンにします：Mode > Dual ARB > ARB Off Onを押します。

例：機器ステートと対応するリスト・ファイルのリコール

機器ステートをリコールしても、リスト掃引のセットアップがリコールされるだけす。周波数／振幅値はリコールされま

せん。リスト・ファイルをファイル・カタログからロードしなければならないので、リスト・ファイルを保存する場合は、

説明的な名前（最長25文字）を付けてください。

1. 目的の機器ステートをリコールします（前の例を参照）。

2. 必要なリスト・ファイルをリコールします： 

a. Sweep > More > Configure List Sweep > More > Load/Storeを押します。

b. 目的のファイルを強調表示し、Load From Selected File > Confirm Load From Fileを押します。
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基本操作
データの表示、保存、リコール
保存されている機器ステートの移動またはコピー

図3-6　機器ステート・ファイル・カタログ

保存されている機器ステートのコメントを変更する手順：

1. Saveを押します。

2. 目的のレジスタを強調表示します。

3. Edit Comment In Seq[n] Reg [nn]を押します。

4. Re-SAVE Seq[n] Reg[nn]を押します。 

これにより、以前に保存した機器ステート設定が新しいコメントで上書きされます。 

シーケンス レジスタ

ユーザ作成のステート・ファイルの
デフォルト名は、ファイルのメモリ
です。

ファイルを移動するには、ファイル
名を目的のシーケンス／レジスタ
に変更します。

既存のファイルと同じ名前を付け
ることはできません。

注意
ステート・ファイルの名前を有効で
ないシーケンス／レジスタ名に変
更した場合、Save メニューにも

Recallメニューにもファイルは表

示されません。
ユーザ・プリセット情報
このファイルの名前を変更した場合、信号発生器はユーザ・プリセット情報とし
て認めなくなります。

ユーザ・プリセットの定義
測定器を必要に応じてセットアップし、User > Save User Presetを押します。

複数のユーザ・プリセットの作成
複数のプリセット条件を異なる名前で設定し、使用したい条件にUSRPRSTと名前を付けます。

別のファイルを使用するには、現在のUSRPRSTの名前を変更し、目的のファイルにUSRPRST
と名前を付けます。

注記

ユーザ・プリセットを定義するには、測定器を必要に応じて設定し、User > Save User Presetを押します。
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基本操作
データの表示、保存、リコール
内部／外部メディアの選択

External Mediaメニュー（下を参照）で、目的のストレージ・タイプを選択します。

外部メディアの使用

記憶媒体をフロント・パネルのUSBコネクタに接続した場合、信号発生器のディスプレイには下の図に示されているメ

ニューが表示され、External USB Storage attached（外部USBストレージが接続されています）というメッセージが

表示されます。USBメディアを取り外すと、External USB Storage detached（外部USBストレージが取り外されまし

た）というメッセージが表示されます。USBメディアを接続せずにExternal Mediaメニューをオープンした場合は、

Eternal Media Not Detected（外部メディアが検出されません） というメッセージが表示されます。

信号発生器では、外部メディアのフォーマット、ディレクトリの作成、ファイル・パーミッションの変更はできません。

これらの操作は、コンピュータを使って実行します。

不揮発性記憶装置
Int = 内部

Ext = 外部。メモリ・スティックを接続していない場合は、
不揮発性記憶装置は使用できません。

Auto = 外部（存在している場合）、そうでなければ内部が使
用されます。

File > More > 
External Media File Manager >

ファイル・タイプ

List　
ステート

波形

ユーザ・フラットネス

ユーザ・プリセット

ライセンス

拡張子

.list　

.state　

.waveform　

.uflat　

.uprst　

.lic　

使用メニュー

Sweepメニュー

Saveメニュー

Modeメニュー

Amplitudeメニュー

User Presetメニュー

Agilentから購入

ファイルを強調表示してSelectを押す...
リストをロードし、掃引を開始する

機器ステートをロードする

波形をロードし、再生する

ユーザ・フラットネスをロードし、適用する

ユーザ・プリセットをロードし、実行する

購入したライセンスをインストールする

確認が必要

ファイル長（拡張子を含む）

内部メディア： 25文字

外部メディア： 39文字

ディレクトリを検索する
には、Selectハードキー

と Up Directory ソフト

キーを使用します。

削除、バックアップ、復元では、
確認が求められます。

信号発生器が使用するディレクトリを外部メディアに設定する手順：
1. ディレクトリに移動します。ディレクトリがパスに表示されます。

2. このキーを押します。
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基本操作
エラー・メッセージの読込み
エラー・メッセージの読込み

エラー状態が発生した場合、信号発生器は、フロント・パネル・ディスプレイ・エラー待ち行列とSCPI（リモート・イン

タフェース）エラー待ち行列の両方に報告します。これら2つの待ち行列は、個別に表示／管理されます。SCPIエラー待

ち行列については、『プログラミング・ガイド』を参照してください。

エラー・メッセージの

フォーマット

フロント・パネル・ディスプレ

イ・エラー待ち行列には、エラー・

メッセージが列挙して ("1/N") 表
示されます。

特性 フロントパネル・ディスプレイ・エラー待ち行列

容量（エラー数） 30

オーバーフロー処理 新しいエラーが入ってくるたびに、最も古いエラーがドロップされます。

エントリの表示 Error > View Next（またはPrevious）Error Pageを押します。

待ち行列のクリア Error > Clear Error Queue(s)を押します。

未解決のエラーa

a 解決する必要のあるエラー。例えば、アンロック。

待ち行列のクリア後に再レポート。

エラーなし
待ち行列が空の場合（待ち行列内のすべてのエラーが読み込まれたか、待ち行列がクリアされた場合）、次のメッセージが待ち
行列に表示されます：
No Error Message(s) in Queue 0 of 0

エラー番号 エラー・メッセージ
エラーの概要

（ディスプレイ上では省略される場合があります）

−222 Data out of range; value clipped to lower limit.

ユーザが特定のリミット値を超える偏差、変調度または内部信号源周波

数を入力したことを示しています

説明はエラー・メッセージ・ファイルに出力されます
（148ページを参照）

（測定器のディスプレイ上には表示されません）

メッセージ番号と詳しい説明

newは、メッセージが最後に表示されてから

以降に作成されたメッセージを示します。

このインジケータは、未読メッセージを示します。

エラー・メッセージは、発生と同時に
ディスプレイの左下に表示されます。
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4 性能の最適化

ここに記載の内容を理解するには、信号発生器の基本動作についての知識が必要です。パワー・レベル／周波数の設定な

どの機能を簡単に操作できない場合、第3章「基本操作」（23ページ） を参照して、内容をよく理解しておいてください。

• 「ユーザ・フラットネス補正の使用法」 44ページ

• 「レベリングなし動作モードの使用法」 47ページ

• 「出力オフセット、基準、逓倍器の使用法」 49ページ
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 43



性能の最適化
ユーザ・フラットネス補正の使用法
ユーザ・フラットネス補正の使用法

ユーザ・フラットネス補正により、最高1601個の連続する直線的または任意の間隔の周波数ポイントのRF 出力振幅を調

整して、ケーブル、スイッチまたはその他のデバイスの外部損失を補正することができます。 

個々のユーザ・フラットネス補正テーブルを作成／保存することができるので、さまざまなテスト・セットアップまたは

周波数レンジのさまざまな補正配列をリコールできます（46ページを参照）。

図4-1　ユーザ・フラットネス補正用のソフトキー

基本的な手順

1. ユーザ・フラットネス配列を作成します：ユーザ・フラットネス補正値を入力します。

2. 必要に応じて、ユーザ・フラットネス補正データを保存します。

3. ユーザ・フラットネス補正をRF出力に適用します。

確認

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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性能の最適化
ユーザ・フラットネス補正の使用法
例：500 MHz～1 GHzのフラットネス補正配列（10個の補正値）

ユーザ・フラットネス配列の作成

1. 信号発生器を設定します。

a. 信号発生器をプリセットします。

b. ユーザ・フラットネス・テーブル・エディタをオープンし、校正配列をプリセットします：

Amptd > More > User Flatness > Configure Cal Array > More > Preset List > Confirm Presetを押します。

c. Step Arrayメニューで、必要なフラットネス補正済み周波数を入力します： 

d. ユーザ・フラットネス補正配列に前のステップで設定したステップ配列を設定します： 

Return > Load Cal Array From Step Array > Confirm Load From Step Dataを押します。

e. 出力振幅を0 dBmに設定します。

f. RF出力をオンにします。

2. パワー・メータをRF出力に接続して、補正値を手動で入力します：

a. ユーザ・フラットネス・テーブル・エディタをオープンし、行1の周波数値を強調表示します： 
More > User Flatness > Configure Cal Arrayを押します。

RF出力がカーソルが置かれているテーブル行の周波数値に変わります。 

b. パワー・メータの測定値に注目してください。

c. 0 dBmから測定値を減算します。

d. 行1の補正値を強調表示します。

e. Select > the difference calculated in step c > Enterを押します。

入力した補正値に基づいて出力振幅が調整されます。

f. パワー・メータの表示値が0 dBmになるまで、ステップeの値を調整します。

g. 次の行の周波数値を強調表示します。 

h. この行以降の行に対して、ステップb～gを繰り返します。

ユーザ・フラットネス補正配列のタイトルにはUser Flatness:と名前なしで表示されます。これは、ユーザ・フラッ

トネス補正配列のデータがファイル・カタログに保存されていないことを示します。

以下を押します。 Configure Step Array > 

Freq Start > 500 > MHz >

Freq Stop > 1 > GHz >

# of Points > 10 > Enter
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 45



性能の最適化
ユーザ・フラットネス補正の使用法
オプション：ユーザ・フラットネス補正データの保存

1. Load/Store > Store to Fileを押します。

2. ファイル名（この例の場合、FLATCAL1）を入力し、Enterを押します。

ユーザ・フラットネス補正配列ファイルがUFLTファイルとしてファイル・カタログに保存されます。カタログに保存

されているユーザ・フラットネス補正ファイルはすべて、リコールし、補正配列にロードし、RF出力に適用すること

で、特定のRF出力フラットネス要件を満たすことができます。

3. Returnを押します。

RF出力でのフラットネス補正

• Return > Flatness Off Onを押します。

UFインジケータがディスプレイのAMPLITUDEエリアに表示され、配列の補正データがRFに適用されます。

ユーザ・フラットネス補正配列のリコールおよび適用

次の例は、ユーザ・フラットネス補正配列が作成／保存されていることを前提条件とします。作成／保存していない場合

は、45ページの「例：500 MHz～1 GHzのフラットネス補正配列（10個の補正値）」を実行してください。

1. 信号発生器をプリセットします。

2. 必要なユーザ・フラットネス補正ファイルをリコールします：

a. AMPTD > More > User Flatness > Configure Cal Array > More > Preset List > Confirm Presetを押します。

b. More > Load/Storeを押します。

c. 目的のファイルを強調表示します。

d. ユーザ・フラットネス補正配列に選択したファイルに含まれているデータを設定します： 
Load From Selected File > Confirm Load From Fileを押します。

ユーザ・フラットネス補正配列のタイトルにはUser Flatness:ファイル名と表示されます。

3. 配列内の補正データをRF出力に適用します：Return > Flatness Off Onを押します。
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性能の最適化
レベリングなし動作モードの使用法
レベリングなし動作モードの使用法

図4-2　Power SearchソフトキーとALC Offソフトキー

ALCオフ・モード

ALCをオフにすると、信号発生器の自動レベリング回路がオフになるので、テスト・セットアップの特定のポイントで出

力を測定し、そのポイントの必要パワー・レベルに合わせて調整することができます。ALCのパルス幅仕様を下回る超高

速パルスで構成される変調や、自動レベリングによって除去される低速振幅変動で構成される変調の場合は、ALCをオフ

にすると便利です。

1. 信号発生器をプリセットします。

2. 目的の周波数を設定します。

3. 目的の振幅を設定します。

4. パワー・メータを特定のパワー・レベルを必要とするポイントに接続します。

5. RF出力をオンにします。

6. 信号発生器の自動レベリング制御をオフにします：AMPTD > ALC Off Onを押して、Offを強調表示します。

7. パワー・メータの測定値が目的のレベルになるまで、信号発生器の振幅を調整します。

唯一使用可能な場合
ALC ＝ Off

唯一使用可能な場合
Power Search ＝ Span

唯一使用可能な場合
Power Search ＝ Span、
および 
Span Type ＝ User

Auto：出力周波数または振幅が変化すると必ず校正

ルーチンが実行されます。

Span：Do Power Searchを押すと、選択された周波

数レンジにわたってパワー・サーチ校正ルーチンが
一度実行されます。

補正データが記録され、信号発生器を校正済み周波
数レンジ内に収まるようにチューニングする時に常
に用いられます。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 47



性能の最適化
レベリングなし動作モードの使用法
パワー・サーチ・モード

47ページの図4-2を参照してください。パワー・サーチは、ALCを一時的にオンにし、現在のRF出力のパワーを校正し、

ALC回路を切断するルーチンを実行します。 

注記 パワー・サーチ・ルーチンを実行するには、RFがオン、ALCがオフになっていなければなりません。

例：自動パワー・サーチ

1. 信号発生器をプリセットします。

2. 目的の周波数を設定します。

3. 目的の振幅を設定します。

4. RF出力をオンにします。

5. 信号発生器の自動レベリング制御をオフにします： 

AMPTD > ALC Off Onを押して、Offを強調表示します。

信号発生器の自動レベリング制御をオフにすることは機器の重大な変更で、パワー・サーチが自動的に開始されます。

Autoに設定した場合、測定器の設定に重大な変更があると、パワー・サーチが自動的に実行されます。Do Power Search
機能を使用すれば、パワー・サーチを実行して、温度ドリフトや外部入力の変化などの他の変化を補正することができます。
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性能の最適化
出力オフセット、基準、逓倍器の使用法
出力オフセット、基準、逓倍器の使用法

出力オフセットの設定

出力オフセットを使用すれば、入力値からのオフセット（正または負）周波数／振幅を出力できます。

RF出力＝入力値 – オフセット値

表示値＝出力周波数＋オフセット値

オフセットを設定する手順：

• 周波数：Freq > Freq Offset > オフセット値 > 周波数単位を押します。

• 振幅：Amptd > More > Amptd Offset > オフセット値 > dBを押します。

例

信号発生器を局部発振器 (LO) として使用している場合は、オフセットを使って目的の周波数を表示することができます

（下の図を参照）。

パラメータ
例
#1

例
#2

例
#3 コメント

入力（表示）値： 300 MHz 300 MHz 2 GHz 入力値は正の値でなければなりません。

オフセット： 50 MHz −50 MHz −1 GHz オフセット値は正／負どちらの値も設定できます。

出力周波数： 250 MHz 350 MHz 3 GH 出力周波数／振幅がレンジ外の場合、警告が出されます。

オフセットがオンであることを示します

IF増幅器RF増幅器 ミキサ フィルタ

信号発生器
（局部発振器）

出力周波数＝ 1000 MHz

IF ＝ 321 MHz

アンテナ 1321 MHz にチューニング

選択オフセット

321 MHz
–679 MHz

信号発生器の表示

1321 MHz（アンテナ周波数）

321  MHz（IF出力）

IF 出力
321 MHz
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性能の最適化
出力オフセット、基準、逓倍器の使用法
出力基準の設定

出力基準を使用すれば、選択した基準値から入力値分だけオフセットした（正または負）周波数／振幅を出力できます。 

RF出力＝基準値＋入力値

基準を設定する手順：

1. 周波数または振幅を出力基準レベルにしたい値に設定します。

2. Frequency: Frequency > Freq Ref Set を押します。

周波数は0.00 Hzと表示されます。これがRF出力周波数の「ゼロ・レベル」であることを示しています。

入力した周波数はすべて、この基準周波数を基準にしているものと解釈されます。

Amplitude: Amptd > More > Amptd Ref Setを押します。

振幅は0.00 dBと表示されます。これがRF出力振幅の「ゼロ・レベル」であることを示しています。

入力した振幅はすべて、この基準振幅を基準にしているものと解釈されます。

例

新しい周波数／振幅基準を設定するには、周波数基準をオフにし、上の手順を実行します。

パラメータ
例
#1

例
#2

例
#3 コメント

基準： 50 MHz 50 MHz 2 GHz 基準値は正の値でなければなりません。

入力（表示）値： 2 MHz −2 MHz −1 GHz 入力値は正／負どちらの値も設定できます。

出力周波数： 52 MHz 48 MHz 1 GHz 出力周波数／振幅がレンジ外の場合、警告が出されます。

基準がオンであることを示します
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性能の最適化
出力オフセット、基準、逓倍器の使用法
周波数逓倍器の設定

出力逓倍器を使用すれば、出力値の倍数（正または負）の周波数を表示できます。 

表示値＝乗数 × 出力周波数

出力周波数＝表示値 ÷ 乗数

周波数逓倍器を設定する手順：

1. Frequency > Freq Multiplier > 乗数 > xを押します。

2. 目的の周波数を設定します。

出力周波数に乗数を掛けた値が表示されます。

例

信号発生器をシステムへの入力として使用している場合は、下の図のように逓倍器を使用して、信号発生器にシステムの

出力が表示されるように周波数逓倍器を設定することができます。

パラメータ
例
#1

例
#2

例
#3 コメント

周波数逓倍器： 3 −3 4 乗数は正／負どちらの値も設定できます。

入力（表示）値： 600 MHz −600 MHz 8 GHz

出力周波数： 200 MHz 200 MHz 2 GHz 出力周波数がレンジ外の場合、警告が出されます。

周波数逓倍器がオンであることを示します

信号発生器 逓倍器

出力＝ 4 GHzX2入力＝ 2 GHz 選択
逓倍器

2

信号発生器
出力

2 GHz

入力／表示
周波数

4 GHz
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性能の最適化
出力オフセット、基準、逓倍器の使用法
ミキサを測定する場合は、周波数逓倍器と周波数オフセットが併用されることがよくあります。下のアップコンバータの

例では、fRFが表示されるように、逓倍器が−1、オフセットが3 GHzにそれぞれ設定されています。

ミキサ

信号発生器
（局部発振器）

fLO ＝ 800 - 600 MHz

fIF ＝ 3000 MHz

選択
逓倍器

–1

–1

信号発生器
出力 (fLO)

800 MHz

600 MHz

fRF ＝ 2200 - 2400 MHz

選択
オフセット

3000 MHz

3000 MHz

入力／表示
周波数 (fRF)

2200 MHz

2400 MHz
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5 アナログ変調の使用法（オプションUNTのみ）

ここに記載の内容を理解するには、信号発生器の基本動作についての知識が必要です。パワー・レベル／周波数の設定な

どの機能を簡単に操作できない場合、第3章「基本操作」（23ページ） を参照して、内容をよく理解しておいてください。

• 「基本的な手順」 54ページ

• 「外部変調源の使用法」 55ページ

• 「DCオフセットの除去」 55ページ

図5-1　アナログ変調用ソフトキー

55ページを

参照
55ページを

参照

55ページ

を参照

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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アナログ変調の使用法（オプションUNTのみ）
基本的な手順
基本的な手順
1. 信号発生器をプリセットします。

2. 搬送波 (RF) 周波数を設定します。

3. RF振幅を設定します。

4. 変調を設定します：

5. 変調をオンにします：

対応する変調インジケータが表示され、変調がオンになったことが示されます。

6. RF出力をオンにします。

RF出力LEDが点灯し、RF Outputコネクタから信号が送られていることが示されます。

変調が正常に行われていないようであれば、143ページの「RF出力に変調がない」を参照してください。

34ページの「搬送波信号の変調」 も参照してください。

AM FM  ΦM

a. AMを押す

b. AMタイプ（リニアまたは指数関数）を設定する： 
AM Typeで目的のタイプを強調表示する

c. 変調度を設定する： 
AM Depth > 値 > %

d. 周波数を設定する： 
AM Rate > 値 > 周波数単位

a. FM/ΦMを押す

b. 偏移を設定する： 
FM Dev > 値 > 周波数単位

c. 周波数を設定する： 
FM Rate > 値 > 周波数単位

a. FM/ΦM > FM ΦMを押す

b. BW（ノーマルまたはハイ）を設定する：

FM ΦMで目的のタイプを強調表示する

c. 偏移を設定する： 
ΦM Dev > 値 > pi rad

d. 周波数を設定する： 
ΦM Rate > 値 > 周波数単位

AM FM  ΦM

AM Off OnソフトキーをOn FM Off OnソフトキーをOn  ΦM Off OnソフトキーをOn
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アナログ変調の使用法（オプションUNTのみ）
外部変調源の使用法
外部変調源の使用法

DCオフセットの除去

外部から印加されたFMまたはΦM信号のオフセットを除去するには、DCFMまたはDCΦM校正を実行します。

注記 この校正は内部で作成された信号に対して実行することはできますが、DCオフセットは通常は内部作成信号の

特性ではありません。

1. 目的の変調を設定し、オンにします。

2. FM/ΦM > More > DCFM/DCΦM Calを押します。

DC信号を印加して校正を行うことにより、DC信号による偏移がすべて除去され、適用されたDCレベルが新しいゼロ基準

ポイントになります。DC信号を切断する場合は、校正を再度実行して、搬送波を適切なゼロ基準にリセットします。

AM 入力

リア・パネルの入力については
9ページを参照

FM または ΦM 入力

デフォルト

外部変調を使用する場合に選択

現在選択されている変調。
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アナログ変調の使用法（オプションUNTのみ）
外部変調源の使用法
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6 パルス変調の使用法（オプションUNU）

ここに記載の内容を理解するには、信号発生器の基本動作についての知識が必要です。パワー・レベル／周波数の設定な

どの機能を簡単に操作できない場合、第3章「基本操作」（23ページ） を参照して、内容をよく理解しておいてください。

• 「パルス特性」 59ページ

• 「基本的な手順」 61ページ

• 「例」 61ページ
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パルス変調の使用法（オプションUNU）
図6-1　パルス用ソフトキー

61ページを

参照

61ページを

参照

外部パルス入力からパル
ス同期出力までのレイテ
ンシ ≈ 50 − 60 ns。
幅 周期
50 ns > 50 ns
20 ns ≤ 50 ns

各キーの詳細については、23ページを参照。

外部パルス信号に対する信号発生器
の応答を決定します。
Normal＝ハイ・ステート。

Invert＝ロー・ステート。

Low＝安定

TTL信号

9ページおよび

10ページも参照

各出力コネクタにルーティング
したい信号を選択します。
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パルス変調の使用法（オプションUNU）
パルス特性
パルス特性

注記 信号器のALCパルス幅仕様を下回る超高速パルスまたはデューティ・サイクルが異常に長いレベリング・パルス

を使用する場合は、通常はALCをオフにすると便利です（47ページを参照）。

パルス源 タイプ 周期a

aすべての遅延、幅、周期の分解能が10 nsです。

幅および遅延a トリガ・イベントの使用b

bリア・パネルのパルス・コネクタの信号は、最低20 ns間はハイを維持して、内部発生パルスをトリガする必要があります。

方形
内部フリーラン・パルス列

（50 %のデューティ・サイクル）。
ユーザ定義のレー
トによって決まる。

 

フリーラン
（デフォルト）

内部フリーラン・パルス列 ユーザ定義 ユーザ定義 

トリガ 内部パルス列  ユーザ定義 ✓

調整可能な
ダブレット

トリガ・イベントごとに2つの

内部パルス列。


ユーザ定義：

最初のパルスはトリガ信号の立ち
上がりエッジを基準とします。

2番目のパルスは最初のパルスの

立ち上がりエッジを基準とします。

60ページの図6-2を参照

✓

トリガ
ダブレット

トリガ・イベントごとに2つの

内部パルス列。


最初のパルスはトリガ信号に従い
ます。

2番目のパルスはユーザ定義です。

60ページの図6-3を参照

✓

ゲーティッド 内部ゲーティッド・パルス列  ユーザ定義 ✓

外部
リア・パネルのPulseコネクタの

外部パルス信号
  

外部パルス入力

リア・パネルの入力については9ページを参照
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パルス変調の使用法（オプションUNU）
パルス特性
図6-2　調整可能なダブレット

図6-3　トリガ・ダブレット

最初のパルスの遅延は、外部トリガ信号の
立ち上がりから測定されます。

遅延 幅

RF出力

外部トリガ

2番目のパルスの遅延は、最初のパルスの

立ち上がりから測定されます。

遅延 幅

2番目のパルスの遅延は、外部トリガ信号の

立ち上がりから測定されます。

遅延 幅

RF出力

外部トリガ

最初のパルスは外部トリガ
信号に従います。
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パルス変調の使用法（オプションUNU）
基本的な手順
基本的な手順
1. 信号発生器をプリセットします。

2. 搬送波 (RF) 周波数を設定します。

3. RF振幅を設定します。

4. 変調を設定します：

a. パルス源を設定します：Pulse > Pulse Source > 選択を押します。

b. 選択したパルス源のパラメータを設定します：

5. 変調をオンにします：Pulse Off OnソフトキーをOn。

PULSEインジケータが表示され、変調がオンになったことが示されます。

6. 信号発生器から変調信号を出力します：RF On Offキーを押します。

RF出力LEDが点灯し、RF Outputコネクタから信号が送られていることが示されます。

34ページの「搬送波信号の変調」 も参照してください。

例

以下の例では、出荷時設定のパルス源と遅延を使用します。

1. 信号発生器をプリセットします。

2. 周波数を2 GHzに設定します。

3. 振幅を0 dBmに設定します。

4. パルス周期を100 μsに設定します：Pulse > Pulse Period > 100 > usecを押します。

5. パルス幅を24 μsに設定します：Pulse > Pulse Width > 24 > usecを押します。

6. パルス変調とRF出力をオンにします。 

PULSEインジケータが表示され、RF出力LEDが点灯します。

変調が正常に行われていないようであれば、143ページの「RF出力に変調がない」を参照してください。 

方形 フリーラン（デフォルト） トリガ 調整可能な ダブレット トリガ・ ダブレット ゲーティッド 外部

パルス・
レート

     

 パルス周期    パルス周期 

 パルス遅延 パルス遅延 パルス遅延 パルス遅延  

 パルス幅 パルス幅 パルス幅 パルス幅 パルス幅 

   パルス2遅延   

   パルス2幅   

出力： 100 µs周期の24 µsパルスによって変調された2 GHz、0 dBmの搬送波。
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パルス変調の使用法（オプションUNU）
基本的な手順
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7 基本デジタル動作－BBGオプションをインストール

しない場合

ここに記載の内容を理解するには、信号発生器の基本動作についての知識が必要です。パワーレベルや周波数の設定など

の機能に慣れていない場合、第3章「基本操作」（23ページ） を参照して、内容をよく理解しておいてください。

関連項目: 「デュアルARB波形へのリアルタイム・ノイズの追加」130ページ
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基本デジタル動作－BBGオプションをインストールしない場合
I/Q変調
I/Q変調

エラー・ベクトル・マグニチュードには以下のファクタが関係します。

• IチャネルとQチャネル間の振幅差、位相差、遅延差

• DCオフセット

I/Qメニューに、I信号とQ信号の差の一部を補正したり、雑音を追加したりするための調整機能があります。

34ページの「搬送波信号の変調」も参照してください。

図7-1　I/Q表示とソフトキー

以下の表に、調整の一般的な用途を示します。

表2　I/Q調整の用途

I/Q調整 有効 劣化

オフセット 搬送波フィードスルー DCオフセット

直交角度

EVM誤差 位相スキュー

I/Qイメージ I/Q経路遅延

このパネルに、外部I/Q信号の

ルーティングが表示されます。

このパネルに、I/Q調整の現在のステータスと設定が

表示されます。グレーの場合、I/Q調整はオフになっ

ています。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください

I信号の位相を基準にしてQ信号の位相をオフセットします。

直交位相調整キーは、度の単位で校正されます。この調整は
校正されていません。 

DCオフセットを

設定します
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基本デジタル動作－BBGオプションをインストールしない場合
I/Q変調
フロント・パネルの入力を設定する

Agilent MXGは、フロント・パネルのI InputとQ Inputで外部供給のアナログI信号とアナログQ信号を受信し、それらの信

号で搬送波を変調します。

1. I信号とQ信号をフロント・パネルのコネクタに接続します。

a. アナログI信号を信号発生器のフロント・パネルのI Inputに接続します。

b. アナログQ信号を信号発生器のフロント・パネルのQ Inputに接続します。

2. I/Q変調器をオンにします。I/Q Off Onを押してOnにします。

3. RF出力を設定します。

a. 搬送波周波数を設定します。

b. 搬送波振幅を設定します。

c. RF出力をオンにします。

4. 必要に応じてI/Q信号を調整します（64ページ）。
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基本デジタル動作－BBGオプションをインストールしない場合
I/Q変調
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8 基本デジタル動作（オプション651/652/654）

ここに記載の内容を理解するには、信号発生器の基本動作についての知識が必要です。パワーレベルや周波数の設定など

の機能に慣れていない場合、第3章「基本操作」（23ページ） を参照して、内容をよく理解しておいてください。

本章で説明する機能は、オプション651、652、または654を備えたベクトル信号発生器でのみ使用することができます。

• 「波形ファイルの基本」 68ページ

• 「波形セグメントのストア、ロード、再生」 70ページ

• 「ベースバンド周波数オフセットの設定」 72ページ

• 「波形シーケンス」 74ページ

• 「波形の設定とパラメータの保存」 78ページ

• 「波形マーカの使用」 82ページ

• 「波形のトリガ」 98ページ

• 「波形のクリッピング」 105ページ

• 「波形のスケーリング」 114ページ

• 「I/Q変調」 121ページ

関連項目: 「デュアルARB波形へのリアルタイム・ノイズの追加」130ページ
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基本デジタル動作（オプション651/652/654）
波形ファイルの基本
波形ファイルの基本

2種類の波形ファイルがあります。 

• セグメントは、信号発生器にダウンロードする波形ファイルです。

波形ファイルの作成方法とダウンロード方法については、『Programming Guide』を参照してください。 

• シーケンスは、信号発生器でユーザが作成するファイルで、1つ以上の波形ファイル（セグメント、別のシーケンス、

または両方）へのポインタを含んでいます。

シーケンスの作成方法については、74ページを参照してください。

信号発生器のメモリ

信号発生器には2種類のメモリがあります。

• 揮発性メモリ。ベースバンド・ジェネレータ（BBG）媒体で、ここの波形ファイルを使って再生や編集を行います。

• 不揮発性メモリ。内部（int）または外部（USB）媒体で、ここに波形ファイルをストアします。

デュアルARBプレーヤ

デュアルARB波形プレーヤを使用すると、波形ファイルの再生、リネーム、削除、ストア、ロードと、波形シーケンスの

作成が可能です。デュアルARB波形プレーヤには、マーカ（82ページ）機能、トリガ（98ページ）機能、クリッピング

（105ページ）機能、スケーリング（114ページ）機能もあります。

このセクションのほとんどの手順は、以下に示すDual ARBメニューからスタートします。 
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基本デジタル動作（オプション651/652/654）
波形ファイルの基本
図8-1　Dual ARBのソフトキー

130ページ

105
ページ

114
ページ

105
ページ

70ページ

デュアルARBがオフのときにARBサンプル・クロッ

クを設定した場合、新しい設定はデュアルARBプ

レーヤをオンにしたときに適用されます。この設定
は、デュアルARBプレーヤのオフとオンを切り替え

ても有効のままです。

82ページ

78ページ

98ページ

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください

注記：これは、
3つのArbメニュー

の最初です。

注記：これは、3つのArb
メニューの2番目

です。

注記：これは、3つのArb
メニューの3番目

です。

74ページ

72ページ

114ページ
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基本デジタル動作（オプション651/652/654）
波形セグメントのストア、ロード、再生
波形セグメントのストア、ロード、再生

35ページの「データの表示、保存、リコール」も参照してください。

図8-2　波形セグメントのソフトキー

波形セグメントを不揮発性メモリ（内部または外部媒体）にストア／リネームする

BBGメモリ内のファイルのコピーを現在選択している媒体（41ページ）にストアするには、以下の手順を使用します。波

形セグメントをダウンロードしていない場合、『Programming Guide』を参照するか、工場供給セグメントを使用してく

ださい。 

1. Mode > Dual ARB > Select Waveform > Waveform Segmentsを押します。

2. Segment On BBG Media列で、任意の波形セグメントを強調表示します。

3. Load Storeを押してStoreを強調表示します。

4. ストアする波形セグメントを強調表示します。

5. 任意でセグメントをリネームします。

現在選択している媒体にこのセグメントのコピーがすでに存在し、それを上書きしたくない場合、ストアする前に波

形セグメントをリネームします。

a. More > Rename Segment > Clear Textを押します。

b. 波形セグメントの名前を入力します。

c. Enter > Moreを押します。

d. リネームされた波形セグメントを強調表示します。

6. Store Segment to（現在選択している）Mediaを押します。

82ページ

を参照

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください

注記：シーケンスを強調表示すると、このキーの
名前がShow Waveform Sequence Contentsに
変わります。

矢印キーまたはノブを使用して
文字やキャラクタを強調表示し
ます
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基本デジタル動作（オプション651/652/654）
波形セグメントのストア、ロード、再生
7. ストアするすべてのセグメントに対してステップ4からステップ6を繰り返します。

BBG媒体のすべてのセグメントを現在選択している媒体に保存するには、Store All to（現在選択している）Mediaを押

します。

波形セグメントをBBG媒体（揮発性メモリ）にロードする

波形セグメントを再生したり、編集したり、シーケンスに含めたりするには、波形セグメントがBBG媒体に存在している

必要があります。信号発生器の電源を入れ直したり、信号発生器をリブートしたりすると、BBG媒体のファイルが削除さ

れます。

注記 信号発生器の電源を入れるたびに、2つの工場供給セグメントRAMP_TEST_WFMとSINE_TEST_WFMがBBG媒体に

自動的に作成されます。

1. Mode > Dual ARB > Select Waveform > Waveform Segmentsを押します。

2. Load Storeを押してLoadを強調表示します。

3. ロードする波形セグメントを強調表示します。

4. 現在選択している媒体にこのセグメントのコピーがすでに存在し、それを上書きしたくない場合、ロードする前に波

形セグメントをリネームします（前の手順を参照してください）。

5. Load Segment From（現在選択している）Mediaを押します。

現在選択している媒体からBBG媒体にすべてのファイルをロードするには、Load All From（現在選択している）Media
を押します。 

波形セグメントを再生する

1. Mode > Dual ARB > Select Waveformを押します。

2. Segment on BBG Media列で、再生する波形セグメントを強調表示します。

3. Select Waveform > ARB Off Onを押してOnにします。

これにより選択した波形セグメントが再生されます。波形セグメントの生成中、I/QインジケータとARBインジケータ

がオンになり、波形がRF搬送波を変調します。 

4. RF出力を設定します。 

a. RF搬送波周波数を設定します。

b. RF出力振幅を設定します。

c. RF出力をオンにします。

波形セグメントが信号発生器のRF OUTPUTコネクタで使用可能になります。 

現在の波形選択

アクティブ波形（ARB On）と一緒にインジケータが表示されます
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基本デジタル動作（オプション651/652/654）
ベースバンド周波数オフセットの設定
ベースバンド周波数オフセットの設定

図8-3　Baseband Frequency Offsetソフトキー

ベースバンド周波数オフセットにより、信号発生器のベースバンド・ジェネレータ・オプションに応じて、BBG 100 MHz
信号帯域幅内で±50 MHzまでベースバンド周波数をシフトすることができます。オフセット機能の一般的な用途には、以

下が含まれます。

• LOフィードスルーから搬送波をオフセットする（搬送波周波数における搬送波信号スプリアス）

• ベースバンド信号と外部I入力およびQ入力を合計してマルチキャリア信号を作成する

• 信号発生器のI/Q信号をIFとして使用する

注記 ベースバンド周波数オフセットを変更すると、DACオーバレンジ状態が発生し、エラー 628, Baseband 
Generator DAC over range（ベースバンド・ジェネレータDACオーバレンジ）が生成される場合があります。

これが発生すると、波形ランタイム・スケーリング値（114ページ）が減少します。

ベースバンド周波数オフセット値は、ファイル・ヘッダのパラメータ（78ページ）の1つです。すなわち、この値を波形

と一緒にストアできます。ストアされた周波数オフセット値と一緒に波形を選択すると、信号発生器がストアされている

ファイル・ヘッダ値に合わせて現在の値を変更します。現在の波形にストアされているベースバンド・オフセット周波数

値がない場合、信号発生器は最後に設定された周波数オフセット値を使用します。 

Save機能（35ページ）を使用して、この値を信号発生器のセットアップの一部としてストアすることもできます。Save機
能を使ってストアされたセットアップをRecall機能でリコールするときには、ベースバンド周波数オフセット値が現在の

信号発生器の設定値になり、ストアされているファイル・ヘッダ値は無視されます。

130ページを参照

114ページを参照

周波数オフセット設定

このメニューの設定をファイル・
ヘッダにストアすることができます。
78ページを参照してください。

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください
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基本デジタル動作（オプション651/652/654）
ベースバンド周波数オフセットの設定
搬送波をLO／搬送波フィードスルーからオフセットするには、以下の手順を使用します。この例では、工場供給波形

SINE_TEST_WFMを使用します。この例の出力を表示するには、信号発生器のRF OUTPUTをスペクトラム・アナライザの

入力に接続します。

1. 波形を選択して再生します。

a. Mode > Dual ARB > Select Waveformを押します。

b. Segment On BBG Media列で、SINE_TEST_WFMを選択します。

c. Select Waveformを押します。

2. 波形を生成します。ARB Off Onを押してOnにします。

3. 搬送波信号を設定します。

a. 搬送波信号を1 GHzに設定します。

b. 振幅を0 dBmに設定します。

c. RF OUTPUTをオンにします。

4. ARB Setup > Baseband Frequency Offset > 20 MHzを押します。

以下の図に示すように、変調RF信号が、搬送波周波数から20 MHzだけオフセットされています。

ベースバンド周波数オフセットが
0 Hzの変調搬送波

ベースバンド周波数オフセットが
20 MHzの変調搬送波 変調RF信号

LO／搬送波フィード

100 MHzのスパンに設定されたスペクトラム・アナライザ
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基本デジタル動作（オプション651/652/654）
波形シーケンス
波形シーケンス

図8-4　波形シーケンスのソフトキー

波形シーケンスは、1つまたは複数の波形セグメントまたは他の波形シーケンス、あるいは両方に対するポインタを格納

したファイルです。これにより、信号発生器が複数の波形セグメントまたは他のシーケンス、あるいは両方を再生するこ

とができ、別の波形を選択するためだけに波形の再生を中止する必要がなくなります。

シーケンスをストアするとき、波形シーケンスがポイントするセグメントは自動的にストアされません。個々のセグメン

トもストアする必要があります。そうでないと、信号発生器をオフにするかリブートしたときにセグメントが失われます。

セグメントが内部／外部媒体に存在する場合、波形シーケンスを選択する前にセグメントをBBG媒体にロードする必要が

あります。 セグメントをBBG媒体にロードしていない状態でシーケンスを再生しようとすると、信号発生器がERROR:
629, File format invalid（ファイル・フォーマットが無効）を報告します。これが発生し、セグメントが内部／外部

媒体にストアされていない場合、同じファイル名を使用してシーケンスがポイントするセグメントを再作成すると、シー

ケンスを再生することができます。 

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください

Mode >
Dual ARB >

シーケンス名

シーケンスの内容

95ページを参照

このソフトキーを表示するには、波形シーケンスを強調表示します
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基本デジタル動作（オプション651/652/654）
波形シーケンス
シーケンスを作成する

波形シーケンスは、最大1,024個のセグメントを格納し、セグメントとその他のシーケンス（ネスト構造シーケンス）の両

方を持つことができます。信号発生器を使用すると、再生中にセグメントとネスト構造シーケンスが繰り返す回数を設定

することができます。ただし、セグメントの繰り返しとネスト構造シーケンスの繰り返しには違いがあります。各セグメ

ントは最大65,535回繰り返すことができますが、セグメントは、繰り返し回数に関係なく、単一セグメントとしてカウン

トされます。しかしながら、ネスト構造シーケンスの各繰り返しは、追加セグメントとしてカウントされます。

ネスト構造シーケンスの繰り返し可能回数の最大値は、ネスト構造シーケンス内のセグメント数と、許容セグメント

（1,024）の残りの数によって決まります。例えば、24個のセグメントと、4個のセグメントを持つ1個のネスト構造シーケ

ンスを含むシーケンスを使用する場合、ネスト構造シーケンスの繰り返しは250に制限されます。

24 + (4 × 250) = 1,024、1シーケンス当たりのセグメントの最大数

ネスト構造シーケンスを繰り返すことができる最大回数には制限ファクタがあるものの、ネスト構造シーケンス内の各セ

グメントは最大65,535回繰り返すことができます。

例

2個の異なるセグメントをそれぞれ1回繰り返す波形シーケンスを作成してストアするには、以下の手順を使用します。

前提条件：波形セグメントをBBG媒体（揮発性メモリ）に入れます。波形セグメントのBBG媒体へのロード方法について

は、71ページを参照してください。 

1. 最初のセグメントを選択します。

a. Mode > Dual ARB > More  > More > Waveform Sequences > Build New Waveform Sequence > Insert Waveformを押します。

b. 目的の波形セグメントを強調表示し、Insertを押します。

2. 2番目のセグメントを選択します。

a. 次の目的の波形セグメントを強調表示し、Insertを押します。

b. Done Insertingを押します。

3. 波形シーケンスに名前を付け、Seqファイル・カタログにストアします。

a. More > Name and Storeを押します。

b. ファイル名を入力し、Enterを押します。

76ページの「シーケンスの内容を表示する」と89ページの「波形セグメントにマーカ・ポイントを設定する」も参照して

ください。

波形

シーケンス

シーケンスA

シーケンスB

シーケンスA
を4回繰り返す

セグメント1

セグメント2

セグメント3

2個のセグメント

9個のセグメント

11個のセグメント

8個の

セグメント
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 75



基本デジタル動作（オプション651/652/654）
波形シーケンス
シーケンスの内容を表示する

波形シーケンスの内容を表示する方法は2通りあります。Waveform Sequencesソフトキーを使用する方法とSelect Waveform
ソフトキーを使用する方法です。

Waveform Sequencesソフトキー

1. Mode > Dual ARB > More  > More > Waveform Sequencesを押します。

2. 目的のシーケンスを強調表示します。

3. Show Waveform Sequence Contentsを押します。

Waveform Selectソフトキー

1. Mode > Dual ARB > Select Waveformを押します。

2. Sequence On列で、目的の波形シーケンスを強調表示します。

3. Show Waveform Sequence Contentsを押します。

シーケンスを編集する

波形シーケンスを編集するとき、以下を実行することができます。

• 各セグメントまたはネスト構造シーケンスを再生する回数を変更する

• セグメントまたはネスト構造シーケンスをシーケンスから削除する

• セグメントまたはネスト構造シーケンスをシーケンスに追加する

• マーカのオンとオフを切り替える（95ページで説明）

• 変更を現在の波形シーケンスに保存するか、新しいシーケンスとして保存する。

変更を保存しないでシーケンス編集メニューを終了すると、変更が失われます。

シーケンスはSeqファイル・カタログに保存されます。

注意 シーケンスで使用しているセグメントを編集して再セーブした場合、シーケンスはヘッダのRMS値を自動

的に更新しません。シーケンスのヘッダ情報（78ページ）を選択して更新する必要があります。

2つの異なるセグメントを持つシーケンスを、最初のセグメントを100回繰り返し、2番目のセグメントを200回繰り返すよ

うに編集して、変更を保存するには、以下の手順を使用します。

前提条件：2つの異なるセグメントを持つ波形シーケンスを作成し、ストアします（75ページの前の例を参照してください）。

1. シーケンスを選択します。 
Mode > Dual ARB > More > More > Waveform Sequences > 希望のシーケンスを強調表示する > 
Edit Selected Waveform Sequenceを押します。

2. 100回繰り返すように最初のセグメントを変更します。 
最初のセグメント・エントリを強調表示し、Edit Repetitions > 100 > Enterを押します。

カーソルが次のエントリに移動します。 

3. 選択したエントリの繰り返しを200に変更します。 
Edit Repetitions > 200 > Enterを押します。

4. 前の手順で行った変更を保存します。 
More > Name and Store > Enterを押します。

変更を新しいシーケンスとして保存するには： 
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a. More > Name and Store > Clear Textを押します。

b. ファイル名（例えば、SINE100+RMP200）を入力します。

c. Enterを押します。

編集したシーケンスが新しい波形シーケンスとして保存されます。 

シーケンスを再生する

波形シーケンスを作成していない場合、75ページの「シーケンスを作成する」を参照してください。

注記 波形セグメントを個別に、または波形シーケンスの一部として再生するには、セグメントが BBG 媒体に存在す

る必要があります。71ページの「波形セグメントをBBG媒体（揮発性メモリ）にロードする」も参照してください。

1. 波形シーケンスを選択します。

a. Mode > Dual ARB > Select Waveformを押します。

b. Sequence On列から波形シーケンス（例えば、SINE100+RMP200）を強調表示します。

c. Select Waveformを押します。

表示に現在選択されている波形が示されます（例えば、Selected Waveform: SEQ:SINE100+RMP200）。

2. 波形を生成します。 
ARB Off Onを押してOnにします。 

これにより選択した波形シーケンスが再生されます。波形シーケンスの生成中、I/QインジケータとARBインジケータ

がオンになり、波形がRF搬送波を変調します。 

3. RF出力を設定します。 

a. RF搬送波周波数を設定します。

b. RF出力振幅を設定します。

c. RF出力をオンにします。

波形シーケンスが信号発生器のRF OUTPUTコネクタで使用可能になります。 

現在の波形選択

アクティブ波形（ARB On）と一緒にインジケータが表示されます
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波形の設定とパラメータの保存

ここでは、ファイル・ヘッダの編集方法と保存方法について説明します。波形ファイル（I/Qデータ、信号発生器が波形セ

グメントとして処理）を単にダウンロードするときには、信号発生器がファイル・ヘッダと、波形ファイルと同じ名前を

持つマーカ・ファイルを自動的に生成します。最初はファイル・ヘッダには、信号発生器の設定は保存されていません。

マーカ・ファイルはすべてゼロから成ります。所定の波形に対して、信号発生器の設定とパラメータをファイル・ヘッダ

に、マーカ設定をマーカ・ファイル（82ページ）に保存することができます。ストアされている波形ファイルをBBG媒体

にロードするとき、ファイル・ヘッダとマーカ・ファイルの設定が信号発生器に自動的に適用されるので、波形ファイル

を再生するたびにデュアルARBプレーヤが同じ方法をセットアップします。 

図8-5　ヘッダ・ユーティリティのソフトキー

波形シーケンスを作成したとき（75ページで説明）、信号発生器が波形シーケンス・ヘッダを自動的に作成します。波形

シーケンス・ヘッダは個々の波形セグメント・ヘッダよりも優先されます。波形シーケンスの再生中、必要なオプション

がすべてインストールされているか確認する場合以外、セグメント・ヘッダは無視されます。波形シーケンスをストアす

ると、ファイル・ヘッダもストアされます。 

ファイル・ヘッダに示された現在の信号発生器設定のいくつかは、ソフトキー・ラベルの一部として表示され、その他は

以下の例に示すように、デュアルARBサマリ表示に表示されます。

79ページを

参照

Mode > Dual ARB >
More > More > 
Header Utilities >

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください

ARB サマリ、ファイル・
ヘッダ設定

ソフトキー・ラベル、
ファイル・ヘッダ
設定

ソフトキー・ラベル、
ファイル・ヘッダ
設定

このメニューのすべての設定を
ファイル・ヘッダにストアできます。
78 Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド



基本デジタル動作（オプション651/652/654）
波形の設定とパラメータの保存
ヘッダ情報を表示／変更する 

以下の例では、工場供給波形ファイルRAMP_TEST_WFMを使用します。

1. BBG媒体から、波形RAMP_TEST_WFMを選択します。 

a. Mode > Dual ARB > Select Waveformを押します。

b. Segment On列で、波形RAMP_TEST_WFMを強調表示します。

c. Select Waveformを押します。

2. Header Utilitiesメニューを開きます。

More > More > Header Utilitiesを押します。

図8-6に、工場供給波形RAMP_TEST_WFMのデフォルト・ファイル・ヘッダを示します。Header Field列に、ファイ

ル・ヘッダのパラメータが表示されます。パラメータをすべて見るにはPage Downキーを使用します。

Saved Header Settings列に、設定のほとんどがUnspecifiedであることが示されます。Unspecifiedは、特定パラ

メータに対して保存されている設定がないことを意味します。

Current Inst. Settings列に現在の信号発生器の設定が表示されます。この例では、これらの設定をファイル・

ヘッダに保存します。 

注記 ファイル・ヘッダで設定が未指定の場合、波形を選択して再生すると、信号発生器は設定の現在の値を使用し

ます。

図8-6　サンプル・ファイル・ヘッダ

3. Current Inst. Settings列の情報をファイル・ヘッダに保存します。

Save Setup To Headerを押します。

Saved Header Settings列とCurrent Inst. Settings列に同じ値が表示されています。Saved Header Settings
列にファイル・ヘッダに保存された設定が表示されます。

波形ファイルの名前

説明の長さは最大32文字です。

Mode > Dual ARB > More > More > Header Utilities >

デフォルトのヘッダ設定 現在の信号発生器の設定

保存されているヘッダ設定エント
リをデフォルト設定にリセットし
ます。
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4. 設定を編集し、更新します。

a. ARB Setupメニューに戻ります。 
Return > More > ARB Setupを押します。

このメニューから、ファイル・ヘッダに保存されている信号発生器の設定の一部にアクセスできます。69ページ

の図8-1に、以下の手順で使用するARB Setupのソフトキーを示します。

b. ARBサンプル・クロックを5 MHzに設定します。 
ARB Sample Clock > 5 > MHzを押します。

c. 波形ランタイム・スケーリングを60％に設定します。

Waveform Runtime Scaling > 60 > %を押します。

d. Header Utilitiesメニューに戻ります。 
Return > More > More > Header Utilitiesを押します。

以下の図に示すように、Current Inst. Settings列に現在の信号発生器のセットアップに対する変更が反映さ

れますが、保存されているヘッダ値は変更されていません。

e. 現在の設定をファイル・ヘッダに保存します。 
Save Setup To Headerソフトキーを押します。

Current Inst. Settings列からの設定がSaved Header Settings列に表示されています。これにより、新し

い現在の機器設定がファイル・ヘッダに保存されます。

波形ファイルを選択した後でファイル・ヘッダに表示された信号発生器の設定を変更した場合、変更された設定がヘッダ

のCurrent Inst. Settings列に表示され、保存されているヘッダ設定の代わりに使用されます。保存されているヘッダ

設定を再度適用するには、再生用の波形を選択し直します。

値は、2つの列で

異なります
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波形を選択せずにヘッダを表示／編集する

79ページで説明したように、波形を選択した後、波形のヘッダ情報を表示／編集することができます。波形ヘッダ情報は、

波形を選択しなくても編集できます。現在選択している波形とは別の波形の波形ヘッダ情報を編集することも可能です。

1. ファイル・ヘッダのユーティリティ・メニューにアクセスします。

Mode > Dual ARB > More > More > Header Utilities > More > Select Different Headerを押します。

信号発生器は、最後に選択した媒体に存在する波形ファイルのアルファベット順のリストを表示します。以下の図に、

BBG媒体内の工場供給波形の例を示します。 

2. 目的のカタログが表示されていない場合、カタログを選択します。 

3. 目的の波形ファイルを強調表示し、Select Headerを押します。

信号発生器が、選択した波形ファイルのファイル・ヘッダを表示します。 

4. ヘッダを編集するには、Moreを押し、80ページのステップ4（「ヘッダ情報を表示／変更する」セクション）の説明に

従って手順を進めます。

アクティブ波形カタログ

内部または外部媒体にストア
された波形シーケンス

BBG媒体にストアされた

波形セグメント

アクティブ媒体

タイプ:
WFM1 = 揮発性セグメント

NVWFM = 不揮発性セグメント

SEQ = シーケンス
アクティブ・カタログ

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください

内部または外部媒体にストア
された波形セグメント
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波形マーカの使用

信号発生器には、波形セグメントの特定のポイントをマーキングするため4個の波形マーカがあります。信号発生器がオ

ンのマーカに遭遇すると、補助信号が、マーカ番号に対応するリア・パネル・イベント出力にルーティングされます。

• イベント1は、EVENT 1 BNCコネクタ（12ページを参照）とAUXILIARY I/Oコネクタのピン（13ページを参照）の両

方で入手可能です。

• イベント2～4は、AUXILIARY I/Oコネクタのピン（13ページを参照）で入手可能です。

補助出力信号は、もう1つの測定器と波形を同期するため、または波形の所定ポイントで測定を開始するためのトリガ信

号として使用することができます。

ALCホールドまたはRFブランキング（ALCホールドを含みます）を開始するためにマーカを設定することもできます。詳

細については、82ページの「波形マーカの使用」を参照してください。

関連するマーカ・ファイルがない波形ファイルをダウンロードするとき、信号発生器はマーカ・ポイントのないマーカ・

ファイルを作成します。工場供給セグメントは、4個すべてのマーカが最初のサンプルにマーカ・ポイントを持っています。

以下の手順では、デュアルARBプレーヤでの作業中のマーカの使用方法を示します。 これらの手順でも、マーカ・ポイン

トとサンプル・ポイントの2種類のポイントについて説明します。マーカ・ポイントは、所定マーカが波形に設定されて

いるポイントです。各マーカに対して1つ以上のマーカ・ポイントを設定することができます。サンプル・ポイントは、波

形を構成する多数のポイントの1つです。

波形マーカの使用には、3つの基本的な手順があります。

「マーカ・ポイントを波形セグメントからクリアする」88ページ

「波形セグメントにマーカ・ポイントを設定する」89ページ

「波形シーケンスのマーカを制御する」95ページ

ここでは、以下の情報についても説明します。

• 「波形マーカの概念」83ページ

• 「マーカ・ユーティリティにアクセスする」87ページ

• 「波形セグメントのマーカを表示する」88ページ

• 「マーカ・パルスを表示する」92ページ

• 「RFブランキング・マーカ機能を使用する」93ページ

• 「マーカ極性を設定する」94ページ
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波形マーカの概念

信号発生器のデュアルARBには、波形セグメントの特定のポイントをマーキングするため4個の波形マーカがあります。各

マーカの極性とマーカ・ポイントを（単一サンプル・ポイントまたはある範囲のサンプル・ポイントに）設定することが

できます。各マーカは、ALCホールド、またはRFブランキングとALCホールドを実行することもできます。

マーカ信号レスポンス

信号発生器は、マーカ信号をベースバンド・ジェネレータでI信号とQ信号に整列します。しかし、振幅などの設定、フィ

ルタ、RF出力経路内のその他のものにより、マーカEVENT出力信号と変調RF出力間に遅延が生じる可能性があります。

マーカEVENT出力信号を使用するとき、信号（変調RFを基準にしたマーカ）のレイテンシを観察し、必要に応じてマー

カ・ポイントの位置、インクルード遅延（125ページ）、または両方をリセットします。

マーカ・ファイル生成

付随するマーカ・ファイルがない波形ファイルをダウンロードすると（『Programming Guide』で説明）、信号発生器が

マーカ・ファイルを自動的に作成しますが、マーカ・ポイントは配置しません。

マーカ・ポイントの編集要件

波形セグメントのマーカ・ポイントを変更するには、セグメントがBBG媒体に存在する必要があります（71ページの「波

形セグメントをBBG媒体（揮発性メモリ）にロードする」を参照）。

マーカの極性設定とルーティング設定を保存する

マーカの極性設定とルーティング設定は、再設定するか、信号発生器をプリセットするか、電源を入れ直すまでそのまま

です。再生するときに波形が確実に正しい設定を使用するようにするには、マーカの極性またはルーティング（RF
BlankingとALC Hold）を設定し、情報をファイル・ヘッダ（78ページ）に保存します。 

注記 マーカ・ルーティングと極性設定がファイル・ヘッダにストアされていない波形を使用する場合、前に再生した

波形がRF Blankingを使用していたときには、RF BlankingをNoneに設定してください。Noneに設定しないと、

RF出力がないか、波形が歪む可能性があります。

マーカ
ファイ

ル

マーカ
極性

Marker N 
RF Blank Off On

Marker N
マーカがローの

ときRFを
ブランキング

EVENT N

負

正

Set Marker
On Off

Marker N 
ALC Hold Off On

Marker N
マーカがローの
ときALCを保持

信号発生器がオンのマーカ（95ページで説明）に遭遇すると、補助出力信号が生成さ

れ、リア・パネルにルーティングされます。 

イベント1は、EVENT 1 BNCコネクタ（12ページを参照）とAUXILIARY I/Oコネクタの

ピン（13ページを参照）で入手可能です。

イベント2～4は、AUXILIARY I/Oコネクタのピン（13ページを参照）で入手可能です。

RF Blank Only:ALC Hold を含みます
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ALC Holdマーカ機能

マーカ機能（ソフトキー・ラベルのMarker Routingとして説明）は、マーカ・ポイント（89ページ）の設定前でも設定後で

も設定できますが、マーカ・ポイントを設定する前にマーカ機能を設定すると、RF出力でパワー・スパイクまたはパワー

の損失が発生します。

アイドル周期、バースト・ランプを含む波形信号があるとき、または拡大したダイナミック・レンジがRFブランキング

（93ページ）に遭遇することを希望しないとき、ALCホールド機能を単独で使用します。 

ALCホールド・マーカ機能は、マーカによって設定されたサンプル・ポイントの平均値でALC回路を保持します。正と負

のどちらのマーカ極性の場合も、ALCは、マーカ信号がハイに移行するときにRF出力信号（搬送波＋変調信号）をサンプ

リングします。

注記 波形の出力振幅に影響する可能性があるので、ALCホールドを100 msを超えて使用しないでください。より長

い時間間隔については、48ページの「パワー・サーチ・モード」を参照してください。

注意 ALC の不適切なサンプリングによって突然のレべリングなし状態が生じ、RF 出力にスパイクが発生して、

DUTまたは接続されている測定器が損傷を受ける場合があります。この状態を防止するため、マーカを設

定して、ALCが信号内で遭遇する高いパワー・レベルを占める振幅でサンプリングを行うようにします。

正： 信号は、オンのマーカ・ポイント中にサンプリングされます。

負 信号は、オフのマーカ・ポイント中にサンプリングされます。

正の極性

RF出力に対してマーカ応答を

明らかにするためマーカを設定

RF出力

最大ALCホールド時間

マーカ
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アベレージングのクローズアップ

ALCは、マーカ信号がハイに移行するときに波形をサンプリン

グし、サンプリングした波形の平均を使用してALC回路を設定

します。

ここで、ALCはオンのマーカ・ポイント（正極性）中にサンプ

リングします。

É}Å[ÉJ É}Å[ÉJ

É}Å[ÉJÉ}Å[ÉJ

正しい使用の例

波形：1022ポイント

マーカ・レンジ： 95-97
マーカ極性：正

この例は、波形の最高振幅エリアをサンプリングするよう設定され
たマーカを示します。マーカは、波形の最低振幅エリアの充分前に
設定されています。マーカと波形信号間のレスポンス差を考慮に入
れています。

レベリングなしのパルス

不適切な使用の例

波形：1022ポイント

マーカ・レンジ： 110-1022
マーカ極性：正

この例は、同じ波形のロー部分をサンプリングするよう設定さ
れたマーカを示します。このレベル用にALC変調器回路を設定

します。信号発生器が高振幅のパルスに遭遇したときには、通
常、信号発生器に対してレベリングなし状態が発生します。

マーカマーカ
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基本デジタル動作（オプション651/652/654）
波形マーカの使用
サンプル・レンジは信号の最初のポイントで開始

負のレンジを信号とオフ時間のあいだに設定

不適切な使用の例

波形：1022ポイント

マーカ・レンジ： 110-1022
マーカ極性：負

この図は、負極性マーカがオンのマーカ・ポイント中にローに移
行することを示します。マーカ信号はオフのポイント中にハイに
移行します。ALCは、オフのマーカ・ポイント中に波形をサンプ

リングします。

マーカ・オン マーカ・オン

より高い信号レベルの場合、オン時間とオフ時間をサンプリング
すると、変調器回路が不適切に設定されます。パルスの最初で振
幅が増加します。

マーカ
オフ

マーカ・オン
マーカマーカ

オフ 投入
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基本デジタル動作（オプション651/652/654）
波形マーカの使用
マーカ・ユーティリティにアクセスする

Mode > Dual ARB > More > 

注記：これは2番目の

Arbメニューです。

以下の表示は、波形のI成分とQ成分、および工場供給セグメントに

設定されたマーカ・ポイントを示します。

表示に示された
最 初 の サ ン プ
ル・ポイント

これらのソフトキー
は、マーカ表示に示さ
れた波形サンプル・ポ
イントのレンジを変更
します。

ソフトキーを押すたび
にサンプル・レンジが
約2の倍数ずつ変化し

ます。

最初の
サンプル・
ポイントの
マーカ・
ポイント

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください

これらのメニューの設定をファイル・
ヘッダにストアすることができます。
78ページを参照してください。
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基本デジタル動作（オプション651/652/654）
波形マーカの使用
波形セグメントのマーカを表示する

マーカは、波形セグメントに適用されます。セグメント（この例では、工場供給セグメントSINE_TEST_WFMを使用）の

マーカ・セットを表示するには、以下の手順を使用します。

1. 2番目のArbメニュー（87ページ）で、Set Markersを押します。

2. 目的の波形セグメント（この例ではSINE_TEST_WFM）を強調表示します。

3. Display Waveform and Markers > Zoom in Maxを押します。 
最大ズームイン・レンジは28ポイントです。

Zoom機能を試して、マーカがどのように表示されるかを見ます。

最大460ポイントを表示できます。サンプル・ポイントのレンジが460ポイントを超えると、表示波形にマーカ位置が表示

されない場合があります。

マーカ・ポイントを波形セグメントからクリアする

マーカ・ポイントを設定する場合、マーカ・ポイントは、すでに存在するポイントと置き換わりません。既存のポイント

に追加して設定されます。マーカは累積されるので、ポイントを設定する前に、セグメントを表示し（88ページ）、不要

なポイントを除去します。すべてのマーカをクリアすると、イベント出力信号のレベルは0 Vになります。セグメントの

マーカ・ポイントをクリアするには、セグメントがBBG媒体（71ページ）に存在する必要があります。

すべてのマーカ・ポイントをクリアする

1. 2番目のArbメニュー（87ページ）で、Set Markersを押します。

2. 目的の波形セグメント（この例ではSINE_TEST_WFM）を強調表示します。

3. 目的のマーカ番号を強調表示します。Marker 1 2 3 4を押します。

4. 選択したマーカ番号に対して、選択したセグメントのすべてのマーカ・ポイントを除去します。

a. Set Marker Off Range of Pointsを押します。

最初のマーカ・ポイントのソフトキーと最後のマーカ・ポイントのソフトキーが、波形の長さに対応します。工

場供給波形（SINE_TEST_WFM）には200個のサンプルが含まれます。設定されているすべてのマーカ・ポイント

をクリアするには、レンジが波形の長さと等しくなければなりません。

b. Apply To Waveform > Returnを押します。

5. 他のマーカから削除する残りのマーカ・ポイントに対してステップ3から繰り返します。

マーカ・ポイントのレンジをクリアする

以下の例では、ポイント10−20にマーカ・ポイント（Marker 1）が設定された波形を使用します。これにより、影響を受

けるマーカ・ポイントを簡単に見ることができます。既存のポイントがレンジに対して設定されているか、単一ポイント

（89ページ）として設定されているかに関係なく、同じプロセスが適用されます。

1. 2番目のArbメニュー（87ページ）で、Set Markersを押し、Marker 1を選択します。

2. オフにする最初のサンプル・ポイントを設定します（この例では13）。
Set Marker Off Range Of Points > First Mkr Point > 13 > Enterを押します。

3. オフにするレンジの最後のマーカ・ポイントを、波形のポイント数以下で、かつステップ2で設定した値（この例では

17）以上の値に設定します。 
88 Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド



基本デジタル動作（オプション651/652/654）
波形マーカの使用
Last Mkr Point > 17 > Enter > Apply To Waveform > Returnを押します。

右に示すように、ステップ2と3で設定され

たレンジ内のアクティブ・マーカのすべて

のマーカ・ポイントがオフになります。

マーカの表示方法については、88ページで

説明しています。

単一マーカ・ポイントをクリアする

88ページの「マーカ・ポイントのレンジをクリアする」に説明した手順を使用しますが、最初のマーカ・ポイントと最後

のマーカ・ポイントを、クリアするポイントの値に設定します。例えば、ポイント5のマーカをクリアする場合、最初の

値と最後の値を5に設定します。

波形セグメントにマーカ・ポイントを設定する

セグメントにマーカ・ポイントを設定するには、セグメントがBBG媒体に存在する必要があります（71ページ）。

マーカ・ポイントを設定する場合、マーカ・ポイントは、すでに存在するポイントと置き換わりません。既存のポイント

に追加して設定されます。マーカは累積されるので、マーカ・ポイントをセグメント内に設定する前に、セグメントを表

示し（88ページ）、不要なポイントを除去します（88ページ）。

マーカをポイントのレンジに配置する

1. 2番目のArbメニュー（87ページ）で、Set Markersを押します。

2. 目的の波形セグメントを強調表示します。

3. 目的のマーカ番号を選択します。Marker 1 2 3 4を押します。

4. レンジの最初のサンプル・ポイントを設定します（この例では10）。

Set Marker On Range Of Points > First Mkr Point > 10 > Enterを押します。

5. レンジの最後のマーカ・ポイントを、波形のポイント数以下で、かつ最初のマーカ・ポイントの値以上の値（この例

では20）に設定します。

Last Mkr Point > 20 > Enterを押します。

6. Apply To Waveform > Returnを押します。

これにより波形マーカ・ポイントのレンジが設定されます。以下の図に示すように、マーカ信号はサンプル・ポイント10
で開始し、サンプル・ポイント20で終了します。
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マーカの表示方法については、88ページで説明しています。
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基本デジタル動作（オプション651/652/654）
波形マーカの使用
マーカを単一ポイントに配置する

最初のポイント上

1. 2番目のArbメニュー（87ページ）で、Set Markersを押します。

2. 目的の波形セグメントを強調表示します。

3. 目的のマーカ番号を選択します。

Marker 1 2 3 4を押します。

4. Set Marker On First Pointを押します。

これにより、ステップ3で選択したマーカ番号に対してセグメントの最初のポイントにマーカが設定されます。

任意のポイント上

89ページの「マーカをポイントのレンジに配置する」に説明した手順を使用しますが、最初のマーカ・ポイントと最後の

マーカ・ポイントを、設定するポイントの値に設定します。例えば、ポイント5にマーカを設定する場合、最初の値と最

後の値を5に設定します。

繰り返し一定間隔でマーカを配置する

以下の例では、ポイントのレンジにマーカを設定し、各マーカ間の間隔（スキップするポイント数）を指定します。マー

カの設定を適用する前に間隔を設定する必要があります。スキップするポイント数を、前に設定したポイントのレンジに

適用することはできません。

1. 既存のマーカ・ポイントを除去します（83ページ）。

2. 2番目のArbメニュー（87ページ）で、Set Markersを押します。

3. 目的の波形セグメントを強調表示します。 

4. 目的のマーカ番号を選択します。 
Marker 1 2 3 4を押します。

5. レンジの最初のサンプル・ポイントを設定します（この例では5）。
Set Marker On Range Of Points > First Mkr Point > 5 > Enterを押します。

6. レンジの最後のマーカ・ポイントを設定します（最後のマーカ・ポイントの値は、波形のポイント数以下で、かつ最

初のマーカ・ポイント以上でなければなりません（この例では25））。
Last Mkr Point > 25 > Enterを押します。

7. スキップするサンプル・ポイントの数を入力します（この例では1）。
# Skipped Points > 1 > Enterを押します。

8. Apply To Waveform > Returnを押します。

これにより、右に示すように、マーカがマーカ・

ポイント・レンジに1ポイントごとに現れます

（1個のサンプル・ポイントがスキップされます）。

マーカの表示方法については、88ページで説明し

ています。

ポイント・スキップ機能は、EVENT出力として

クロック信号を作成するときなどに使用します。
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マーカ・パルスを表示する

波形を再生するとき（77ページ）、設定されたオンのマーカのパルスは、マーカ番号に対応するリア・パネルのイベント・

コネクタ／Aux I/Oピンで検出できます。この例は、1個以上のマーカ・ポイントが設定されている波形セグメント（89
ページ）によって生成されたマーカ・パルスの表示方法を示しています。プロセスは、波形シーケンスの場合と同じです。 

この例では、デュアルARBプレーヤで工場供給セグメントSINE_TEST_WFMを使用します。工場供給セグメントは、以下に

示すように、4個すべてのマーカが最初のサンプル・ポイントにマーカ・ポイントを持っています。

1. 最初のArbメニュー（69ページ）で、Select Waveformを押します。

2. SINE_TEST_WFMセグメントを強調表示し、Select Waveformを押します。

3. ARB Off Onを押してOnにします。

4. Agilent MXGのリア・パネルQ OUT出力をオシロスコープのチャネル1入力に接続します。

5. 信号発生器のリア・パネルEVENT 1出力をオシロスコープのチャネル2入力に接続します。 

マーカ1が存在するとき、以下の例に示すように、Agilent MXGがEVENT 1から信号を出力します。

波形セグメントの
最初のサンプル・
ポイントの
マーカ・ポイント

マーカの表示方法については、88ページで説明しています。

RF出力

Event 1信号のマーカ・パルス
92 Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド



基本デジタル動作（オプション651/652/654）
波形マーカの使用
RFブランキング・マーカ機能を使用する

マーカ機能（2番目のArbメニューのソフトキー・ラベルのMarker Routingとして説明）は、マーカ・ポイントの設定前で

も設定後（89ページ）でも設定できますが、マーカ・ポイントを設定する前にマーカ機能を設定すると、RF出力が変化し

ます。RFブランキングにはALCホールドが含まれます（84ページで説明しています。レべリングなしパワーに関する注意

を参照してください）。信号発生器は、マーカ信号がローに移行するとき、RF出力をブランキングします。この例は、前

の例「マーカ・パルスを表示する」の続きです。

1. 工場供給セグメントSINE_TEST_WFMを使用して、Marker 1のポイント範囲1−180を設定します（89ページ）。

2. Marker Routingソフトキー・メニューから、RF BlankingをMarker 1に割り当てます。 
2番目のArbメニュー（87ページ）で、Marker Routing > Pulse/RF Blank > Marker 1を押します。

マーカ極性 = 正
マーカ極性が正（デフォルト設定）の場合、オ
フのマーカ・ポイント中にRF出力がブランキ

ングされます。

200180ポイント1
マーカ

セグメント

RF信号

RF信号

200180ポイント1
マーカ

セグメント

マーカ極性 = 負
マーカ極性が負の場合、オンのマーカ・ポイン
ト中にRF出力がブランキングされます。

≈3.3V

0V

≈3.3V

0V

RF 信号

RF 信号
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波形マーカの使用
マーカ極性を設定する

負のマーカ極性を設定すると、マーカ信号が反転します。

1. 2番目のArbメニュー（87ページ）で、Marker Polarityを押します。

2. 各マーカに対して、所望のマーカ極性を設定します。

• デフォルトのマーカ極性は正です。

• それぞれのマーカ極性は独立して設定できます。

83ページの「マーカの極性設定とルーティング設定を保存する」も参照してください。

93ページで示したように、

正極性：  オンのマーカ・ポイントがハイ（≈3.3V）です。 

負極性：  オンのマーカ・ポイントがロー（0V）です。

RFブランキングは、極性の設定に関係なく信号のロー部分で発生します。
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基本デジタル動作（オプション651/652/654）
波形マーカの使用
波形シーケンスのマーカを制御する

波形セグメントで、オンになっているマーカ・ポイントは補助出力信号を生成します。信号は、マーカ番号に対応するリ

ア・パネルEVENT出力（9ページの「リア・パネルの概要」で説明）にルーティングされます。波形シーケンスの場合、

セグメントごとにマーカをオンまたはオフにすることができます。すなわち、シーケンスの一部のセグメントのマーカを

出力し、他のセグメントのマーカは出力しないようにすることができます。シーケンスのマーカ設定を変更するか、電源

を入れ直さない限り、シーケンスで編集した最後のセグメントのマーカ設定が、作成した次のシーケンスのすべてのセグ

メントに適用されます。波形シーケンスの作成方法については、75ページの「シーケンスを作成する」を参照してください。

図8-7　セグメントのマーカをオン／オフにするための波形シーケンス・メニュー

Mode > Dual ARB >
More > More > 

注記：これは番目の
Arbメニューです。

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください

波形シーケンスの作成中に
マーカをオン／オフ

シーケンスを編集して
マーカをオン／オフ
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 95



基本デジタル動作（オプション651/652/654）
波形マーカの使用
波形シーケンスのマーカをオン／オフにする

波形シーケンス内の波形セグメントを選択して各セグメントのマーカを個別にオンまたはオフにします。マーカは、シー

ケンスの作成時、またはシーケンスを作成してストアした後にオンまたはオフにすることができます。シーケンスがすで

にストアされている場合、変更後にシーケンスを再度ストアする必要があります。マーカ・ポイントがないマーカをオン

にしても、補助出力には影響がありません。セグメントにマーカ・ポイントを設定するには、89ページの「波形セグメン

トにマーカ・ポイントを設定する」を参照してください。この例は、波形シーケンスが存在すると仮定しています。

1. シーケンスのすべての波形セグメントがBBG媒体に存在することを確認します（71ページを参照）。

2. 3番目のArbメニューから、Waveform Sequencesを押します。

3. 目的の波形シーケンスを強調表示します。

4. Edit Selected Waveform Sequence > Enable/Disable Markersを押します。

5. マーカをトグルします。 

a. 最初の波形セグメントを強調表示します。

b. 必要に応じて、Toggle Marker 1、Toggle Marker 2、Toggle Marker 3、Toggle Marker 4を押します。

Mkr列のエントリ（以下の図を参照）は、マーカがセグメントに対してオンであることを示します。列にエントリ

がない場合、すべてのマーカがセグメントに対してオフになっています。

c. 順に、残りの各セグメントを強調表示して、ステップbを繰り返します。

6. Return > More > Name and Storeを押します。

7. テキスト入力キーを使用してシーケンスをリネームするか（70ページを参照）、そのままEnterを押して既存の名前で

シーケンスを保存します。

マーカが選択ごとにオンまたはオフになり、変更がシーケンス・ファイルに保存されます。

以下の図に、工場供給波形セグメントの1つを使用して作成されたシーケンスを示します。工場供給セグメントは、4個す

べてのマーカが最初のサンプルにマーカ・ポイントを持っています。この例では、最初のセグメントのマーカ1がオン、2
番目のセグメントのマーカ2がオン、3番目のセグメントのマーカ3と4がオンになっています。

各セグメントでは、そのセグメントに対してオンになっているマーカだけがリア・パネル補助出力信号を生成します。こ

の例の場合、マーカ1補助信号は、最初のセグメントに対してのみ現れます。他のセグメントに対してオフになっている

からです。マーカ2補助信号は2番目のセグメントに対してのみ現れ、マーカ3および4補助信号は3番目のセグメントに対

してのみ現れます。

シーケンス・マーカ列

このエントリは、セグメント
に対してマーカ3と4がオンに

なっていることを示します。
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基本デジタル動作（オプション651/652/654）
波形マーカの使用
EVENT出力信号を測定器トリガとして使用する

EVENT出力信号（マーカ信号）の用途の1
つは、測定機器のトリガです。波形の先頭、

波形の任意の単一ポイント、または波形の

複数ポイントで測定を開始するよう、マー

カをセットアップすることができます。測

定のためEVENT信号の使用を最適化する

には、サンプリング・レートの調整も必要

となります。図の右に、サンプリング・レー

トを設定する場所を示します。

EVENT出力信号は、立ち上がりエッジと立

ち下がりエッジで最大±4 nsのジッタを示

します。このジッタは、以下の2つの方法の

いずれかで減少させることができます。 

方法1：125 MHz/Nのサンプル・クロックを使用します。Nは正の整数で、125 MHz/Nが画面にきっちり納まる必要があり

ます。 
例：125 MHz、62.5 MHz、31.25 MHz、25 MHzなど 

結果を画面に正確に表示できない場合、ジッタが発生します。

例：N = 6はジッタを生成します。 であるからです。これは、表示のときに切り捨てられます。

方法2：マーカの間隔が8 nsの倍数になるように、サンプル・クロックと波形長を選択します。例：最初のポイントにマー

カを持つ200ポイント波形で、サンプル・クロックが50 MHzの場合、マーカの間隔は4 µsになります。4 µsは8 nsの倍数な

ので、ジッタを抑えることができます。

EVENT出力信号がジッタを示し、信号が測定トリガとして使用されている場合、波形が、ジッタを持つ波形として誤って

表示されます。この状態が発生した場合、ジッタが出現しない値（上を参照）にサンプリング・レートを調整することが

できます。サンプリング・レートを変更したときには元の波形との整合性を保持するため、サンプル値の再計算も行う必

要があります。以下の図に、マーカ信号のジッタとジッタの波形に対する影響を示します。

サンプ
リング・
レート
設定

このメニューの設定をファイル・
ヘッダにストアすることができます。
78ページを参照してください。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください

125 MHz 6⁄ 20.833 MHz=

ジッタが消えた
（サンプリング・レートを最適化したため）

波形にジッタがあるように見える
（ジッタを持つ EVENT 信号を使用してトリガしたため）

オシロスコープが波形をトリガ オシロスコープが EVENT 信号をトリガ オシロスコープが EVENT 信号をトリガ

EVENT 出力信号にジッタが現れる
（サンプリング・レートが最適でないため）
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波形のトリガ

図8-8　トリガのソフトキー

トリガは、信号発生器が変調信号を伝送するタイミングを制御することにより、データ伝送を制御します。データ伝送が

1回だけ発生する（Singleモード）、連続して発生する（Continuousモード）、または開始と中止を繰り返す（Gatedモード

とSegment Advanceモード）ようにトリガを設定することができます。

トリガ信号には、正のステートと負のステートが含まれます。どちらのステートもトリガに使用することができます。

トリガ・モードを初めて選択したときや、あるトリガ・モードから別のトリガ・モードへ変更したときには、変調信号が

トリガされるまでRF出力に搬送波信号が現れない場合があります。これは、信号発生器が、最初のトリガ・イベントの前

にI信号とQ信号を0ボルトに設定するからです。RF出力で搬送波信号を保持するため、初期I電圧と初期Q電圧をゼロ以外

の値に設定した状態でデータ・パターンを作成します。

波形トリガの設定には2つのパートがあります。

• タイプは、再生するときの波形の動作を指定します（99ページの「トリガ・タイプ」を参照）。

• 信号源は、変調波形の再生を開始するトリガの受信方法を指定します（100ページの「トリガ・ソース」を参照）。

Mode > Dual ARB >

99ページを参照

100ページを参照

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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基本デジタル動作（オプション651/652/654）
波形のトリガ
トリガ・タイプ

タイプはトリガ・モードを定義します。トリガされたときの波形の再生方法です。

• Continuousモードは、信号をオフにするか、別の波形、トリガ・モード、またはレスポンスを選択するまで、波形を繰

り返します（Free Run、Trigger & Run、Reset & Run）。

• Singleモードは、波形を1回再生します。

• Segment Advanceモードは、トリガされた場合のみ、シーケンスのセグメントを再生します。トリガ・ソースがセグメ

ントごとの再生を制御します（101ページの「例：セグメント・アドバンス・トリガ」を参照）。最後のセグメント・

ループ中にトリガを受信すると、シーケンスの最初のセグメントまで再生されます。

• Gatedモードは、最初のアクティブ・トリガ・ステートで波形をトリガした後、外部からのゲーティング信号に応えて

波形の再生の開始と停止を繰り返します。102ページの「例：ゲーティッド・トリガ」を参照してください。

Mode >
Dual ARB >
Trigger Type >

波形を即座にトリガして再生します。波形の再生中に受信し
たトリガは無視されます。

トリガを受信したときに波形を再生します。後続のトリガ
は無視されます。

トリガを受信したときに波形を再生します。後続のトリガに
よって波形がリスタートします。

波形は、トリガ・ソースの非アクティ
ブ・ステート中は停止し、アクティブ・
ステート中に再生されます。

波形の再生中に受信した
トリガは無視されます。

波形の再生中に受信し
たトリガは現在の波形
が完了するまで待機状
態になり、完了後に波形
をもう一度再生します。

波形の再生中に受信した
トリガにより、波形が即
座にリスタートします。

シーケンスのセグメントを1回
再生します。繰り返し設定は無
視されます。再生後、デュアル
ARBプレーヤは停止してトリガ

を待ち、トリガを受信すると次
のセグメントに進みます。次の
セグメントが最後まで再生され
ます。 

セグメントの再生中にトリガを
受信した場合、セグメントが最
後まで再生されます。その後、
デュアルARBプレーヤは次のセ

グメントに進み、セグメントを
最後まで再生します。

シーケンスのセグメントは、波形が別のトリガを受信するまで連続して再生されます。 

セグメントの再生中にトリガを受信した場合、セグメントが最後まで再生されます。その
後、デュアルARBプレーヤは次のセグメントに進み、セグメントを連続して再生します。 

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください
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トリガ・ソース

外部トリガ極性

• Continuousモード、Singleモード、Segment Advanceモードでは、Ext Polarityソフトキーを使用して外部トリガ極性を

設定します。

• Gatedモードでは、Active LowソフトキーとActive Highソフトキー（99ページ）が外部トリガ極性を決定します。 

Mode >
Dual ARB > 
Trigger Source >

Patt Trig In BNCコネクタ

（13ページを参照）

Aux I/Oコネクタ

（13ページを参照）

Neg = 信号発生器はトリガ信号が

ロー・ステートのあいだ応答します。

Pos = 信号発生器はトリガ信号がハ

イ・ステートのあいだ応答します。

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください
100 Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド



基本デジタル動作（オプション651/652/654）
波形のトリガ
例：セグメント・アドバンス・トリガ

セグメント・アドバンス・トリガを使用すると、波形シーケンス内のセグメントの再生を制御することができます。この

タイプのトリガは、繰り返し値（76ページ）を無視します。例えば、セグメントの繰り返し値が50の場合、セグメント・

アドバンス・トリガ・モードとしてSingleを選択すると、セグメントは1回だけ再生されます。以下の例では、2個のセグ

メントを持つ波形シーケンスを使用します。

波形シーケンスの作成と保存を行っていない場合、75ページの「シーケンスを作成する」を参照してください。

1. 信号発生器をプリセットします。

2. RF出力を設定します。

• 目的の周波数を設定します。

• 目的の振幅を設定します。

• RF出力をオンにします。

3. 再生する波形シーケンスを選択します。

a. Mode > Dual ARB > Select Waveformを押します。

b. Sequence On列で、波形シーケンス・ファイルを強調表示します。

c. Select Waveformを押します。

4. トリガを次のように設定します。

• トリガ・タイプ：連続セグメント・アドバンス

Trigger Type > Segment Advance > Continuousを押します。

• トリガ・ソース：Triggerハードキー

Trigger Source > Trigger Keyを押します。

5. 波形シーケンスを生成します。 
ARB Off Onを押してOnを強調表示します。

6. （オプション）波形をモニタします。

信号発生器のRF OUTPUTをオシロスコープの入力に接続し、信号を表示できるようにオシロスコープを設定します。

7. 最初の波形セグメントをトリガして、連続再生を開始します。 
Triggerハードキーを押します。

8. 2番目のセグメントをトリガします。 
Triggerハードキーを押します。

Triggerハードキーを押すと、現在再生中のセグメントが終了し、次のセグメントが開始します。

シーケンスの最後のセグメントを再生中の場合、Triggerハードキーを押すと、最後のセグメントが終了したときに波

形シーケンスの最初のセグメントが開始します。
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波形のトリガ
例：ゲーティッド・トリガ

ゲーティッド・トリガを使用すると、変調波形のオン・ステートとオフ・ステートを定義することができます。

1. 以下の図に示すように、ファンクション・ジェネレータの出力を信号発生器のリア・パネルPATT TRIG INコネクタに

接続します。この接続は、すべての外部トリガ方法に適用可能です。オプションでオシロスコープを接続すると、ト

リガ信号のRF出力に対する影響を表示することができます。

2. 信号発生器をプリセットします。

3. RF出力を設定します。

• 目的の周波数を設定します。

• 目的の振幅を設定します。

• RF出力をオンにします。

4. 再生する波形を選択します（シーケンスまたはセグメント）。

a. Mode > Dual ARB > Select Waveformを押します。

b. Segment On列またはSequence On列で、波形を強調表示します。

c. Select Waveformを押します。

5. トリガを次のように設定します。

• トリガ・タイプ：ゲーティッド

Trigger Type > Gatedを押します。

• アクティブ・ステート：ロー

Active Lowを押します。

• トリガ・ソース：外部

Trigger Source > Extを押します。

• 入力コネクタ：リア・パネルPatt Trig In BNC
Ext Source > Patt Trig In 1を押します。

6. 波形を生成します。Return > ARB Off Onを押してOnを強調表示します。

ファンクション・ジェネレータ

オシロスコープ信号発生器

チャネル1 チャネル2
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基本デジタル動作（オプション651/652/654）
波形のトリガ
7. ファンクション・ジェネレータで、外部ゲーティング・トリガ用のTTL信号を設定します。

8. （オプション）波形をモニタします。

信号発生器の出力と外部トリガ信号を表示するためオシロスコープを設定します。ゲートのアクティブ周期（この例

ではロー）中に波形が出力を変調している様子が表示されます。

以下の図にサンプル画面を示します。
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波形のトリガ
例：外部トリガ

以下の例を使用して、PATT TRIG INリア・パネルBNCコネクタでTTLステートがローからハイへ変化したら、変調RF信号

を100ミリ秒出力するよう信号発生器を設定します。

1. 上に示すように、信号発生器をファンクション・ジェネレータに接続します。

2. RF出力を設定します。

• 目的の周波数を設定します。

• 目的の振幅を設定します。

• RF出力をオンにします。

3. 再生する波形を選択します（シーケンスまたはセグメント）。

a. Mode > Dual ARB > Select Waveformを押します。

b. Segment On列またはSequence On列で、波形を強調表示します。

c. Select Waveformを押します。

4. 波形を生成します。 
ARB Off Onを押してOnを強調表示します。

5. 波形トリガを次のように設定します。

a. トリガ・タイプ：シングル

Trigger Type > Single > No Retriggerを押します。

b. トリガ・ソース：外部

Trigger Source > Extを押します。

c. 入力コネクタ：リア・パネルPatt Trig In BNC
Ext Source > Patt Trig In 1を押します。

d. 外部トリガ極性：正

Ext Polarityを押してPosを強調表示します。

e. 外部遅延：100 ms
More > Ext Delayを押してOnを強調表示します。

Ext Delay Time > 100 > msecを押します。

6. ファンクション・ジェネレータを設定します。

• 波形：0.1 Hz方形波

• 出力レベル：3.5V～5V 

信号発生器

ファンクション・
ジェネレータ

出力
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波形のクリッピング
波形のクリッピング

高パワー・ピークを持つデジタル変調信号により相互変調歪みが発生し、その結果生じたスペクトル・リグロースが隣接

周波数バンドの信号と干渉する場合があります。クリッピング機能を使用すると、IデータとQデータを最高ピークの選択

したパーセンテージまで切り取って高パワー・ピークを下げ、それによってスペクトル・リグロースを減少させることが

できます。

• 「パワー・ピークが大きくなるしくみ」 106ページ

• 「ピークがスペクトル・リグロースを引き起こすしくみ」 108ページ

• 「クリッピングがピーク対アベレージ・パワーを減少させるしくみ」 109ページ

• 「円クリッピングを設定する」 112ページ

• 「長方形クリッピングを設定する」 113ページ

図8-9　クリッピングのソフトキー

Mode > Dual ARB > More > More >

唯一使用可能な場合
のときにのみ使用可能

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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波形のクリッピング
パワー・ピークが大きくなるしくみ

クリッピングにより高パワー・ピークがどのように減少するかを見るには、信号を作成するときにピークが大きくなるし

くみを理解することが重要です。

複数のチャネルの加算

I/Q波形は、以下の図に示すように、複数チャネルの加算によって生成される場合があります。複数の個別チャネル波形で

同じステート（ハイまたはロー）のビットが同時に発生すると、加算された波形に通常よりも高いパワー・ピーク（正ま

たは負）が発生します。 

チャネル波形ではハイ・ステートのビットとロー・ステートのビットがランダムに起きるので、通常は相殺されるため、

複数のチャネルの加算で高パワー・ピークが発生することはほとんどありません。

複数のチャネルを加算して

1つのI波形またはQ波形を

生成

加算されたI波形またはQ波形
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波形のクリッピング
I波形とQ波形の結合

I/Q変調器でI波形とQ波形を結合してRF波形を作成する場合、RFエンベロープの大きさは です。IとQの二乗は常

に正の値になります。

以下の図に示すように、I波形とQ波形で同時に正であるピークと負であるピークは互いに相殺されず、結合してより大き

なピークを形成します。

I波形とQ波形を結合

によって決まる、

結果のベースバンド波形
高ピークのベクトル表現
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波形のクリッピング
ピークがスペクトル・リグロースを引き起こすしくみ

波形では、稀に発生する高パワー・ピークにより、以下の図に示すように、波形のピーク対アベレージ・パワー比が上昇

します。 

トランスミッタのパワーアンプの利得は、特定のアベレージ・パワーを提供するように設定されているため、高ピークに

よりパワーアンプが飽和の方向に進みます。これが相互変調歪みを引き起こし、スペクトル・リグロースが生成されます。

スペクトル・リグロースは、（側波帯と同様）搬送波の両側に発達し、隣接周波数バンドまで延びる周波数のレンジです

（以下の図を参照）。クリッピングは、ピーク対アベレージ・パワー比を減少させることにより、この問題に対するソリュー

ションを提供します。

ピーク・パワー

アベレージ・パワー

スペクトル・

リグロース

RF信号 隣接バンド
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波形のクリッピング
クリッピングがピーク対アベレージ・パワーを減少させるしくみ

波形をクリッピングすると、ピーク対アベレージ・パワー、およびその結果としてスペクトル・リグロースを減少させる

ことができます。クリッピングは、I/Qデータを最高ピークの選択したパーセンテージまで切り取ることにより、波形のパ

ワー・ピークを制限します。信号発生器には、2つのクリッピング方法があります。

• 円クリッピングは、複合I/Qデータに適用されます（IデータとQデータが等しく切り取られます）。

図8-10に示すように、クリッピング・レベルはベクトルのすべての位相に対して一定で、ベクトル表現では円として

現れます。

• 長方形クリッピングは、IデータとQデータに独立に適用されます。

 110ページの図8-11に示すように、IとQに対するクリッピング・レベルが異なり、ベクトル表現では長方形として現

れます。

円クリッピングも長方形クリッピングも、目的は、スペクトル・リグロースが減少し、しかも信号の完全性が損なわれな
いレベルまで波形をクリップすることです。111ページの図8-12の2つの相補累積分布プロットに、波形に円クリッピング

を適用した後のピーク対アベレージ・パワーの減少を示します。

クリッピング値が小さいほど、パスするピーク・パワーが小さくなります（より多くの信号がクリッピングされます）。

ピークは通常、波形の残りの部分との実質的な干渉なしにクリッピングすることができます。多くの場合、符号化システ

ムに固有の誤差補正により、本来ならクリッピング・プロセスで失われるデータも保持することができます。ただし過度

のクリッピングを適用すると、失われたデータを回復できません。さまざまなクリッピング設定を試して、必要なデータ

を保持しながらスペクトル・リグロースを減少させるパーセンテージを見つけます。

図8-10　円クリッピング
クリッピングなしのピーク・パワー

（クリッピングを100％に設定）

クリッピングを80％
に設定

クリッピングされたベースバンド波形

クリッピングされたピークの

ベクトル表現
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波形のクリッピング
図8-11　長方形クリッピング

クリッピングされたI波形

クリッピングされたQ波形

クリッピングされたIおよび

Qピークのベクトル表現

a)  |I|クリッピングを100％に設定

（クリッピングなし）

b) |I|クリッピングを最大ピークの75％に設定

c) |Q|クリッピングを100％に設定

（クリッピングなし）

d) |Q|クリッピングを最大ピークの50％に設定
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波形のクリッピング
図8-12　ピーク対アベレージ・パワーの減少

相補累積分布

クリッピング＝100％（クリッピングなし）の場合のCCDF

クリッピング＝80％の場合のCCDF
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円クリッピングを設定する

この例を使用して円クリッピングを設定し、波形のピーク対アベレージ・パワー比に対する影響を観察します。円クリッ

ピングは、複合I/Qデータをクリップします（IデータとQデータが等し切り取られます）。円クリッピングの詳細について

は、109ページの「クリッピングがピーク対アベレージ・パワーを減少させるしくみ」を参照してください。

注意 クリッピングは、非可逆的で、累積されます。クリッピングを適用する前に波形ファイルのコピーを保存

してください。

波形ファイルをコピーする

1. 信号発生器のファイルを表示します。File > Catalog Type > More > Volatile Segmentsを押します。

2. 波形RAMP_TEST_WFMを強調表示します。

3. Copy Fileを押します。

4. コピーに名前を付け（この例では名前はMY_TEST_CIRC）、Enterを押します。

円クリッピングをコピーした波形ファイルに適用する

1. DUAL ARB Waveform Utilitiesメニューを開きます。Mode > Dual ARB > More > More > Waveform Utilitiesを押します。

2. ファイルのリストで、コピーしたファイル（この例ではMY_TEST_CIRC）を強調表示します。

3. CCDFプロットを作成します。Plot CCDFを押します。 

4. 波形の曲線の形状と位置を観察します（右の

例では暗い線）。

5. 円クリッピングをアクティブにします。

Return > Clipping > Clipping Typeを押して

|I+jQ|を強調表示します。

6. 円クリッピングを80％に設定します。 
Clip |I+jQ| To > 80 > %を押します。

7. IデータとQデータに80％のクリッピングを

適用します。Apply to Waveformを押します。

8. CCDFプロットを作成します（右の例を参

照）。Plot CCDFを押します。 

9. クリッピング後の波形曲線を観察します。 

前のプロットと比べてピーク対アベレージ・

パワーが減少しています。

クリッピング前の波形曲線の例

円クリッピング後の波形曲線の例
112 Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド



基本デジタル動作（オプション651/652/654）
波形のクリッピング
長方形クリッピングを設定する

この例を使用して長方形クリッピングを設定します。長方形クリッピングは、IデータとQデータを独立に切り取ります。

長方形クリッピングの詳細については、109ページの「クリッピングがピーク対アベレージ・パワーを減少させるしくみ」

を参照してください。

注意 クリッピングは、非可逆的で、累積されます。クリッピングを適用する前に波形ファイルのコピーを保存

してください。

波形ファイルをコピーする

1. 信号発生器のファイルを表示します。File > Catalog Type > More > Volatile Segmentsを押します。

2. 波形RAMP_TEST_WFMを強調表示します。

3. Copy Fileを押します。

4. コピーに名前を付け（この例では名前はMY_TEST_REC）、Enterを押します。

長方形クリッピングをコピーした波形ファイルに適用する

1. DUAL ARB Waveform Utilitiesメニューを開きます。Mode > Dual ARB > More > More > Waveform Utilitiesを押します。

2. ファイルのリストで、コピーしたファイル（この例ではMY_TEST_REC）を強調表示します。

3. CCDFプロットを作成します。Plot CCDFを押します。 

4. 波形の曲線の形状と位置を観察します（右の

例では暗い線）。

5. 長方形クリッピングをアクティブにします。

Return > Clipping > Clipping Typeを押して

|I|,|Q|を強調表示します。

6. Iデータの場合80％クリッピングを設定しま

す。Clip |I| To > 80 > %を押します。

7. Qデータの場合40％クリッピングを設定しま

す。Clip |Q| To > 40 > %を押します。

8. 波形に長方形クリッピングを適用します。Apply to Waveformを押します。

9. CCDFプロットを作成します（右の例を参

照）。Plot CCDFを押します。 

10. クリッピング後の波形曲線を観察します。 

前のプロットと比べてピーク対アベレージ・

パワーが減少しています。

クリッピング前の波形曲線の例

長方形クリッピング後の波形曲線の例
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波形のスケーリング

信号発生器は、波形を復元するときに補間アルゴリズム（I/Qデータ・ポイント間のサンプリング）を使用します。一般的

な波形の場合、この補間によりオーバシュートが発生し、DACオーバレンジ・エラーが生成される可能性があります。こ

の章では、DACオーバレンジ・エラーが発生するしくみと、波形スケーリングを使用してこれらのエラーをなくす方法に

ついて説明します。

• 「DACオーバレンジ・エラーが発生するしくみ」 116ページ

• 「スケーリングがDACオーバレンジ・エラーをなくすしくみ」 117ページ

• 118ページと119ページのAgilent MXG波形スケーリング：

— 現在再生中の波形をスケーリングするための波形ランタイム・スケーリング

— 現在再生中の波形、またはBBG媒体の再生中でない波形ファイルを恒久的にスケーリングするための波形スケー

リング
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波形のスケーリング
図8-13　スケーリングのソフトキー

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください

波形ランタイム・スケーリング、118ページを参照

このメニューの設定をファイル・ヘッダ
にストアすることができます。
78ページを参照してください。

波形スケーリング、119ページを参照
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DACオーバレンジ・エラーが発生するしくみ

信号発生器は、デジタルI/Qベースバンド波形をアナ

ログ波形に変換するとき、補間器フィルタを使用し

ます。補間器のクロック・レートはベースバンド・

クロックの4倍なので、補間器は入力ベースバンド・

サンプル間のサンプル・ポイントを計算し、右の図

に示すように波形をスムージングします。

DACの補間フィルタはベースバンド波形をオーバ

シュートします。ベースバンド波形に高速立ち上が

りエッジがある場合、補間器フィルタのオーバ

シュートが補間されたベースバンド波形の成分にな

ります。このレスポンスによって立ち上がりエッジ

のピークにリップルやリンギングが発生します。こ

のリップルがDACレンジの上限をオーバシュート

する場合、補間器が誤差の多いサンプル・ポイント

を計算し、リップルの真の形状を複製できません（右

の図を参照）。その結果、信号発生器がDACオーバ

レンジ・エラーを報告します。

補間されたサンプル

ベースバンド・サンプル

オーバレンジ・サンプルは
正しく補間できません

ベースバンド・サンプル

D
A

C
レ
ン
ジ
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スケーリングがDACオーバレンジ・エラーをなくすしくみ

スケーリングは、ピーク対アベレージ・パワー比などの基本

形状と特性を保持しながら、ベースバンド波形の振幅を減少

します。高速立ち上がりベースバンド波形を十分にスケーリ

ングして補間器フィルタのオーバシュートに対して適切な

マージンが得られるようにすると、補間器フィルタが、リッ

プルを含むサンプル・ポイントを計算して、オーバレンジ・

エラーを取り除くことができます（右の図を参照）。

スケーリングは波形の基本形状を保持しますが、過度のス

ケーリングは波形の完全性を損なう可能性があります。例え

ば、ビット分解能が低くなり過ぎると、波形が量子化ノイズ

によって破損します。最大確度を実現し、ダイナミック・レ

ンジを最適化するには、DACオーバレンジ・エラーを除去す

るために必要な分だけ波形をスケーリングします。最適なス

ケーリングは、波形の内容によって異なります。

DACレンジ内のサンプルは

正しく補間されます

ベースバンド・サンプル

D
A

C
レ

ン
ジ
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波形ランタイム・スケーリングを設定する

ランタイム・スケーリングは、再生中に波形データをスケーリングします。ランタイム・スケーリングは、ストアされた

データには影響しません。ランタイム・スケーリングをセグメントまたはシーケンスに適用することができ、スケーリン

グ値はARBがオンでもオフでも設定できます。このスケーリング・タイプは、DACオーバレンジ・エラーの除去に有効で

す。ランタイム・スケーリング調整は累積されません。スケーリング値は、波形ファイルの元の振幅に適用されます。ラ

ンタイム・スケーリング設定の保存方法は2通りあります。保存機能を使用する（35ページ）方法と、設定をファイル・

ヘッダに保存する（79ページ）方法です。ファイル・ヘッダに保存すると、値が波形ファイルと一緒に保存され、Save機
能を使って保存すると、値が現在の機器設定としてストアされます。

この例を使用して、現在選択している波形のスケーリング方法を学習します。 

1. スケーリングを適用する波形を選択します。

a. Mode > Dual ARB > Select Waveformを押します。

b. 目的の波形（セグメントまたはシーケンス）を強調表示します。

c. Select Waveformを押します。

2. 選択した波形を再生します。ARB Off Onを押してOnを強調表示します。

3. Waveform Runtime Scaling値を設定します。 

a. ARB Setup > Waveform Runtime Scalingを押します。 

b. スケーリング値を入力します。

信号発生器が新しいスケーリング値を波形に自動的に適用します。1つですべての波形を最適化できるような値は

ありません。最大ダイナミック・レンジを実現するには、DACオーバレンジ・エラーを引き起こさない最大スケー

リング値を使用します。 

c. Returnを押します。 
118 Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド



基本デジタル動作（オプション651/652/654）
波形のスケーリング
波形スケーリングを設定する

波形スケーリングは、波形データに恒久的な影響を与え、BBG媒体にストアされた波形セグメントにのみ適用されるとい

う点で波形ランタイム・スケーリングと異なっています。波形のスケーリングは、DACフル・スケール（100％）のパー

センテージとしてアップまたはダウンします。この方法を使用して波形をスケーリングする場合、波形ランタイム・スケー

リング値も、このスケーリングに適合するよう変更する必要があります。

スケーリングを行うと、信号発生器が、波形ファイルのサンプル値を目的のスケーリング値に適合するよう恒久的に変更

します。スケーリングを開始すると、信号発生器は以下の動作を実行します。

• 波形ファイルの絶対ピーク・サンプル値を探します。

• 現在のフル・スケールのパーセンテージを指定します。

• 指定した絶対ピーク・サンプル・スケール値に対する所望のスケール値の割合を計算します。

• 波形ファイルの各サンプルにこの比を乗算します。

波形をスケーリングするとき、分数データの生成、データの損失、または両方が起こる可能性があります。分数データは、

スケーリング値を減少または増加するたびにほぼ毎回発生し、量子化誤差の原因となります。量子化誤差は、スケーリン

グ・ダウンのときにより顕著です。ノイズ・フロアに近づくからです。信号発生器が分数データを丸めるか、2のベキ乗

からの結果を使用してスケーリング値が導出されたときには、データが失われます。 これは、波形を半分（2のベキ乗：21

= 2）にスケーリングすると、各波形サンプルが1ビットを失うことを意味します。波形データの変更は補正不能で、波形

の歪みの原因となります。スケーリングの適用前に元のファイルのコピーを作成してください。

以下の例を使用して波形スケーリングを波形ファイルに適用します。このプロセスでは工場供給波形RAMP_TEST_WFMを使

用していますが、どの波形ファイルでも同じです。

波形ファイルをコピーする

1. BBG媒体の波形ファイルを表示します。File > Catalog Type > More > Volatile Segmentsを押します。

2. 波形RAMP_TEST_WFMを強調表示します。

3. Copy Fileを押します。

ピーク・サンプル

フル・スケールの85％－プリスケーリング

フル・スケールの60％－ポスト・スケーリング

DACフル・スケール100％

スケーリング後のサンプル値 = スケーリング比×プリスケール・サンプル値

スケーリング比 = 目的のスケール値／現在のスケール値

= 60 / 85　
= 0.70588　

波形の各サンプルに0.70588を乗算すると、

60％ポスト・スケーリング波形振幅になります。

元のランプ波形 スケーリング後のランプ波形

= サンプル
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4. コピーに名前を付け（この例では名前はMY_TEST_SCAL）、Enterを押します。

コピーした波形ファイルにスケーリングを適用する

注意 このタイプのスケーリングは非可逆的です。スケーリング操作で失われたデータを復元できません。スケー

リング前に波形ファイルのコピーを保存してください。

1. DUAL ARB Waveform Utilitiesメニューを開きます。 

Mode > Dual ARB > More > More > Waveform Utilitiesを押します。

2. BBG媒体セグメント・ファイルのリストで、コピーしたファイル（この例ではMY_TEST_SCAL）を強調表示します。

3. スケーリング値を設定して適用します（この例では70％スケーリングを適用します）。 

Scale Waveform Data > Scaling > 70 > % > Apply to Waveformを押します。
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I/Q変調

エラー・ベクトル・マグニチュードには以下のファクタが関係します。

• IチャネルとQチャネル間の振幅差、位相差、遅延差

• DCオフセット

I/Qメニューでは、I/Q信号源と出力を選択できるほか、I信号とQ信号の差を補正するための調整機能や校正機能もあります。

34ページの「搬送波信号の変調」も参照してください。

図8-14　I/Q表示とソフトキー

これらの選択は、
I/Q Routing & 
Optimization
グラフィックに
反映されます。

125ページ

このパネルに、I/Q信号ルーティング

とI/Q補正最適化経路の現在の設定が

表示されます。

このパネルに、I/Q調整の現在のステータスと設定が

表示されます。Page UpキーとPage Downキーを使

用してこれらのパラメータをスクロールします。グ
レーは非アクティブ（オフ）調整を示します。

内部生成された、バースト変調フォーマットとのみ使用
されます。RFバースト変調器をオン／オフにします。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください

各経路には異なる最適化値が必要です。経路を選択
することは、経路が要求する固有の最適化値を選択
していることになります。 

信号発生器は、選択した最適化値を両方の経路に適
用します。選択しなかった経路が劣化します。

内部生成のQ信号を反転し、I成分がQ成分より

90度遅れるようにします。

127ページ
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リア・パネルのI出力とQ出力を使用する

注記 リア・パネルのIコネクタとQコネクタは、内部BBGを使用しているあいだのみ信号を出力します。

信号発生器は、搬送波を変調するほか、内部生成のI信号とQ信号をリア・パネルのIコネクタとQコネクタにルーティング

します。これらの出力信号はポストDACであるため、アナログ形式です。これらのリア・パネルI信号とQ信号は、以下に

使用することができます。

• システムのトランスミッタ段をドライブする

• I/Q変調器などの個別のアナログI成分とQ成分をテストする

• I信号とQ信号を別の信号発生器にルーティングする

工場デフォルト設定は、内部生成のI信号とQ信号を、I/Q変調器およびリア・パネルのI出力コネクタとQ出力コネクタに

ルーティングします。ただしリア・パネルの信号を最適化するには（校正係数を適用するには）、外部I/Q出力経路を選択

する必要があります。

波形を選択して再生する

1. Mode > Dual ARB > Select Waveformを押します。

2. 目的の波形を強調表示します。

3. Select Waveform > ARB Off On to Onを押します。

信号経路を最適化する

1. リア・パネルのIコネクタおよびQコネクタからのケーブルをDUTまたは別の信号発生器に接続します。

ARBをオンにすると、信号発生器がI信号とQ信号をリア・パネルのコネクタに自動的に出力します。

リア・パネルのI信号とQ信号を、別の信号発生器へのI入力とQ入力として使用することができます。MXGにはこの目

的のため、フロント・パネルにコネクタI InputとQ Inputが装備されています。

2. I/Q > I/Q Correction Optimized Path > Ext I/Q Outputを押します。
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基本デジタル動作（オプション651/652/654）
I/Q変調
経路を最適化すると、経路インジケータが緑色に変わります。

工場デフォルト設定 - RF Output 経路の最適化

リアパネル I/Q 経路の最適化
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基本デジタル動作（オプション651/652/654）
I/Q変調
フロント・パネルの入力を設定する

信号発生器は、フロント・パネルのI InputとQ Inputを通して外部供給されたアナログI信号とQ信号を受け取ります。外

部信号を変調ソースとして使用するか、外部信号を内部ベースバンド・ジェネレータ信号と加算することができます。

1. I信号とQ信号をフロント・パネルのコネクタに接続します。

a. アナログI信号を信号発生器のフロント・パネルのI Inputに接続します。

b. アナログQ信号を信号発生器のフロント・パネルのQ Inputに接続します。

2. フロント・パネルの入力信号を認識するように信号発生器を設定します。 

• 搬送波を変調するには

I/Q > I/Q Source > Externalを押します。

• 合計して搬送波を変調するには

I/Q > I/Q Source > Sumを押します。

BB GEN経路用の波形を選択し、再生するには、71ページを参照してください。

内部BBG（BB GEN）だけが、I信号とQ信号をリア・パネルのI出力とQ出力にルーティングします。

3. 外部のI信号とQ信号のみ（加算なし）を使用する場合、I/Q変調器をオンにします。 
I/Q Off Onを押してOnにします。

4. RF出力を設定します。

a. 搬送波周波数を設定します。

b. 搬送波振幅を設定します。

c. RF出力をオンにします。

信号発生器の表示 - I/Q Correction Optimized Path
をExt I/Q Outputに設定すると、両方の経路が校正

されます（122ページを参照）。

信号発生器の表示 - I/Q Correction Optimized Path
を RF Output に設定すると、両方の RF 経路が校正
されます（122 ページを参照）。
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基本デジタル動作（オプション651/652/654）
I/Q調整
I/Q調整

I/Q Adjustmentsを使用して、雑音の補正や、I/Q信号への雑音の追加を行います。

I/Q > I/Q Adjustments >

波形の再生時にのみ
使用可能

オプション 1EL
でのみ使用可能

Q信号の振幅を基準にしてI信号の振幅を調整

します。これを内部劣化として使用するか、外
部IおよびQ出力配線の経路のふぞろいによっ

て起きる信号経路損失の差を補正するため使用
します。

I信号の位相を基準にしてQ信号の位

相をオフセットします。ベースバン
ド直交位相調整キーは、度の単位で
校正されます。外部入力直交位相調
整は校正されません。 
このキーによって提供される機能
は、I/Q Skewキーによって提供され

る機能と同じではありません。

スキューは通常、雑音の作成、または大きな帯域幅の信号
でエラー・ベクトルを減少するために使用します。

I信号とQ信号間の相対時間遅延補正が得られます。I信号と

Q信号が異なる信号経路を移動すると、時間遅延差が発生

し、大きな帯域幅変調信号ではEVM誤差として現れます。 

ベースバンド生成中、I/Q信号に大きさが同じで向きが反対

の時間遅延（スキュー）を加算すると、時間遅延誤差が除
去され、内部ベースバンド・ジェネレータで発生した信号
の遅延が補正されます。 

トリガとマーカを基準として、I信号とQ信号の絶対位相を変

更します。 

正の値は遅延を追加し、負の値は信号を進めます。この値
は、RF信号に変調されたベースバンド信号と外部出力信号

（IとQ）に影響します。設定は、定エンベロープ変調では使

用できません。外部I入力とQ入力には影響しません。

オフセットは通常、搬送波リーケージを減少するため、または搬送波
リーケージをシミュレートする劣化を作成するために使用します。

Common Mode I/Q Offset
I信号とQ信号のDCオフセットを同時に調整します。

Diff Mode I Offset
IおよびIバー出力信号のDCオフセット・レベルを調整します。IおよびI
バーを独立して調整することはできません。

Diff Mode Q Offset
IおよびIバー出力信号のDCオフセット・レベルを調整します。IおよびI
バーを独立して調整することはできません。
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基本デジタル動作（オプション651/652/654）
I/Q調整
I/Q調整I/Q Delayは、雑音を追加するためではなく、EVENT出力信号（マーカ信号）とRF出力間のレイテンシの補正に使

用します。

表8-1　I/Q調整の用途

I/Q調整 有効 劣化

オフセット 搬送波フィードスルー DCオフセット

直交角度

EVM誤差 位相スキュー

I/Qイメージ I/Q経路遅延

I/Qスキュー EVM誤差
高サンプリング・レート位相
スキューまたはI/Q経路遅延

I/Q利得バランス I/Q振幅差 I/Q利得比
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基本デジタル動作（オプション651/652/654）
I/Q校正
I/Q校正

I信号補正とQ信号補正の場合、I/Q校正を使用します。I信号とQ信号のどの面が補正されるかは、信号が内部生成か外部

生成かに依存します。

I/Q校正を実行するとき、校正データは工場供給校正データよりも優先されます。校正ルーチンが、時間と共に劣化する性

能、または温度変化によって劣化する性能を改善します。 

補正 内部IおよびQ 外部IおよびQ

オフセット X X

利得バランス X --

直交誤差 X X

I/Q > I/Q Calibration >

唯一使用可能な場合の
ときにのみ使用可能

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください

DCは、現在の機器設定のI/Q性能を最適化します。通常、数

秒で完了します。DC校正後のI/Q調整を除いて、機器設定

を変更するとDC校正が無効になり、信号発生器が工場供給

校正データに戻ります。

測定器をプリセットしたり、電源を入れ直したりすること
は、Revert to Default Cal Settingを押すことと同じです。

Userは、フル校正が不要のときに、クイック校正を提供し

ます。校正のスタート周波数とストップ周波数を指定する
ことにより、校正を制限できます。 

校正を測定器のフル周波数レンジ未満に制限すると、残り
のレンジに工場供給校正データが使用されます。

情報は、プリセットしたり電源を入れ直したりしても保持
されます。

Fullの所要時間は5分です。測定器の周波数レンジ全体に対

して測定を実行します。 

情報は、プリセットしたり電源を入れ直したりしても保持
されます。

ユーザ生成校正データを削
除し、工場供給校正データを
復元します。
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基本デジタル動作（オプション651/652/654）
I/Q校正
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9 リアルタイム・ノイズの信号への追加

（オプション403）

ここに記載の内容を理解するには、信号発生器の基本動作についての知識が必要です。パワー・レベル／周波数の設定な

どの機能を簡単に操作できない場合、第3章「基本操作」（23ページ） を参照して、内容をよく理解しておいてください。

本章では、相加性白色ガウス雑音（AWGN）波形ジェネレータの使用例を示します。AWGN波形ジェネレータは、オプショ

ン403を搭載したベクトル信号発生器でのみ使用することができます。

• 「デュアルARB波形へのリアルタイム・ノイズの追加」130ページ

• 「Real Time I/Q Baseband AWGNの使用」132ページ
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リアルタイム・ノイズの信号への追加（オプション403）
デュアルARB波形へのリアルタイム・ノイズの追加
デュアルARB波形へのリアルタイム・ノイズの追加

オプション403を搭載したベクトル信号発生器を使用すると、デュアルARB波形プレーヤで変調波形を再生しながら、搬

送波にリアルタイムで相加性白色ガウス雑音（AWGN）を加えることができます。 

図9-1　Real Time I/Q Baseband AWGNのソフトキー

選択した搬送波対雑音比に対して、ノイ
ズを積分する帯域幅

搬送波パワーを基準にしたノイズ・パ
ワーの量

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください

表示にノイズのステート（オン
またはオフ）が示されます。

実際の雑音帯域幅。通常、搬送波の帯域
幅より少し広くなります。
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リアルタイム・ノイズの信号への追加（オプション403）
デュアルARB波形へのリアルタイム・ノイズの追加
工場供給波形SINE_TEST_WFMを使って1 GHz、–10 dBmの搬送波を変調した後、40 MHzの搬送波帯域幅で30 dBのノイ

ズ・パワー搬送波対雑音比を持つ45 MHz帯域幅のノイズを適用するには、以下の手順を使用します。

1. 信号発生器をプリセットし、以下を設定します。

• 周波数：1 GHz

• 振幅：−10 dBm

• RF出力：オン

2. 工場供給波形SINE_TEST_WFMを選択します。

a. Mode > Dual ARB > Select Waveformを押します。

b. SINE_TEST_WFMを強調表示し、Select Waveformを押します。

3. デュアルARBプレーヤをオンにします。ARB Off Onを押してOnを強調表示します。

4. ARBサンプル・クロックを50 MHzに設定します。ARB Setup > ARB Sample Clock > 50 > MHzを押します。

5. Real-time Noise Setupを押し、以下を設定します。

• 搬送波対雑音比：30 dB

• 搬送波帯域幅：40 MHz

• 雑音帯域幅：45 MHz

• リアルタイム・ノイズ：オン

信号発生器の表示パワー・レベル（–10 dBm）にはノイズ・パワーが含まれます。
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 131



リアルタイム・ノイズの信号への追加（オプション403）
Real Time I/Q Baseband AWGNの使用
Real Time I/Q Baseband AWGNの使用

図9-2　Real Time I/Q Baseband AWGNのソフトキー

10 MHz帯域幅のノイズを500 MHz、−10 dBmの搬送波に適用するには、以下の手順を使用します。

1. ノイズを設定します。

a. 信号発生器をプリセットします。

b. Mode > Real Time I/Q Baseband AWGNを押します。

c. Bandwidth > 10 > MHzを押します。

2. ノイズを生成します。

ARB Off Onを押してOnを強調表示します。

生成中、AWGNインジケータとI/Qインジケー

タがアクティブになります（右の図を参照）。

RF搬送波の変調にAWGNを使用できるよう

になります。

3. RF出力を設定します。

• 周波数：500 MHz

• 振幅：−10 dBm

• RF出力：オン

信号発生器のRF OUTPUTコネクタでAWGNを持つ搬送波を使用できるようになります。

各キーの詳細については、23ページの説明に従って

キーのヘルプを使用してください
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10 セキュア環境での作業

• 「メモリ・タイプについて」 134ページ

• 「メモリからのデータの除去（オプション006のみ）」 136ページ

• 「Secure Displayの使用（オプション006のみ）」 139ページ
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セキュア環境での作業
メモリ・タイプについて
メモリ・タイプについて

信号発生器には、複数のメモリ・タイプがあります。それぞれ、特定タイプのデータのストアに使用されます。機密デー

タを除去する前に、各メモリ・タイプがどのように使用されているかを理解する必要があります。以下の表に、基本測定

器とオプションのベースバンド・ジェネレータで使用する各メモリ・タイプを示します。

表10-1　基本測定器メモリ

メモリ・
タイプと
サイズ

通
常

操
作

中
に

書
き

込
み

可
能

?

電
源

を
オ

フ
に

し
た

と
き

デ
ー

タ
を

保
持

?

目的／内容 データ入力方法 測定器内の位置と注釈

メイン・メモリ
（RAM）

32 MB

はい いいえ ファームウェア動作
メモリ

ユーザ・データなし

オペレーティング・
システム

CPUボード

メイン・メモリ
（フラッシュ）

8 MB

はい はい 工場校正／設定データ

aユーザ・ファイル・シス
テム。フラットネス校正、
機器ステート、掃引リス
トが含まれます。

ファームウェア・
アップグレードと

ユーザ保存データa

CPUボード（ファームウェア・メモリと同じチップ、

ただし別に管理）

このメモリ・チップには8 Mバイトのユーザ・データ

（ここで説明）と8 Mバイトのファームウェア・メモ

リが含まれているため、フルチップ消去は推奨しませ
ん。Erase and Sanitize機能を実行すると、ユーザ・デー

タ領域が選択的に完全に削除されます。

ファームウェ
ア・メモリ
（フラッシュ）

8 MB

いいえ はい メイン・ファームウェア・
イメージ

工場インストール済
みまたはファーム
ウェア・アップグ
レード

CPUボード（メイン・フラッシュ・メモリと同じチッ

プ、ただし別に管理）

通常操作では、このメモリを上書きすることはできませ
ん。メモリは、ファームウェア・インストール中また
はアップグレード・プロセス中にのみ上書きされます。

このメモリ・チップには8 Mバイトのユーザ・データ

と8 Mバイトのファームウェア・メモリ（ここで説明）

が含まれているため、フルチップ消去は推奨しませ
ん。Erase and Sanitize機能を実行すると、ユーザ・デー

タ領域が選択的に完全に削除されます。

ブートロム・
メモリ
（EEPROM）

8 kB

いいえ はい CPUブートアップ・パラ

メータ

ユーザ・データなし

工場でプログラム CPUボード

通常操作では、このメモリを上書きまたは消去するこ
とはできません。この読取り専用データは、工場でプ
ログラムされます。

校正データ
（フラッシュ）

256 kB

いいえ はい 工場校正／設定データの
バックアップ

ユーザ・データなし

工場またはサービス
のみ

RFボード

LCD
ディスプレイ・
メモリ（RAM）

160 kB

いいえ いいえ 表示バッファ オペレーティング・
システム

RFボード
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セキュア環境での作業
メモリ・タイプについて
フロント・
パネル・メモリ

（フラッシュ）

32 kB

いいえ いいえ フロント・パネル・キー
ボード・コントローラ・
ファームウェア

ユーザ・データなし

オペレーティング・
システム

フロント・パネル・ボード

a アナログ測定器のみ

表10-2　ベースバンド・ジェネレータ・メモリ（オプション651、652、654）

メモリ・
タイプと
サイズ

通
常

操
作

中
に

書
き

込
み

可
能

?

電
源

を
オ

フ
に

し
た

と
き

デ
ー

タ
を

保
持

?

目的／内容 データ入力方法 注釈

波形メモリ
（RAM）

≦320 MB

はい いいえ 波形（ヘッダとマーカ・
データを含む）

通常ユーザ操作 Erase and Sanitize機能を実行すると、ユーザ・データが

完全に削除されます。

持続性メモリ
（フラッシュ）

512 MB

はい はい すべてのユーザ・データ Erase and Sanitize機能を実行すると、ユーザ・データが

完全に削除されます。

校正データ・
メモリ

（フラッシュ）

128 kB

いいえ はい ユーザ・データなし

表10-1　基本測定器メモリ（続き）

メモリ・
タイプと
サイズ

通
常

操
作

中
に

書
き

込
み

可
能

?

電
源

を
オ

フ
に

し
た
と

き
デ

ー
タ

を
保
持

?

目的／内容 データ入力方法 測定器内の位置と注釈
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セキュア環境での作業
メモリからのデータの除去（オプション006のみ）
メモリからのデータの除去（オプション006のみ）

信号発生器を安全な開発環境から移動するときには、装備された複数のセキュリティ機能を使用して、機密扱いの占有情

報を測定器から除去することができます。セキュリティ機能には、リモート操作用として同じ働きを持つSCPIコマンドも

あります（“System Subsystem (:SYSTem)”コマンド。『SCPI Command Reference』を参照してください）。

注意 信号発生器には、複数のメモリ・タイプ（134ページの表10-1と135ページの表10-2で説明）があります。

それぞれ、特定タイプのデータのストアに使用されます。機密データを除去する前に、各メモリ・タイプ

がどのように使用されているかを理解する必要があります。

Erase All

除去：  すべてのユーザ・ファイル、ユーザ・フラットネス校正、ユーザI/Q校正を除去します。

リセット：   すべてのテーブル・エディタを元の工場値にリセットし、ユーザ・データと設定へのアクセスや表

示ができないようにします。

実行しない操作：  メモリを削除しません。

消去にかかる時間：   通常< 1分。ファイルの数に依存します。

開始する場合：  File > More > Security > Erase All > Confirm Eraseを押します。

注記 File > Delete All Filesとは異なります。この操作は、すべてのユーザ・ファイルを削除しますが、テーブル・エ

ディタをリセットしません。

137
ページ

下を参照

137ページの

「Secure Mode」を

参照

36ページを参照

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください
136 Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド



セキュア環境での作業
メモリからのデータの除去（オプション006のみ）
Erase and Overwrite All

Erase Allと同じ動作を実行します。それに加えて、以下に示すように、国防省(DoD)規格に従って各種のメモリ・タイプ

をクリア／上書きします。

CPU Flash  すべてのアドレス可能な位置をランダムな文字で上書きした後、フラッシュ・ブロックを消去しま

す。チップ消去と同じ目的を達成できます。消去後にシステム・ファイルが復元されます。

開始する場合：  File > More > Security > Erase and Overwrite All > Confirm Eraseを押します。

Erase and Sanitize All

Erase and Overwrite Allと同じ動作を実行した後、さらに上書き動作を追加します。この機能を実行後、国防省（DoD）

規格に適合した削除を行うため、以下に説明する追加手順を手動で実行する必要があります。

開始する場合：  File > More > Security > Erase and Sanitize All > Confirm Sanitizeを押します。

Secure Mode

注意 セキュア・モードを（Confirmを押して）オンにすると、モードをオフにしたり、セキュリティ・レベルを

下げたりする操作はできなくなります。次に電源を入れ直したときに、指定したセキュリティ・レベルの

消去動作が実行されます。セキュア・モードをオンにした後は、電源を入れ直すまでセキュリティ・レベ

ルを上げることしかできません。例えば、EraseをOverwriteに変更することはできますが、逆の操作はでき

ません。

電源を入れ直すと、セキュリティ・レベルの選択は同じままですが、セキュア・モードがオンになりません。

セキュア・モードでは、次回、測定器の電源を入れ直したときに選択したSecurity Level動作が自動的に適用されます。 

レベルを設定する場合：  File > More > Security > Security Levelを押し、以下から選択します。

— None = 工場プリセット。ユーザ情報が失われません。

— Erase = Erase All
— Overwrite = Erase and Overwrite All
— Sanitize = Erase and Sanitize All

オンにする場合：  File > More > Security > Enter Secure Mode > Confirmを押します。

ソフトキーがSecure Mode Activatedに変わります。

CPU Flash すべてのアドレス可能な位置をランダムな文字で上書きした後、フラッシュ・ブロックを消去しま

す。チップ消去と同じ目的を達成できます。消去後にシステム・ファイルが復元されます。

BBG持続性メモリ

（フラッシュ）

(ベクトル測定器のみ) すべてのアドレス可能な位置をランダムな文字で上書きした後、フラッ

シュ・ブロックを消去します。チップ消去と同じ目的を達成できます。消去後にシステム・ファイ

ルが復元されます。
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セキュア環境での作業
メモリからのデータの除去（オプション006のみ）
機能しない測定器のセキュア

測定器が機能せず、セキュリティ機能を使用できない場合、測定器からプロセッサ・ボードと、ベクトル測定器の場合、

A4メモリ・チップを取り出す必要があります。これらのアセンブリを取り出したら、以下のオプションのいずれかを選択

します。

• ボードを破棄し、測定器を修理施設に送ります。新しいボードを搭載し、測定器の修理と校正を行います。測定器が

保証期間内であれば、新しいボードの料金は請求されません。

• 機能している別の測定器がある場合、ボードをその測定器に搭載し、メモリを消去します。ボードを機能しない測定

器に再度搭載し、修理と校正のため修理施設に送ります。現在機能している測定器でボードが機能しない場合、機能

しないボードを破棄し、測定器の障害の原因がボードであることを修理オーダに記載します。測定器が保証期間内で

あれば、新しいボードの料金は請求されません。

ボードを取り出して交換する方法については、『Service Guide』を参照してください。
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Secure Displayの使用（オプション006のみ）

この機能は、権限のないユーザが測定器の表示を読んだり、フロント・パネルから現在の設定を不正に変更したりするこ

とを防止します。以下の図に示すメッセージを除いて、表示がブランクになり、フロント・パネルのキーが無効になります。 

表示とフロント・パネル・キーを再度オンにするには、電源を入れ直します。

図10-1　Secure Displayソフトキー

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください
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セキュア環境での作業
Secure Displayの使用（オプション006のみ）
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11 トラブルシューティング

• 「表示」 142ページ

• 「信号発生器のロックアップ」 142ページ

• 「RF出力」 143ページ

— 「RF出力がない」

— 「電源のシャットダウン」

— 「RF出力に変調がない」

— 「RF出力パワーが低過ぎる」

— 「歪み」

— 「スペクトラム・アナライザと一緒に動作中の信号損失」

— 「ミキサと一緒に動作中の信号損失」 144ページ

• 「掃引」 146ページ

— 「掃引をオフにできない」

— 「掃引が失速するように見える」

— 「不適切なリスト掃引待ち時間」

— 「呼び出されたレジスタからリスト掃引情報がなくなっている」

— 「リスト掃引またはステップ掃引で振幅が変化しない」 146ページ

• 「内部媒体データ・ストレージ」 147ページ

— 「機器ステートを保存したが、レジスタが空か、間違ったステートが含まれている」

• 「外部媒体データ・ストレージ」 147ページ

— 「測定器が外部媒体接続を認識するが、ファイルを表示しない」

• 「プリセット」 147ページ

— 「信号発生器が応答しない」

— 「Presetを押すとユーザ・プリセットを実行する」

• 「エラー・メッセージ」 148ページ

• 「フロント・パネルのテスト」 149ページ

• 「セルフテスト」 149ページ

• 「ライセンス」 150ページ

• 「Agilent Technologiesへの問合せ方法」 151ページ

— 「信号発生器をAgilentに返送する」
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表示
表示

表示が暗すぎて読めない

明度とコントラストが最小値に設定されています。16ページの「ディスプレイの設定」の図を使用して明度とコントラス

トのソフトキーを探し、値を調整して表示が見えるようにします。

信号発生器のロックアップ
• 信号発生器がリモート・モード（画面にRインジケータが表示されます）でないことを確認します。リモート・モード

を終了し、フロント・パネルをアンロックするには、Local Cancel/(Esc)を押します。

• 信号発生器が、フロント・パネル操作を防止するローカル・ロックアウトになっていないことを確認します。ローカ

ル・ロックアウトについては、『Programming Guide』を参照してください。

• 信号発生器の画面に進捗度バーが表示される場合、操作が進行中です。

• 信号発生器をプリセットします。

• 信号発生器の電源を入れ直します。
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RF出力
RF出力

RF出力がない

• RF ON/OFF LED（3ページに表示）をチェックします。オフの場合、RF On/Offを押して出力をオンにします。

• 振幅が信号発生器のレンジ内に設定されていることを確認します。

• 測定器が波形を再生中の場合、マーカ極性とルーティング設定が正しいことを確認します（83ページの「マーカの極

性設定とルーティング設定を保存する」 を参照）。

電源のシャットダウン

電源が機能しない場合、修理または交換が必要です。測定器のサービスを自分で行えない場合は、修理のため信号発生器

をAgilentサービス・センタに送ります（151ページを参照）。

RF出力に変調がない

Mod On/Off LEDと<変調> Off Onソフトキーをチェックし、両方がオンになっていることを確認します。34ページも参照

してください。

ベクトル信号発生器でのデジタル変調の場合、内部I/Q変調器がオンであることを確認します（I/Qインジケータが表示さ

れます）。

外部変調ソースを使用する場合、外部ソースがオンで、信号発生器の指定リミット内で動作していることを確認します。

RF出力パワーが低過ぎる

• 表示のAMPLITUDEエリアにOFFSインジケータが表示される場合、オフセットを除去します。

Amptd > More (1 of 2) > Amptd Offset > 0 > dBを押します。49ページの「出力オフセットの設定」 も参照してください。

• 表示のAMPLITUDEエリアにREFインジケータが表示される場合、基準モードをオフにします。

1. Amptd > More > Amptd Ref Off Onを押し、Offを強調表示します。

2. 出力パワーを目的のレベルにリセットします。

50ページの「出力基準の設定」 も参照してください。

• 信号発生器を外部ミキサと一緒に使用している場合、144ページを参照してください。

• 信号発生器をスペクトラム・アナライザと一緒に使用している場合、144ページを参照してください。

• パルス変調がオンの場合、ALCをオフにし、パルス幅が仕様内であることをチェックします。

歪み

波形シーケンスのセグメントを編集して再セーブした場合、シーケンスはヘッダにストアされたRMS値を自動的に更新し

ません。そのため、出力信号に歪みが生じます。シーケンスのヘッダ情報を表示し、RMS値を再計算します（78ページを

参照）。
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RF出力
スペクトラム・アナライザと一緒に動作中の信号損失

信号発生器をプリセレクションのないスペクトラム・アナライザと一緒に使用する場合、逆電力の影響によりRF出力に問

題が生じます。レべリングなし動作モード（47ページで説明）を使用します。

周波数によっては、スペクトラム・アナライザのLOフィードスルーがRF入力ポートで+5 dBm に達する場合があります。

LOフィードスルーとRF搬送波の周波数差がALC帯域幅より小さいと、LOの逆電力が信号発生器のRF出力を振幅変調する

可能性があります。望ましくないAMの速度は、スペクトラム・アナライザのLOフィードスルーと信号発生器のRF搬送波

の周波数差と等しくなります。

逆電力の問題は、いずれかのレベリングなし動作モードを使用すると解決できます。 

以下を参照してください。

• 「ALCオフ・モード」47ページ

および

• 「パワー・サーチ・モード」48ページ

ミキサと一緒に動作中の信号損失

ミキサとの低振幅結合操作中に信号発生器のRF出力での信号損失を修正するには、減衰を追加し、RF出力の振幅を増加

します。

右の図に、信号発生器が低振幅信号

をミキサに提供する際の設定を示し

ます。

内部レべリングされた信号発生器の

RF出力（およびALCレベル）は−8
dBmです。ミキサは+10 dBmのLOで

駆動され、LO-RFアイソレーション

は15 dBです。結果の−5 dBmのLO
フィードスルーが、信号発生器のRF
出力コネクタに入り、内部ディテク

タに届きます。

周波数によっては、このLOフィード

スルー・エネルギーのほとんどが

ディテクタに入ります。ディテクタ

は周波数に関係なく全入力パワーに

応答するので、この余分のエネル

ギーによりALCがRF出力を減少さ

せます。この例では、ディテクタの

逆電力が実際にALCレベルより大きく、これによりRF出力で信号の損失が起こります。

ミキサ

LO 

ALCレベル 
= −8 dBm

RFレベル
制御

信号発生器

出力制御

ディテクタが
−8 dBmの

ALCレベルを

測定

ディテクタ
が−5 dBm
の逆電力を
測定

LOフィードスルー
= −5 dBm

RF出力
= −8 dBm

LOレベル
= +10 dBm

IF 

ALCへの逆電力の影響
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RF出力
右に示すソリューションは同様の

構成ですが、信号発生器のRF出力と

ミキサの入力の間に10 dBアッテ

ネータを接続しています。信号発生

器のALCレベルは、+2 dBmまで増

加し、10 dBアッテネータを通って

伝送し、ミキサ入力で要求された−8
dBmの振幅を実現します。 

元の構成と比較して、ALCレベルは

10 dB高くなりますが、アッテネー

タがLOフィードスルー（および信号

発生器のRF出力）を10 dBだけ減少

します。減衰構成を使用すると、

ディテクタは望ましい+2 dBmの信

号と、望ましくない−15 dBmのLO
フィードスルーにさらされます。望

ましいエネルギーと望ましくない

エネルギー間のこの17 dBの差によ

り、信号発生器のRF出力レベルに最大0.1 dBのシフトが生じます。

ミキサ

LO 

ALCレベル／RF出力
= +2 dBm

RFレベル
制御

信号発生器

出力制御

ディテクタが

+2 dBmのALC
レベルを測定

ディテクタ
が−15 dBm
の逆電力を
測定

LOフィードスルー
= −5 dBm

RF出力
= −8 dBm

LOレベル
= +10 dBm

IF 

逆電力ソリューション

10 dB 
ATTEN
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掃引
掃引

掃引をオフにできない

Sweep > Sweep > Offを押します。

掃引が失速するように見える

掃引の現在のステータスは、進捗度バーに陰影表示の長方形として示されます（27ページの「掃引出力の設定」 を参照）。

掃引が失速するように見える場合、以下をチェックします。

1. 以下のキー・シーケンスのいずれかで掃引をオンにします。

Sweep > Sweep > Freq
Sweep > Sweep > Amptd
Sweep > Sweep > Waveform（ベクトル測定器のみ）

2. 掃引がシングル・モードの場合、Single Sweepソフトキーを押します。 

3. 掃引トリガ（Sweep Triggerソフトキーによって示されます）がFree Runに設定されていない場合、Free Runに設定し、

行方不明の掃引トリガが掃引をブロックしていないか判断します。

4. ポイント・トリガ（Point Triggerソフトキーによって示されます）がFree Runに設定されていない場合、Free Runに設

定し、行方不明のポイント・トリガが掃引をブロックしていないか判断します。

5. 待ち時間を1秒に設定し、待ち時間が、表示するには遅すぎる値に設定されていたか速すぎる値に設定されていたかを

判断します。

6. ステップ掃引またはリスト掃引に2個以上のポイントが設定されていることを確認します。

不適切なリスト掃引待ち時間

1. Sweep > More > Configure List Sweepを押します。

2. リスト掃引の待ち時間値が正確であることをチェックします。

3. 待ち時間値が不適切な場合、値を編集します。

待ち時間値が正しい場合、次の手順に進みます。

4. Moreを押し、Dwell Type List StepソフトキーがListに設定されていることを確認します。

Stepが選択されている場合、信号発生器が、リスト掃引ではなくステップ掃引用に設定された待ち時間を使用してリ

スト・ポイントを掃引します。

27ページの「掃引出力の設定」 も参照してください。

呼び出されたレジスタからリスト掃引情報がなくなっている

リスト掃引情報は、機器ステート・レジスタに機器ステートの一部としてストアされません。現在のリスト掃引だけが信

号発生器で使用可能です。リスト掃引データを測定器カタログにストアできます（37ページの「データのセーブ／リコー

ル」を参照）。

リスト掃引またはステップ掃引で振幅が変化しない

掃引タイプが振幅（Amptd）に設定されていることを確認します。掃引タイプを周波数（Freq）または波形に設定したと

きには、振幅が変化しません。
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内部媒体データ・ストレージ
内部媒体データ・ストレージ

機器ステートを保存したが、レジスタが空か、間違ったステートが含まれている

使用する予定だったレジスタ番号が空か、間違った機器ステートが含まれている場合、レジスタ99を呼び出します。99よ
りも大きなレジスタ番号を選択した場合、信号発生器が機器ステートをレジスタ99に自動的に保存します。

38ページの「機器ステート・ファイルの場合」 も参照してください。

外部媒体データ・ストレージ

測定器が外部媒体接続を認識するが、ファイルを表示しない

外部媒体が他の測定器またはコンピュータで機能する場合、単に信号発生器と互換性がない可能性があります。別のメモ

リ・スティックを使用してください。互換性のある媒体については、信号発生器のデータ・シートを参照してください。

プリセット

信号発生器が応答しない

信号発生器がプリセットに応答しない場合、測定器がリモート・モードで、キーパッドがロックされています。 

リモート・モードを終了し、プリセット・キーをアンロックするには、Local Cancel/(Esc)を押します。

Presetを押すとユーザ・プリセットを実行する

この動作は、以前の製品と互換性があるSCPIコマンドを使用すると発生します。信号発生器を通常使用に戻すには、コマ

ンド:SYST:PRESet:TYPE NORMを送信します。 

Agilent MXG SCPIコマンドについては、『SCPI Command Reference』を参照してください。
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エラー・メッセージ
エラー・メッセージ

エラー・メッセージのタイプ

イベントが複数タイプのエラーを生成することはありません。例えば、クエリ・エラーを生成するイベントは、デバイス

固有エラー、実行エラー、コマンド・エラーを生成しません。

クエリ・エラー（–499～–400）は、測定器の出力待ち行列制御が、第6章のIEEE 488.2で説明したメッセージ交換プロト

コルに関する問題を検出したことを示します。このクラスのエラーは、イベント・ステータス・レジスタにクエリ・エ

ラー・ビット（ビット2）をセットします（IEEE 488.2、セクション11.5.1）。これらのエラーは、IEEE 488.2, 6.5で説明

したメッセージ交換プロトコル・エラーに対応します。この場合、

• 存在する出力も中断している出力もないときに、出力待ち行列からデータを読み出そうとしています。または

• 出力待ち行列のデータが行方不明になっています。

デバイス固有エラー（–399～–300、201～703、800～810）は、おそらくハードウェアまたはファームウェア状態の異常

により、デバイス操作が正しく完了しなかったことを示します。これらのコードは、セルフテスト応答エラーにも使用さ

れます。このクラスのエラーは、イベント・ステータス・レジスタにデバイス固有エラー・ビット（ビット3）をセット

します（IEEE 488.2、セクション11.5.1）。

正エラーの<error_message>文字列はSCPIによって定義されません。正エラーは、測定器が、GPIBシステム内、測定器の

ファームウェアまたはハードウェア内、ブロック・データの転送中、あるいは校正中にエラーを検出したことを示します。

実行エラー（–299～–200）は、測定器の実行制御ブロックによってエラーが検出されたことを示します。このクラスのエ

ラーは、イベント・ステータス・レジスタに実行エラー・ビット（ビット4）をセットします（IEEE 488.2、セクション

11.5.1）。この場合、

• ヘッダに続く<PROGRAM DATA>要素が、デバイスによってリーガル入力レンジの外側にあると評価されたか、デバ

イスの機能と一貫していません。または

• 有効なプログラム・メッセージが、あるデバイス状態によって正しく実行できませんでした。

実行エラーは、丸めや数式評価操作が完了した後に報告されます。例えば、数値データ要素の丸めは、実行エラーとして

報告されません。

コマンド・エラー（–199～–100）は、測定器のパーサがIEEE 488.2構文エラーを検出したことを示します。このクラスの

エラーは、イベント・ステータス・レジスタにコマンド・エラー・ビット（ビット5）をセットします（IEEE 488.2、セ

クション11.5.1）。この場合、

• IEEE 488.2構文エラーがパーサによって検出されています（IEEE 488.2規格に違反した制御-デバイス・メッセージを

受信しました。考えられる違反には、デバイス・リッスン形式に違反するデータ要素や、デバイスが受け入れること

ができないタイプのデータ要素が含まれます）、または

• 認識されないヘッダを受信しました。これには、不適切なデバイス固有ヘッダや、誤っているか実装されていない

IEEE 488.2共通コマンドが含まれます。

エラー・メッセージ・ファイル

エラー・メッセージの完全なリストは、測定器に付属のCDROMに収録されています。エラー・メッセージ・ファイルに

は通常、エラーの意味をさらに明確にするため、各エラーと共に説明が含まれています。エラー・メッセージは数字でリ

ストされています。同じエラー番号に対して複数のメッセージをリストする場合、メッセージはアルファベット順になっ

ています。 
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フロント・パネルのテスト
フロント・パネルのテスト

セルフテスト

セルフテストは、信号発生器のさまざまな機能をチェックする一連の内部テストです。

すべての表示ピクセルを選択した色に設定します。 
通常操作に戻るには、任意のキーを押します。

Blink RF On/Off、Mod on/Off、More LEDs

正しい操作：
Full CCW = −10
Full CW = 10

キーボード・マップを表示します。 
キーを押すと、マップにキーの位置が示されます。

各キーの詳細については、23ページの説明に

従ってキーのヘルプを使用してください

セルフテストを実行するには約5分かかります。

障害が発生した場合：
1. GPIB ケーブル、LAN ケーブル、USB ケーブルを含むすべて

の外部ケーブルが信号発生器から取り外されていることを確

認し、セルフテストを再度実行します。

2. セルフテストに失敗し続ける場合、信号発生器のサービスが

必要です。測定器のサービスを自分で行えない場合は、失敗

したテストの詳しい説明や画面に表示されたその他のエ

ラー・メッセージを付けて、修理のため信号発生器を Agilent
サービス・センタに送ります。

151 ページの「Agilent Technologies への問合せ方法」を参照し

てください。

現在選択しているテストの
詳細を表示します。
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 149



トラブルシューティング
ライセンス
ライセンス

時間ベース・ライセンスが動作を終了した

• 測定器が進んだ時間または日付にリセットされ、時間ベース・ライセンスの有効期限が終了した可能性があります。

• 測定器がほぼ25時間以上遅れた時間または日付にリセットされ、測定器が時間ベース・ライセンスを無視している可

能性があります。

時間と日付を設定する際の詳細と注意については、18ページを参照してください。

時間ベース・ライセンスをロードできない

測定器がほぼ25時間以上遅れた時間または日付にリセットされ、測定器が時間ベース・ライセンスを無視している可能性

があります。

時間と日付を設定する際の詳細と注意については、18ページを参照してください。
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Agilent Technologiesへの問合せ方法
Agilent Technologiesへの問合せ方法

• 電子計測へのニーズに関わるサポート、および最寄りのAgilentオフィスに関する情報：

http://www.agilent.com/find/assist

• アクセサリまたはドキュメント：http://www.agilent.com/find/mxg

• 新しいファームウェア・リリース：http://www.agilent.com/find/upgradeassistant

インターネットにアクセスできない場合は、フィールド・エンジニアにお問い合わせください。

注記 通信や電話で信号発生器について説明する際には、モデル番号とフルのシリアル番号を使用してください。

Agilentの営業担当は、この情報を使用してお使いのユニットが保証期間内にあるかどうかを判断します。

信号発生器をAgilentに返送する

信号発生器をサービスのためAgilent Technologiesに返送するには、以下の手順に従ってください。

1. 信号発生器の問題に関して、できるだけ多くの情報を収集します。 

2. インターネット（http://www.agilent.com/find/assist）に掲載の最寄りの地域の電話番号を呼び出します。インター

ネットにアクセスできない場合は、Agilentフィールド・エンジニアにお問い合わせください。 

信号発生器とその状態に関する情報を共有した後で、修理のために信号発生器を返送する場所についての情報をお知

らせします。

3. 信号発生器を送る際には信号発生器を適切に保護するため、元の出荷時の梱包材料を使用する（可能な場合）か、同

様の梱包材料を使用します。
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用語集

A

Active Entry（アクティブ・エントリ）　現在選択され、そ

のため編集可能なエントリまたはパラメータ

ARB　任意波形発生器

AWG　任意波形発生器。相加性白色ガウス雑音

B

BBG Media（BBG媒体）　ベースバンド・ジェネレータ媒

体。揮発性メモリで、ここで波形ファイルが再生または編

集されます。

BNC Connector（BNCコネクタ）　Bayonet 
Neill-Concelmanコネクタ。同軸ケーブルを終端するために

使用されるRFコネクタの1タイプです。

C

CCW　反時計回り

C/N　搬送波対雑音比

CW　連続波。時計回り

D

DHCP　ダイナミック・ホスト通信プロトコル

Dwell Time（待ち時間）　ステップ掃引(28ページを参照)
では、信号がセトリングし、掃引が次のポイントに移動す

る前に測定を実行できる時間

E

EVM　エラー・ベクトル・マグニチュード。理想基準信号と

測定信号間の所定の瞬間におけるベクトル差の大きさです。
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド
G

GPIB　汎用インタフェース・バス。テスト機器に共通の8
ビット・パラレル・バスです。

H

Hardkey（ハードキー）　測定器上のラベルが付いたボタン

I

IF　中間周波数

Int Media（内部媒体）　内部媒体。信号発生器の不揮発性

メモリで、ここに波形ファイルがストアされます。

IP　インターネット・プロトコル。イーサネット・ネット

ワークで広く使用されているTCP/IPプロトコル・スイート

のネットワーク層です。

L

LAN　ローカル・エリア・ネットワーク

LO　局部発振器

LXI　測定用のLAN拡張。小型および中型システムにモ

ジュラ方式、柔軟性、性能を提供するよう設計された、業

界標準イーサネット技術をベースとする測定プラット

フォームです。 http://www.lxistandard.orgも参照してく

ださい。

P

Persistent Settings (States)（持続性設定（ステート）） 　
プリセット、ユーザ・プリセット、または電源の入れ直し

によって影響を受けない設定

Point-to-point Time（ポイントツーポイント時間）　

ステップ掃引(28ページを参照)では、待ち時間と処理時間、

スイッチング時間、セトリング時間の合計
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R

RMS　実効値。時間変化する信号の実効値（所定の抵抗で

等価の熱を生成するために必要な等価DC電圧）。正弦波の

場合、RMS = 0.707×ピーク値

S

Softkey（ソフトキー）　測定器の表示に沿って配置された

ボタン。表示でボタンの横に表示された機能を実行します。

T

TCP　伝送制御プロトコル。イーサネットとインターネッ

トで使用されている最も一般的なトランスポート層プロ

トコルです。

Terminator（ターミネータ）　エントリを完了する単位イ

ンジケータ（Hz、dBmなど）。例えば、エントリ100 Hzの
場合、Hzがターミネータです。

Time/Date Reference Point（時間／日付基準ポイン

ト）　信号発生器に設定された最新の時間と日付（18ペー

ジを参照）

Type-N Connector（N型コネクタ）　同軸ケーブルの結合

に使用されるネジ式RFコネクタ

U

USB　ユニバーサル・シリアル・バス。http://www.usb.org
も参照してください。
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索引
記号　

# pointsソフトキー , 28　

# Skipped Pointsソフトキー , 87　
ΦM　

DCオフセット、除去, 55　

インジケータ, 7　
ソフトキー , 53, 55　

ハードキー , 53　

数字　

10 MHz OUTコネクタ, 11　

100Base-T LANケーブル, 20　

628、エラー , 72　

8648A/B/C/Dソフトキー , 19　

8656B,8657A/Bソフトキー , 19　

A　

Activate Secure Displayソフトキー , 16　
active　

entry, 153　

Active Highソフトキー , 99　

Active Lowソフトキー , 99　

AC電源コンセント, 9　
Add Comment Toソフトキー , 38　

Adjust Phaseソフトキー , 26　

Adjustable doubletソフトキー , 58　

Advanced Settingsソフトキー , 20　

Agilentセールスおよびサービス・オフィス, 151　
ALC　

OFFインジケータ, 7　
オフ・モード, 47　

ソフトキー , 26, 87　

ホールド, 83, 84　
AM　

インジケータ, 7　
外部変調源, 55　

コネクタ, 9　
ソフトキー , 53　

ハードキー , 53　

Amptdソフトキー , 26–29　

AMPTDハードキー , 26　

Apply To Waveformソフトキー , 87　
ARB　

definition, 153　

ソフトキー , 68, 97, 130　

波形クリッピング, 105　

プレーヤ、デュアル, 68　

ARMEDインジケータ, 7　
ATTEN HOLDインジケータ, 7　
Atten/ALC Controlソフトキー , 26　

Auto (DHCP/Auto-IP) ソフトキー , 20　
auto-IP, 20　

Autoソフトキー , 47　

AUX I/Oコネクタ, 13　

Auxiliary Software Optionsソフトキー , 21　

AWGN　
definition, 153　

インジケータ, 7　
ソフトキー , 132　

追加, 129　

デュアルARBプレーヤ, 130　

B　

Backup All User Files to Current Directoryソフトキー , 41　

Bandwidthソフトキー , 132　

Baseband Frequency Offsetソフトキー , 72　
BB GEN, 124　

BBG, 124　

BBG media, 153　

BBG媒体, 68, 71　

Binaryソフトキー , 35　

Bk Spハードキー , 24　
BNC, 153　

Bright Colorソフトキー , 16　

Brightnessソフトキー , 16　

Buffered Trigソフトキー , 99　

Build New Waveform Sequenceソフトキー , 74, 95　

Burst Envelopeソフトキー , 121　

Busソフトキー , 27　

C　

C/N, 153　

Calculateソフトキー , 78　

Calibration Typeソフトキー , 127　

Cancelハードキー , 4　
Carrier Bandwidthソフトキー , 130　

Carrier to Noiseソフトキー , 130　

Catalog Typeソフトキー , 35, 78　
ccw, 153　

Channel Bandソフトキー , 26　

Channel Numberソフトキー , 26　

Clear Error Queue(s) ソフトキー , 42　

Clear Headerソフトキー , 78　

Clear Textソフトキー , 24　

Config Typeソフトキー , 20　

Connection Monitoringソフトキー , 20　

Continuousソフトキー , 99　

Contrastソフトキー , 16　

Copy Fileソフトキー , 35　
cw, 153　

CW (no modulation) ソフトキー , 29　

D　

DACオーバレンジ・エラー , 72, 116　

Dark Colorソフトキー , 16　

DCFMΦ/DCfM Calソフトキー , 53　

DCオフセット, 64　

DCオフセット、除去, 55　

Default Gatewayソフトキー , 20　

Delete Rowソフトキー , 29　
Agilent N5181A/82A MXG信号発生器ユーザーズ・ガイド 155



索引
Deleteソフトキー　
All, 35　

All Files In Current Directory, 41　

All Regs in Seq, 38　

All Segments On Int Media, 70　

All Sequences, 38　

File, 35　

File or Directory, 36, 41　

Item, 25, 29　

Row, 25　

Seq Reg, 38　

All Waveformsソフトキー , 95　

すべての波形, 74　

選択された波形, 74, 95　

波形シーケンス, 95　

DETHTRインジケータ, 7　
Deviceソフトキー , 26　
DHCP, 20, 153　

DHCPソフトキー , 20　

Diff Modeソフトキー , 125　

DIGBUSインジケータ, 8　
Display Waveform And Markersソフトキー , 87　

Displayed Caseソフトキー , 24　

Displayソフトキー , 15　

DNS Server Overrideソフトキー , 20　

DNS Serverソフトキー , 20　

Domain Nameソフトキー , 20　

Dual ARBソフトキー , 130　
dwell time, 153　

Dwell Typeソフトキー , 29　

Dynamic DNS Namingソフトキー , 20　

Dynamic Hostname Servicesソフトキー , 20　

E　
Editing Keysソフトキー , 24　

Editing Modeソフトキー , 24　

Editソフトキー　
Noise RMS Override, 78　

RMS, 78　

繰り返し, 95　

選択された波形シーケンス, 74, 95　
EEPROM, 134　

Enable/Disable Markersソフトキー , 74, 95　
entry, active, 153　

Errorハードキー , 42　

ERRインジケータ, 8　
Escハードキー , 4　
EVENT　

コネクタ、AUX I/O, 13　

コネクタ、BNC, 12, 82　

出力, 82　

出力ジッタ, 97　

EVENT出力のジッタ, 97　
EVM, 153　

EVM誤差, 64　

Execute Calソフトキー , 127　

EXT CLOCKコネクタ, 12　

EXT REFインジケータ, 7, 8　
External Media Not Detectedメッセージ, 41　

F　
Fileハードキー , 35, 40　

First Mkr Pointソフトキー , 87　

First Sample Pointソフトキー , 87　

Flatnessソフトキー , 44　
FM　

DCオフセット、除去, 55　

インジケータ, 8　
外部変調源, 55　

コネクタ, 10　

ソフトキー , 53　

ハードキー , 53　

Free Runソフトキー , 27, 99　

Free-Runソフトキー , 58　

Freqソフトキー , 26–29, 44　

FREQハードキー , 26　

FTP Serverソフトキー , 20　

FTPサーバ, 20　

G　

Gatedソフトキー , 58, 99　

Go To Default Pathソフトキー , 36, 41　

Goto Rowソフトキー , 25, 29, 35　
GPIB　

definition, 153　

コネクタ, 11　

セットアップ, 19　

GPIB Addressソフトキー , 19　

GPIB Setupソフトキー , 19　

H　

hardkeys　
definition, 153　

Helpハードキー , 4, 23　

Hostnameソフトキー , 20　

I　
I Offsetソフトキー , 125　

I OUTコネクタ, 12　

I/O Configソフトキー , 15　
I/Q　

最適化, 122　

信号経路、最適化, 122　

信号、整列, 83　

ソフトキー , 64, 121–127　

調整, 125　

波形、クリッピング, 105　

フロント・パネルの入力、使用, 65, 124　

変調, 121　
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索引
リア・パネル出力、使用, 122　

リア・パネル出力, 12　

I/Q調整, 64　

I/Q変調, 64　
IF, 153　

Import Waveformソフトキー , 95　

Incr Setハードキー , 6　
Insertソフトキー　

Item, 25, 29　

Row, 25, 29　

挿入, 74　

波形, 74　

波形シーケンスの内容, 74　
int media, 153　

Int Phase Polarityソフトキー , 121　

Internal Baseband Adjustmentsソフトキー , 125　
IP　

Addressソフトキー , 20　
auto, 20　

definition, 153　

アドレス、設定, 20　

Iコネクタ, 5　

L　
LAN　

definition, 153　

Services Setupソフトキー , 19　

Setupソフトキー , 19　

コネクタ, 11　

セットアップ, 20　

Last Mkr Pointソフトキー , 87　

Lastソフトキー , 17　

LCDディスプレイ・メモリ, 134　
LED, 6　

点滅テスト, 149　

フロント・パネル, 6　
変調, 34　

Listソフトキー , 35　
LO, 153　

Localハードキー , 4　
LXI, 153　

Lインジケータ, 8　

M　

Markerソフトキー , 87　
media　

BBG, 153　

int, 153　

Mod On/Offハードキー , 5, 34　

Modeハードキー , 69, 130, 132　

Modulator Attenソフトキー , 132　

Monochromeソフトキー , 16　

MULTインジケータ, 8　

N　

Name And Storeソフトキー , 95　

No Retriggerソフトキー , 99　

Noiseソフトキー , 130　

Non-Volatile Segmentsソフトキー , 35, 78　

O　

OFFSインジケータ, 8　
Options Infoソフトキー , 21　

Output Blankingソフトキー , 26　

P　
Page Upハードキー , 4　
PAT TRIG INコネクタ, 13　

Patt Trig Inソフトキー , 100　
persistent settings　

definition, 153　

Phase Ref Setソフトキー , 26　

Plot CDDFソフトキー , 115　

Point Triggerソフトキー , 27　
point-to-point time, 153　

Proceed With Reconfigurationソフトキー , 20　

Pulse/RF Blankソフトキー , 87　

Pulseハードキー , 58　

Q　

Q Offsetソフトキー , 125　

Quadrature Angle Adjustmentソフトキー , 64, 125　

Qコネクタ, 5　

R　

RAM, 134, 135　

Real Time I/Q Baseband AWGNソフトキー , 132　

Real-time Noiseソフトキー , 130　

Recallハードキー , 38　

REF INコネクタ, 10　

Ref Oscillator Sourceソフトキー , 26　
reference point, time/date, 154　

REFインジケータ, 8　
Remote Languageソフトキー , 19　

Rename Fileソフトキー , 35　

Rename Segmentソフトキー , 70　

Reset & Runソフトキー , 99　

Restart on Trigソフトキー , 99　

Returnハードキー , 6　
Reverse Power Protectionソフトキー , 17　

Revert to Default Cal Settingsソフトキー , 127　
RF　

出力　

コネクタ, 5　
設定, 26　

トラブルシューティング, 143　

ハードキー , 5　
ブランキング　
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設定、保存, 83　

マーカ機能, 93　

RF During Power Searchソフトキー , 47　

RF Outputソフトキー , 121, 122, 123　

RFC NETBIOS Namingソフトキー , 20　
RMS, 154　

Route Connectorsソフトキー , 27, 58　

Route Toソフトキー , 33, 58　

RPGテスト, 149　

Rインジケータ, 8　

S　
SAVE Seq Regソフトキー , 38　

Save Setup To Headerソフトキー , 78　

Saveハードキー , 38　

Scale Waveform Dataソフトキー , 115　
SCPI　

ソフトキー , 19　

有効化, 20　

リファレンスの内容, ix　
Screen Saverソフトキー , 16　

Securityソフトキー , 35　

Segment Advanceソフトキー , 99　

Selectハードキー , 24　

Sequenceソフトキー , 35, 78　

Set Markerソフトキー , 87　
settings, persistent, 153　

Showソフトキー　
Alpha Table, 24　

波形シーケンス, 74　

波形シーケンスの内容, 74, 95　
Signal Studio, 2　
Signal Studioライセンス, 21　

Single Sweepソフトキー , 27　

Singleソフトキー , 99　

Sockets SCPIソフトキー , 20　
softkeys　

definition of, 154　

See also specific key　

Source Settledソフトキー , 33, 58　

Span Typeソフトキー , 47　

Spanソフトキー , 47　

Squareソフトキー , 58　
states, persistent, 153　

Stateソフトキー , 35　

Step Dwellソフトキー , 28　

Step Spacingソフトキー , 28　

Step/Knob Ratioソフトキー , 17　

Storage Typeソフトキー , 36, 41　

Store To Fileソフトキー , 37　

Subnet Maskソフトキー , 20　

Sumソフトキー , 121　

SWEEPハードキー , 27　

SWMANインジケータ, 8　
Sインジケータ, 8　

T　
TCP, 154　

TCP Keep Aliveソフトキー , 20　
terminator, 154　

time, dwell, 153　

time/date reference point, 154　

Time/Dateソフトキー , 18　

Timer Triggerソフトキー , 27　

Toggleソフトキー , 95　
Trig　

inコネクタ, 10　

outコネクタ, 10, 33　

出力信号, 33　

Triggeredソフトキー , 58　
Type-N connector, 154　

Tインジケータ, 8　

U　

UNLEVELインジケータ, 8　
UNLOCKインジケータ, 8　
Unspecifiedソフトキー , 78　

Up Directoryソフトキー , 36　

Update in Remoteソフトキー , 16　
urls, 2, 18, 21, 151　

USB　
definition, 154　

デバイス・コネクタ, 11　

トラブルシューティング, 147　

ホスト・コネクタ, 3　
メディアの接続, 41　

Use Current Directory As Default Pathソフトキー , 41　

Utilityハードキー , 15　

V　
View Next Error Pageソフトキー , 42　

View Previous Error Pageソフトキー , 42　

Volatile Segmentsソフトキー , 35, 78　

VXI-11、有効化, 20　

VXT-11 SCPIソフトキー , 20　

W　

Web Serverソフトキー , 20　

Webサーバ, 20　

WINITインジケータ, 8　

Z　
Zoomソフトキー , 87　

あ　

アクティブ　

機能エリア, 25　

入力エリア, 7　
アドバンス、セグメント, 101　

アドレス、GPIB, 19　
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アナログ変調, 53　

位相スキュー , 64　

イメージ, 64　

インジケータ, 7　
インストール・ガイドの内容, ix　
インタフェース　

GPIB, 19　

LAN, 20　

永続設定　

デフォルトの復元, 17　

リセット, 23　

エディタ、テーブル, 25　

エラー　

DACオーバレンジ, 72, 116　

エラー・メッセージ, 42　

タイプ, 148　

表示エリア, 8　
ファイル, 148　

メッセージ・フォーマット, 42　

円クリッピング, 109, 112　

オーバシュート, 116　

オーバレンジ・エラー、DAC, 116　

オプション　

有効化, 15, 21　

リソース, 2　
オフセット, 64　

I/Q, 125　

出力、使用法, 49　

ベースバンド周波数, 72　

オン／オフ・スイッチ, 6　

か　

カーソル, 25　

回転ノブ, 24　

ガイド、内容, ix　
外部　

I信号とQ信号, 124　

トリガ, 104　

トリガ・ソース, 102, 104　

媒体, 41, 147　

変調源, 55　

外部ソフトキー　

外部, 121　

出力, 125　

入力, 125　

入力Iオフセット, 64　

入力Qオフセット, 64　

メディア・ファイル・マネージャ , 35　

外部用ソフトキー　
Delay Time, 100　

Ext, 27　

I/Q Output, 121, 122, 123　

Pulse, 58　

信号源, 100　

遅延, 100　

概要、信号発生器, 1　
ガウス、AWGNを参照　

角度、直交, 64　

カタログ、ステート・ファイル, 40　

カラー・パレット、ディスプレイ, 16　

キー　

数字, 3　
テスト, 149　

特定のキーも参照してください。　

のヘルプ, 23　

フロント・パネル, 3　
無効にする, 139　

黄色のLED, 6　
機器ステート　

波形との対応付け, 38　

ファイル, 38, 40　

レジスタ、　

基準、使用法, 50　

揮発性メモリ, 68, 71　

基本的な操作　基本操作を参照　

機密、　

極性、外部トリガ, 100　

極性、マーカ、設定, 94　

クリッピング　

円, 109, 112　

ソフトキー , 105　

長方形, 110, 113　

クロスオーバー・ケーブル, 20　

クロック、サンプリング・レート, 13　

経路遅延, 64　

ゲーティッド・トリガ, 99, 102　

ケーブル、100Base-T LAN, 20　

ケーブル、クロスオーバー , 20　

工場設定、復元, 17, 20, 127　

校正、I/Q, 127　

校正データ, 134　

校正データ・メモリ, 135　

コネクタ　

外部トリガ・ソース, 102, 104　

信号のルーティング, 33　

フロント・パネル, 3　
リア・パネル, 9　

コメント、追加および編集（機器ステート） , 38　

コントラスト調整, 16　

さ　

サーチ、パワー , 48　

サーバ、有効化, 20　

サービス　

Agilentオフィス, 151　

ガイドの内容, ix　
リクエスト・インジケータ, 8　

最適化、I/Q, 64, 121　

雑音, 64　

雑音帯域幅ファクタ, 130　
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サンプリング・レート・ソフトキー , 97　

サンプリング・レート・クロック, 13　

シーケンス　

再生, 77　

波形, 74　

ファイル・ヘッダ, 78　

編集, 76　

マーカ制御, 95　

時間ベースのライセンス、注意, 18　

時間ベース・ライセンス、トラブルシューティング, 150　

時間、設定, 18　

時間／日付基準ポイント, 18　

システム・デフォルト、復元, 17　

持続性メモリ, 135　

周波数　

オフセット, 49　

オフセット、設定, 72　

オフセット、ベースバンド, 72　

基準, 50　

設定, 26　

ソフトキー , 26, 26–29　

逓倍器, 51　

ハードキー , 5, 6, 26　

表示エリア, 7　
変調, 53　

出力、掃引, 27　

手動制御、掃引, 33　

手動用ソフトキー　
Config Settings, 20　

手動用, 20　

ポイント, 27　

モード, 27　

情報、メモリから除去, 136　

シリアル・データ　

同期, 13　

信号源安定信号, 33　

振幅　

オフセット, 49　

基準, 50　

設定, 26　

掃引のトラブルシューティング, 146　

ソフトキー , 26–29　

ハードキー , 26　

表示エリア, 8　
変調, 53　

スイッチ、電源, 6　
スキュー、I/Q, 125　

スクリーン・セーバ設定, 16　

スケーリングのソフトキー , 115　

ステップ掃引　

間隔, 28　

使用法, 28　

トラブルシューティング, 146　

ステップ配列（ユーザ・フラットネス） , 45　

ユーザ・フラットネス補正も参照　

スペクトラム・アナライザ、信号損失のトラブルシューティング,

144　

スペクトル・リグロース, 108　

性能、最適化, 43　

セールス、Agilentオフィス, 151　

セキュア　

ソフトキー , 35　

表示, 139　

モード, 137　

セキュリティ , 133　

セグメント　

アドバンス・トリガ, 101　

ストア、ロード、再生, 70　

ソフトキー , 70　

ファイル・ヘッダ, 78　

ロード, 71　

セグメント・アドバンス・トリガ, 99　

設定用ソフトキー　
Cal Array, 44　

Step Array, 44　

ステップ掃引, 27, 28　

リスト掃引, 27, 29　

セルフテスト, 149　

選択用ソフトキー　
Color Palette, 16　

Different Header, 78, 81　

Header, 78　

Reg, 38　

Seq, 38　

波形, 29　

掃引　

outコネクタ, 9, 33　

インジケータ, 8　
出力信号, 33　

手動制御, 33　

ステップ, 28　

ソフトキー , 27–33, 58　

対数, 28　

トラブルシューティング, 146　

ハードキー , 27　

波形、を含む, 31　

リスト・ステータス情報, 30　

リスト・パラメータ, 30　

リニア, 28　

掃引出力, 27　

掃引用ソフトキー , 27–33, 58　

相加性白色ガウス雑音、AWGNを参照　

操作、基本, 23　

操作、リモート, 19　

測定器のファームウェア、アップグレード, 18　

測定器用ソフトキー　
Adjustments, 15　

Info, 15　

オプション, 21　

ソケット、有効化, 20　

ソフトキー　

位置, 3　
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のヘルプ, 23　

ラベル・エリア, 8　

た　

待機（黄色）LED, 6　
対数掃引, 28　

ダブレット用ソフトキー , 58　

ダブレット、調整可能, 60　

ダブレット、トリガ, 60　

遅延、I/Q, 125　

調整　
I/Q, 64　

直交位相, 125　

調整、I/Q, 125　

長方形クリッピング, 110, 113　

直交位相調整, 125　

直交角度, 64　

ディスプレイ・メモリ, 134　

逓倍器、使用法, 51　

データ　

校正, 134　

消去, 136　

除去, 136　

シリアル・同期, 13　

ストレージ　

コメント、追加および編集, 38　

使用法, 35　

タイプ, 41　

トラブルシューティング, 147　

入力用ソフトキー , 24　

ファイル, 35–38　

テーブル・エディタ, 25　

テキスト入力ソフトキー , 70　

テキスト・エリア（ディスプレイ上） , 8　
デジタル信号からアナログ波形, 116　

デジタル動作, 67　

デジタル・バス, 13　

テスト、セルフ, 149　

テスト、フロント・パネル, 149　

デフォルト設定　

システム、復元, 23　

復元, 17　

デフォルト、復元, 20, 127　

デュアルARB　
ソフトキー , 69　

プレーヤ, 68　

デュアルARBリアルタイム・ノイズ, 130　

テンキー , 3　
電源用ソフトキー　

On/Preset, 15　

Search, 47　

投入, 17　

電源（緑色）LED, 6　
トーカ・モード・インジケータ, 8　
特長, 2　

トラブルシューティング, 141　

トリガ　

開始, 4　
ゲーティッド, 99, 102　

コネクタ, 10　

セグメント・アドバンス, 99　

ソフトキー , 98　

ハードキー , 4　
波形, 98　

トリガ用ソフトキー　
& Run, 99　

Doublet, 58　

キー , 27　

出力極性, 27　

信号源, 98　

タイプ, 98　

トリガ, 58　

な　

内部メディア, 41　

ノイズ, 129　

ノブ, 6, 17, 24　

は　

ハードキー　

概要, 3　
特定のキーも参照してください。　

のヘルプ, 23　

媒体　
USB, 41, 147　

消去, 136　

ストレージ, 41　

タイプ, 68, 134　

メモリ・スティック, 41　

波形　

概要, 68　

機器ステートの保存, 38　

クリッピング, 105　

シーケンス, 74　

スケーリング, 114　

ストア、ロード、再生, 70　

セグメントのソフトキー , 70　

掃引の, 31　

デジタル・ベースバンド波形から, 116　

トリガ, 98　

ファイル・ヘッダ, 78　

マーカ, 82, 83　

メモリ, 135　

ライセンス, 21　

波形用ソフトキー　
Runtime Scaling, 115　

Segments, 70　

Utilities, 115　

シーケンス, 74, 95　

波形, 27, 29　
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ライセンス, 21　

バックスペース・ハードキー , 24　

パラメータ、波形の保存, 78　

パルス　

インジケータ, 8　
高速, 47　

コネクタ, 10　

同期信号, 33　

特性, 59　

ビデオ信号, 33　

変調, 57　

マーカ、表示, 92　

パルス用ソフトキー , 33, 58　

パワー　

コンセント, 9　
サーチ, 48　

スイッチ, 6　
設定, 26　

ソフトキー , 15, 17, 26–29, 47　

電源、トラブルシューティング, 143　

投入、設定, 17　

トラブルシューティング, 143　

ピーク対アベレージ、減少, 109　

メータ, 44, 45　

搬送波　

設定, 26　

帯域幅, 130　

対雑音比, 130　

変調, 34　

搬送波フィードスルー , 64　

ピーク対アベレージ・パワー、減少, 109　

ピクセル・テスト, 149　

歪み、トラブルシューティング, 143　

日付、設定, 18　

表示　

エラー・メッセージ・エリア, 8　
概要, 3, 7　
セキュア, 139　

設定, 16　

ソフトキー・ラベル, 8　
テキスト・エリア, 8　
テスト, 149　

トラブルシューティング, 142　

ブランキング, 139　

ファームウェア　

アップグレード, 18　

メモリ, 134　

ファームウェア、アップグレード, 151　

ファイル・カタログ、　

ファイル・ヘッダ　

異なるファイルの表示, 81　

作成, 78　

編集, 79　

例, 79　

ファイル　

フィードスルー , 64　

フィルタ、補間器, 116　

ブートロム・メモリ, 134　

不揮発性メモリ, 68　

復元用ソフトキー　
All User Files from Current Directory, 41　

LAN Settings to Default Values, 20　

System Settings to Default Values, 17　

フラッシュ・メモリ, 134　

フラットネス補正　

プリセット　

使用法, 23　

設定, 17　

トラブルシューティング, 147　

ハードキー位置, 4　
プリセット用ソフトキー　

Language, 17　

List, 29, 44　

プリセット, 17　

プリファレンス、設定, 15　

プログラミング・ガイドの内容, ix　
フロント・パネル　

I/Q入力、使用, 65　

概要, 3　
キーを無効にする, 139　

テスト, 149　

ノブの分解能, 17　

表示, 7　
フロント・パネル・メモリ, 135　

ベースバンド, 13　

I/Q出力コネクタ, 12　

クリッピング, 105　

雑音インジケータ, 7　
周波数オフセット、設定, 72　

信号の加算, 124　

信号を整列, 83　

ソフトキー , 72　

直交位相調整, 125　

ノイズ, 129　

波形をアナログに変換, 116　

メモリ, 68, 134　

リアルタイムI/Q AWGN, 130, 132　

ベクトル動作, 67　

ヘッダ・ユーティリティのソフトキー , 78　

変調　
AM, 53　

FM, 53　

I/Q, 64, 121　

位相, 53　

インジケータ, 8　
外部変調源、使用法, 55　

作成, 34　

トラブルシューティング, 143　

パルス, 57　

搬送波信号, 34　

補間器フィルタ, 116　

ホスト名、設定, 20　
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補正配列（ユーザ・フラットネス） , 45　

ユーザ・フラットネス補正も参照　

ま　

マーカ　

信号、整列, 83　

マーカ、波形, 82–97　

待ち行列、エラー , 42　

待ち時間, 29　

待ち時間、トラブルシューティング, 146　

マニュアル, ix　
マニュアル、内容, ix　
ミキサ、信号損失のトラブルシューティング, 144　

緑色のLED, 6　
明度調整, 16　

メイン・メモリ, 134　

メッセージ、エラー , 148　

メニュー・キー , 4, 24　

メモリ, 134　

からデータを消去, 136　

メモリ、媒体を参照　

モノクロ・ディスプレイ、設定, 16　

や　

矢印キー , 24　

ユーザ　

ファイル、バックアップおよび復元, 35　

フラットネス補正, 44　

プリセット, 23　

プリセット、トラブルシューティング, 147　

マニュアルの内容, ix　
ユーザ用ソフトキー　

Current Directory As Default Path, 36　

Flatness, 26, 35　

Span, 47　

User, 17　

フラットネス補正, 44　

用語集, 153　

ら　

ライセンス　
Signal Studio, 21　

サービス・ソフトウェア, 21　

時間ベース, 18　

トラブルシューティング, 150　

波形, 21　

表示, 21　

マネージャ , 21　

ランタイム・スケーリング, 118　

リアルタイム・ノイズ, 130　

リア・パネル　

I/Q出力, 122　

リア・パネルの概要, 9　
リグロース、スペクトル, 108　

リスト掃引　

使用法, 29　

ステータス情報, 30　

トラブルシューティング, 146　

波形, 31　

パラメータ, 30　

リスト・モード値, 30　

リスナ・モード・インジケータ, 8　
リップル, 116　

リニア掃引, 28　

リファレンス、内容, ix　
リモート操作用プリファレンス, 19　

リモート・オペレーション・インジケータ, 8　
リンギング, 116　

ルーティング　
I/Q, 64, 121　

マーカ　

ALCホールド, 84　

RFブランキング, 93　

設定の保存, 83　

レジスタ呼び出し、トラブルシューティング, 146　

レベリングなし動作, 47　

レベリング、オフ, 47　

連続ステップ掃引の例, 32　

連続波出力, 26　

ロード用ソフトキー　
All From Int Media, 70　

Cal Array From Step Array, 44　

From Selected File, 37　

Load/Store, 29, 37　

Segment From Int Media, 70　

Store, 70　

ロックアップ、トラブルシューティング, 142　
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